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Product Description
Read, analyze, and visualize genomic and proteomic data

Bioinformatics Toolbox™ provides algorithms and visualization techniques for
Next Generation Sequencing (NGS), microarray analysis, mass spectrometry,
and gene ontology. Using toolbox functions, you can read genomic and
proteomic data from standard file formats such as SAM, FASTA, CEL, and
CDF, as well as from online databases such as the NCBI Gene Expression
Omnibus and GenBank®. You can explore and visualize this data with
sequence browsers, spatial heatmaps, and clustergrams. The toolbox also
provides statistical techniques for detecting peaks, imputing values for
missing data, and selecting features.

You can combine toolbox functions to support common bioinformatics
workflows. You can use ChIP-Seq data to identify transcription factors;
analyze RNA-Seq data to identify differentially expressed genes; identify copy
number variants and SNPs in microarray data; and classify protein profiles
using mass spectrometry data.

Key Features

¢ Next Generation Sequencing analysis and browser

® Sequence analysis and visualization, including pairwise and multiple
sequence alignment and peak detection

® Microarray data analysis, including reading, filtering, normalizing, and
visualization

® Mass spectrometry analysis, including preprocessing, classification, and
marker identification

® Phylogenetic tree analysis

¢ Graph theory functions, including interaction maps, hierarchy plots, and
pathways

¢ Data import from genomic, proteomic, and gene expression files, including
SAM, FASTA, CEL, and CDF, and from databases such as NCBI and
GenBank
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Product Overview

In this section...

“Features” on page 1-3

“Expected Users” on page 1-5

Features

The Bioinformatics Toolbox product extends the MATLAB® environment

to provide an integrated software environment for genome and proteome
analysis. Scientists and engineers can answer questions, solve problems,
prototype new algorithms, and build applications for drug discovery and
design, genetic engineering, and biological research. An introduction to these
features will help you to develop a conceptual model for working with the
toolbox and your biological data.

The Bioinformatics Toolbox product includes many functions to help you
with genome and proteome analysis. Most functions are implemented in the
MATLAB programming language, with the source available for you to view.
This open environment lets you explore and customize the existing toolbox
algorithms or develop your own.

You can use the basic bioinformatic functions provided with this toolbox
to create more complex algorithms and applications. These robust and
well-tested functions are the functions that you would otherwise have to
create yourself.

Toolbox features and functions fall within these categories:

¢ Data formats and databases — Connect to Web-accessible databases
containing genomic and proteomic data. Read and convert between
multiple data formats.

e High-throughput sequencing — Gene expression and transcription
factor analysis of next-generation sequencing data, including RNA-Seq
and ChIP-Seq.

® Sequence analysis — Determine the statistical characteristics of a
sequence, align two sequences, and multiply align several sequences.

1-3
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Model patterns in biological sequences using hidden Markov model (HMM)
profiles.

* Phylogenetic analysis — Create and manipulate phylogenetic tree data.

* Microarray data analysis — Read, normalize, and visualize microarray
data.

* Mass spectrometry data analysis — Analyze and enhance raw mass
spectrometry data.

e Statistical learning — Classify and identify features in data sets with
statistical learning tools.

®* Programming interface — Use other bioinformatic software (BioPerl
and BioJava) within the MATLAB environment.

The field of bioinformatics is rapidly growing and will become increasingly
important as biology becomes a more analytical science. The toolbox provides
an open environment that you can customize for development and deployment
of the analytical tools you will need.

* Prototype and develop algorithms — Prototype new ideas in an open
and extensible environment. Develop algorithms using efficient string
processing and statistical functions, view the source code for existing
functions, and use the code as a template for customizing, improving,
or creating your own functions. See “Prototyping and Development
Environment” on page 1-20.

¢ Visualize data — Visualize sequences and alignments, gene expression
data, phylogenetic trees, mass spectrometry data, protein structure,
and relationships between data with interconnected graphs. See “Data
Visualization” on page 1-20.

¢ Share and deploy applications — Use an interactive GUI builder to
develop a custom graphical front end for your data analysis programs.
Create standalone applications that run separately from the MATLAB
environment. See “Algorithm Sharing and Application Deployment” on
page 1-21.



Product Overview

Expected Users

The Bioinformatics Toolbox product is intended for computational biologists
and research scientists who need to develop new algorithms or implement
published ones, visualize results, and create standalone applications.

¢ Industry/Professional — Increasingly, drug discovery methods are being
supported by engineering practice. This toolbox supports tool builders
who want to create applications for the biotechnology and pharmaceutical
industries.

¢ Education/Professor/Student — This toolbox is well suited for learning
and teaching genome and proteome analysis techniques. Educators
and students can concentrate on bioinformatic algorithms instead of
programming basic functions such as reading and writing to files.

While the toolbox includes many bioinformatic functions, it is not intended
to be a complete set of tools for scientists to analyze their biological data.
However, the MATLAB environment is ideal for rapidly designing and
prototyping the tools you need.

1-5
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Installation

In this section...

“Installing” on page 1-6
“Required Software” on page 1-6
“Optional Software” on page 1-6

Installing

Install the Bioinformatics Toolbox software from a DVD or Web release
using the MathWorks® Installer. For more information, see the installation
documentation.

Required Software

The Bioinformatics Toolbox software requires the following MathWorks
products to be installed on your computer.

Required Software | Description

MATLAB Provides a command-line interface and integrated
software environment for the Bioinformatics
Toolbox software.

Bioinformatics Toolbox software requires the
current version of MATLAB.

Statistics Toolbox™ | Provides basic statistics and probability functions
used by the Bioinformatics Toolbox software.

Bioinformatics Toolbox software requires the
current version ofStatistics Toolbox.

Optional Software

MATLAB and the Bioinformatics Toolbox software environment is open and

extensible. In this environment you can interactively explore ideas, prototype
new algorithms, and develop complete solutions to problems in bioinformatics.
MATLAB facilitates computation, visualization, prototyping, and deployment.



Installation

Using the Bioinformatics Toolbox software with other MATLAB toolboxes and
products will allow you to do advanced algorithm development and solve
multidisciplinary problems.

Optional Software

Description

Parallel Computing
Toolbox™

Perform parallel bioinformatic computations on

multicore computers and computer clusters. For
an example of batch processing through parallel
computing, see the Batch Processing of Spectra

Using Distributed Computing.

Signal Processing
Toolbox™

Process signal data from bioanalytical
instrumentation. Examples include acquisition
of fluorescence data for DNA sequence analyzers,
fluorescence data for microarray scanners, and
mass spectrometric data from protein analyses.

Image Processing

Create complex and custom image processing

Toolbox™ algorithms for data from microarray scanners.
SimBiology® Model, simulate, and analyze biochemical systems.
Optimization Use nonlinear optimization to predict the
Toolbox™ secondary structure of proteins and the structure

of other biological macromolecules.

Neural Network
Toolbox™

Use neural networks to solve problems where
algorithms are not available. For example, you
can train neural networks for pattern recognition
using large sets of sequence data.

Database Toolbox™

Create your own in-house databases for sequence
data with custom annotations.

MATLAB
Compiler™

Create standalone applications from MATLAB
GUI applications, and create dynamic link
libraries from MATLAB functions to use with any
programming environment.

MATLAB Builder™
NE

Create COM objects to use with any COM-based
programming environment.
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Optional Software

Description

MATLAB Builder JA | Integrate MATLAB applications into your
organization’s Java® programs by creating a Java
wrapper around the application.

MATLAB Builder EX | Create Microsoft® Excel® add-in functions

from MATLAB functions to use with Excel
spreadsheets.

Spreadsheet Link™
EX

Connect Microsoft Excel with the MATLAB
Workspace to exchange data and to use MATLAB
computational and visualization functions. For

more information, see “Exchange Bioinformatic
Data Between Excel and MATLAB” on page 1-22.




Features and Functions

Features and Functions

In this section...

“Data Formats and Databases” on page 1-9
“Sequence Alignments” on page 1-11

“Sequence Utilities and Statistics” on page 1-11
“Protein Property Analysis” on page 1-12
“Phylogenetic Analysis” on page 1-13

“Microarray Data Analysis” on page 1-13
“Microarray Data Storage” on page 1-14

“Mass Spectrometry Data Analysis” on page 1-15
“Graph Theory Functions” on page 1-18

“Graph Visualization” on page 1-19

“Statistical Learning and Visualization” on page 1-19
“Prototyping and Development Environment” on page 1-20

“Data Visualization” on page 1-20

“Algorithm Sharing and Application Deployment” on page 1-21

Data Formats and Databases

The toolbox accesses many of the databases on the Web and other online data
sources. It allows you to copy data into the MATLAB Workspace, and read
and write to files with standard bioinformatic formats. It also reads many
common genome file formats, so that you do not have to write and maintain
your own file readers.

Web-based databases — You can directly access public databases on the
Web and copy sequence and gene expression information into the MATLAB
environment.

The sequence databases currently supported are GenBank (getgenbank),
GenPept (getgenpept), European Molecular Biology Laboratory (EMBL)
(getembl), and Protein Data Bank (PDB) (getpdb). You can also access data
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from the NCBI Gene Expression Omnibus (GEO) Web site by using a single
function (getgeodata).

Get multiply aligned sequences (gethmmalignment), hidden Markov model
profiles (gethmmprof), and phylogenetic tree data (gethmmtree) from the
PFAM database.

Gene Ontology database — Load the database from the Web into

a gene ontology object (geneont.geneont). Select sections of the
ontology with methods for the geneont object (geneont.getancestors,
geneont.getdescendants, geneont.getmatrix, geneont.getrelatives),
and manipulate data with utility functions (goannotread, num2goid).

Read data from instruments — Read data generated from gene
sequencing instruments (scfread, joinseq, traceplot), mass spectrometers
(jcampread), and Agilent® microarray scanners (agferead).

Reading data formats — The toolbox provides a number of functions for
reading data from common bioinformatic file formats.

® Sequence data: GenBank (genbankread), GenPept (genpeptread), EMBL
(emblread), PDB (pdbread), and FASTA (fastaread)

e Multiply aligned sequences: ClustalW and GCG formats (multialignread)

® Gene expression data from microarrays: Gene Expression Omnibus (GEO)
data (geosoftread), GenePix® data in GPR and GAL files (gprread,
galread), SPOT data (sptread), Affymetrix® GeneChip® data (affyread),
and ImaGene® results files (imageneread)

¢ Hidden Markov model profiles: PFAM-HMM file (pfamhmmread)

Writing data formats — The functions for getting data from the Web
include the option to save the data to a file. However, there is a function to
write data to a file using the FASTA format (fastawrite).

BLAST searches — Request Web-based BLAST searches (blastncbi), get
the results from a search (getblast) and read results from a previously saved
BLAST formatted report file (blastread).
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The MATLAB environment has built-in support for other industry-standard
file formats including Microsoft Excel and comma-separated-value (CSV) files.
Additional functions perform ASCII and low-level binary I/0, allowing you to
develop custom functions for working with any data format.

Sequence Alignments

You can select from a list of analysis methods to compare nucleotide or amino
acid sequences using pairwise or multiple sequence alignment functions.

Pairwise sequence alignment — Efficient implementations of standard
algorithms such as the Needleman-Wunsch (nwalign) and Smith-Waterman
(swalign) algorithms for pairwise sequence alignment. The toolbox also
includes standard scoring matrices such as the PAM and BLOSUM
families of matrices (blosum, dayhoff, gonnet, nuc44, pam). Visualize
sequence similarities with seqdotplot and sequence alignment results with
showalignment.

Multiple sequence alignment — Functions for multiple sequence
alignment (multialign, profalign) and functions that support multiple
sequences (multialignread, fastaread, showalignment). There is also a
graphical interface (seqalignviewer) for viewing the results of a multiple
sequence alignment and manually making adjustment.

Multiple sequence profiles — Implementations for multiple alignment and
profile hidden Markov model algorithms (gethmmprof, gethmmalignment,
gethmmtree, pfamhmmread, hmmprofalign, hmmprofestimate,
hmmprofgenerate, hmmprofmerge, hmmprofstruct, showhmmprof).

Biological codes — Look up the letters or numeric equivalents for
commonly used biological codes (aminolookup, baselookup, geneticcode,
revgeneticcode).

Sequence Utilities and Statistics

You can manipulate and analyze your sequences to gain a deeper
understanding of the physical, chemical, and biological characteristics of
your data. Use a graphical user interface (GUI) with many of the sequence
functions in the toolbox (seqviewer).

1-11
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Sequence conversion and manipulation — The toolbox provides routines
for common operations, such as converting DNA or RNA sequences to amino
acid sequences, that are basic to working with nucleic acid and protein
sequences (aa2int, aa2nt, dna2rna, rna2dna, int2aa, int2nt, nt2aa, nt2int,
seqcomplement, seqrcomplement, seqreverse).

You can manipulate your sequence by performing an in silico digestion with
restriction endonucleases (restrict) and proteases (cleave).

Sequence statistics — Determine various statistics about a sequence
(aacount, basecount, codoncount, dimercount, nmercount, ntdensity,
codonbias, cpgisland, oligoprop), search for specific patterns within a
sequence (seqshowwords, seqwordcount), or search for open reading frames
(seqshoworfs). In addition, you can create random sequences for test cases
(randseq).

Sequence utilities — Determine a consensus sequence from a set of multiply
aligned amino acid, nucleotide sequences (segconsensus, or a sequence
profile (seqprofile). Format a sequence for display (seqdisp) or graphically
show a sequence alignment with frequency data (seqlogo).

Additional MATLAB functions efficiently handle string operations with
regular expressions (regexp, seq2regexp) to look for specific patterns in a
sequence and search through a library for string matches (seqmatch).

Look for possible cleavage sites in a DNA/RNA sequence by searching for
palindromes (palindromes).

Protein Property Analysis

You can use a collection of protein analysis methods to extract information
from your data. You can determine protein characteristics and simulate
enzyme cleavage reactions. The toolbox provides functions to calculate various
properties of a protein sequence, such as the atomic composition (atomiccomp),
molecular weight (molweight), and isoelectric point (isoelectric). You can
cleave a protein with an enzyme (cleave, rebasecuts) and create distance
and Ramachandran plots for PDB data (pdbdistplot, ramachandran). The
toolbox contains a graphical user interface for protein analysis (proteinplot)
and plotting 3-D protein and other molecular structures with information
from molecule model files, such as PDB files (molviewer).
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Amino acid sequence utilities — Calculate amino acid statistics for a
sequence (aacount) and get information about character codes (aminolookup).

Phylogenetic Analysis

You can use functions for phylogenetic tree building and analysis. There is
also a GUI to draw phylograms (trees).

Phylogenetic tree data — Read and write Newick-formatted tree files
(phytreeread, phytreewrite) into the MATLAB Workspace as phylogenetic
tree objects (phytree).

Create a phylogenetic tree — Calculate the pairwise distance between
biological sequences (seqpdist), estimate the substitution rates (dnds,
dndsml), build a phylogenetic tree from pairwise distances (seqlinkage,
seqneighjoin, reroot), and view the tree in an interactive GUI that allows
you to view, edit, and explore the data (phytreeviewer or view). This GUI
also allows you to prune branches, reorder, rename, and explore distances.

Phylogenetic tree object methods — You can access the functionality

of the phytreeviewer GUI using methods for a phylogenetic tree object
(phytree). Get property values (get) and node names (getbyname). Calculate
the patristic distances between pairs of leaf nodes (pdist, weights)

and draw a phylogenetic tree object in a MATLAB Figure window as a
phylogram, cladogram, or radial treeplot (plot). Manipulate tree data by
selecting branches and leaves using a specified criterion (select, subtree)
and removing nodes (prune). Compare trees (getcanonical) and use
Newick-formatted strings (getnewickstr).

Microarray Data Analysis

The MATLAB environment is widely used for microarray data analysis,
including reading, filtering, normalizing, and visualizing microarray data.
However, the standard normalization and visualization tools that scientists
use can be difficult to implement. The toolbox includes these standard
functions:

Microarray data — Read Affymetrix GeneChip files (affyread) and plot

data (probesetplot), ImaGene results files (imageneread), SPOT files
(sptread) and Agilent microarray scanner files (agferead). Read GenePix

1-13



1 Getting Started

GPR files (gprread) and GAL files (galread). Get Gene Expression Omnibus
(GEO) data from the Web (getgeodata) and read GEO data from files
(geosoftread).

A utility function (magetfield) extracts data from one of the microarray
reader functions (gprread, agferead, sptread, imageneread).

Microarray normalization and filtering — The toolbox provides a
number of methods for normalizing microarray data, such as lowess
normalization (malowess) and mean normalization (manorm), or across
multiple arrays (quantilenorm). You can use filtering functions to

clean raw data before analysis (geneentropyfilter, genelowvalfilter,
generangefilter, genevarfilter), and calculate the range and variance of
values (exprprofrange, exprprofvar).

Microarray visualization — The toolbox contains routines for visualizing
microarray data. These routines include spatial plots of microarray data
(maimage, redgreencmap), box plots (maboxplot), loglog plots (maloglog),
and intensity-ratio plots (mairplot). You can also view clustered expression
profiles (clustergram, redgreencmap). You can create 2-D scatter plots of
principal components from the microarray data (mapcaplot).

Microarray utility functions — Use the following functions to work
with Affymetrix GeneChip data sets. Get library information for a probe
(probelibraryinfo), gene information from a probe set (probesetlookup),
and probe set values from CEL and CDF information (probesetvalues).
Show probe set information from NetAffx™ Analysis Center (probesetlink)
and plot probe set values (probesetplot).

The toolbox accesses statistical routines to perform cluster analysis and
to visualize the results, and you can view your data through statistical
visualizations such as dendrograms, classification, and regression trees.

Microarray Data Storage

The toolbox includes functions, objects, and methods for creating, storing, and
accessing microarray data.

The object constructor function, DataMatrix, lets you create a DataMatrix
object to encapsulate data and metadata from a microarray experiment. A
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DataMatrix object stores experimental data in a matrix, with rows typically
corresponding to gene names or probe identifiers, and columns typically
corresponding to sample identifiers. A DataMatrix object also stores
metadata, including the gene names or probe identifiers (as the row names)
and sample identifiers (as the column names).

You can reference microarray expression values in a DataMatrix object the
same way you reference data in a MATLAB array, that is, by using linear or
logical indexing. Alternately, you can reference this experimental data by
gene (probe) identifiers and sample identifiers. Indexing by these identifiers
lets you quickly and conveniently access subsets of the data without having
to maintain additional index arrays.

Many MATLAB operators and arithmetic functions are available to
DataMatrix objects by means of methods. These methods let you modify,
combine, compare, analyze, plot, and access information from DataMatrix
objects. Additionally, you can easily extend the functionality by using
general element-wise functions, dmarrayfun and dmbsxfun, and by manually
accessing the properties of a DataMatrix object.

Note For more information on creating and using DataMatrix objects, see
“Representing Expression Data Values in DataMatrix Objects” on page 4-5.

Mass Spectrometry Data Analysis

The mass spectrometry functions preprocess and classify raw data from
SELDI-TOF and MALDI-TOF spectrometers and use statistical learning
functions to identify patterns.

Reading raw data — Load raw mass/charge and ion intensity data from
comma-separated-value (CSV) files, or read a JCAMP-DX-formatted file with
mass spectrometry data (jcampread) into the MATLAB environment.

You can also have data in TXT files and use the importdata function.
Preprocessing raw data — Resample high-resolution data to a lower

resolution (msresample) where the extra data points are not needed. Correct
the baseline (msbackadj). Align a spectrum to a set of reference masses
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(msalign) and visually verify the alignment (msheatmap). Normalize the
area between spectra for comparing (msnorm), and filter out noise (nslowess
and mssgolay).

Spectrum analysis — Load spectra into a GUI (msviewer) for selecting mass
peaks and further analysis.

The following graphic illustrates the roles of the various mass spectrometry
functions in the toolbox.
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Graph Theory Functions

Graph theory functions in the toolbox apply basic graph theory algorithms to
sparse matrices. A sparse matrix represents a graph, any nonzero entries in
the matrix represent the edges of the graph, and the values of these entries
represent the associated weight (cost, distance, length, or capacity) of the
edge. Graph algorithms that use the weight information will cancel the edge
if a NaN or an Inf is found. Graph algorithms that do not use the weight
information will consider the edge if a NaN or an Inf is found, because these
algorithms look only at the connectivity described by the sparse matrix and
not at the values stored in the sparse matrix.

Sparse matrices can represent four types of graphs:

* Directed Graph — Sparse matrix, either double real or logical. Row
(column) index indicates the source (target) of the edge. Self-loops (values
in the diagonal) are allowed, although most of the algorithms ignore these
values.

¢ Undirected Graph — Lower triangle of a sparse matrix, either double
real or logical. An algorithm expecting an undirected graph ignores values
stored in the upper triangle of the sparse matrix and values in the diagonal.

¢ Direct Acyclic Graph (DAG) — Sparse matrix, double real or logical,
with zero values in the diagonal. While a zero-valued diagonal is a
requirement of a DAG, it does not guarantee a DAG. An algorithm expecting
a DAG will not test for cycles because this will add unwanted complexity.

¢ Spanning Tree — Undirected graph with no cycles and with one
connected component.

There are no attributes attached to the graphs; sparse matrices representing
all four types of graphs can be passed to any graph algorithm. All functions
will return an error on nonsquare sparse matrices.

Graph algorithms do not pretest for graph properties because such tests

can introduce a time penalty. For example, there is an efficient shortest
path algorithm for DAG, however testing if a graph is acyclic is expensive
compared to the algorithm. Therefore, it is important to select a graph theory
function and properties appropriate for the type of the graph represented by
your input matrix. If the algorithm receives a graph type that differs from
what it expects, it will either:
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e Return an error when it reaches an inconsistency. For example, if you pass
a cyclic graph to the graphshortestpath function and specify Acyclic as
the method property.

® Produce an invalid result. For example, if you pass a directed graph to a
function with an algorithm that expects an undirected graph, it will ignore
values in the upper triangle of the sparse matrix.

The graph theory functions include graphallshortestpaths, graphconncomp,
graphisdag, graphisomorphism, graphisspantree, graphmaxflow,
graphminspantree, graphpred2path, graphshortestpath, graphtopoorder,
and graphtraverse.

Graph Visualization

The toolbox includes functions, objects, and methods for creating, viewing,
and manipulating graphs such as interactive maps, hierarchy plots, and
pathways. This allows you to view relationships between data.

The object constructor function (biograph) lets you create a biograph object to
hold graph data. Methods of the biograph object let you calculate the position
of nodes (dolayout), draw the graph (view), get handles to the nodes and
edges (getnodesbyid and getedgesbynodeid) to further query information,
and find relations between the nodes (getancestors, getdescendants,

and getrelatives). There are also methods that apply basic graph theory
algorithms to the biograph object.

Various properties of a biograph object let you programmatically change the
properties of the rendered graph. You can customize the node representation,
for example, drawing pie charts inside every node (CustomNodeDrawFcn). Or
you can associate your own callback functions to nodes and edges of the graph,
for example, opening a Web page with more information about the nodes
(NodeCallback and EdgeCallback).

Statistical Learning and Visualization

You can classify and identify features in data sets, set up cross-validation
experiments, and compare different classification methods.

1-19



1 Getting Started

1-20

The toolbox provides functions that build on the classification and statistical
learning tools in the Statistics Toolbox software (classify, kmeans, and
treefit).

These functions include imputation tools (knnimpute), and K-nearest neighbor
classifiers (knnclassify).

Other functions include set up of cross-validation experiments (crossvalind)
and comparison of the performance of different classification methods
(classperf). In addition, there are tools for selecting diversity and
discriminating features (rankfeatures, randfeatures).

Prototyping and Development Environment

The MATLAB environment lets you prototype and develop algorithms and
easily compare alternatives.

¢ Integrated environment — Explore biological data in an environment
that integrates programming and visualization. Create reports and plots
with the built-in functions for mathematics, graphics, and statistics.

* Open environment — Access the source code for the toolbox functions.
The toolbox includes many of the basic bioinformatics functions you will
need to use, and it includes prototypes for some of the more advanced
functions. Modify these functions to create your own custom solutions.

* Interactive programming language — Test your ideas by typing
functions that are interpreted interactively with a language whose basic
data element is an array. The arrays do not require dimensioning and
allow you to solve many technical computing problems,

Using matrices for sequences or groups of sequences allows you to work
efficiently and not worry about writing loops or other programming controls.

* Programming tools — Use a visual debugger for algorithm development
and refinement and an algorithm performance profiler to accelerate
development.

Data Visualization

You can visually compare pairwise sequence alignments, multiply aligned
sequences, gene expression data from microarrays, and plot nucleic acid and
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protein characteristics. The 2-D and volume visualization features let you
create custom graphical representations of multidimensional data sets. You
can also create montages and overlays, and export finished graphics to an
Adobe® PostScript® image file or copy directly into Microsoft PowerPoint®.

Algorithm Sharing and Application Deployment

The open MATLAB environment lets you share your analysis solutions with
other users, and it includes tools to create custom software applications.
With the addition of MATLAB Compiler software, you can create standalone
applications independent of the MATLAB environment, and, with the addition
of MATLAB Builder NE software, you can create GUIs and standalone
applications within other programming environments.

* Share algorithms with other users — You can share data analysis
algorithms created in the MATLAB language across all supported
platforms by giving files to other users. You can also create GUIs within the
MATLAB environment using the Graphical User Interface Development
Environment (GUIDE).

¢ Deploy MATLAB GUIs — Create a GUI within the MATLAB
environment using GUIDE, and then use MATLAB Compiler software

to create a standalone GUI application that runs separately from the
MATLAB environment.

¢ Create dynamic link libraries (DLLs) — Use MATLAB Compiler
software to create DLLs for your functions, and then link these libraries to
other programming environments such as C and C++.

®* Create COM objects — Use MATLAB Builder NE software to create
COM objects, and then use a COM-compatible programming environment
(Visual Basic®) to create a standalone application.

* Create Excel add-ins — Use MATLAB Builder EX software to
create Excel add-in functions, and then use these functions with Excel
spreadsheets.

* Create Java classes — Use MATLAB Builder JA software to
automatically generate Java classes from algorithms written in the
MATLAB programming language. You can run these classes outside the
MATLAB environment.
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Exchange Bioinformatic Data Between Excel and MATLAB

In this section...
“Using Excel and MATLAB Together” on page 1-22

“About the Example” on page 1-22
“Before Running the Example” on page 1-23
“Running the Example for the Entire Data Set” on page 1-23

“Editing Formulas to Run the Example on a Subset of the Data” on page
1-27

“Using the Spreadsheet Link EX Interface to Interact With the Data in
MATLAB” on page 1-28

Using Excel and MATLAB Together

If you have bioinformatic data in an Excel (2007 or 2010) spreadsheet, use
Spreadsheet Link EX to:

¢ Connect Excel with the MATLAB Workspace to exchange data

e Use MATLAB and Bioinformatics Toolbox computational and visualization
functions

About the Example

Note The following example assumes you have Spreadsheet Link EX
software installed on your system.

The Excel file used in the following example contains data from DeRisi, J.L.,
Iyer, V.R., and Brown, P.O. (Oct. 24, 1997). Exploring the metabolic and
genetic control of gene expression on a genomic scale. Science 278(5338),
680—-686. PMID: 9381177. The data was filtered using the steps described
in Gene Expression Profile Analysis.
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Before Running the Example

If not already done, modify your system path to include the MATLAB root
folder as described in “Modify Your System Path” in the Spreadsheet Link
EX documentation.

If not already done, enable the Spreadsheet Link EX Add-In as described in
“Customization” in the Spreadsheet Link EX documentation.

Close MATLAB and Excel if they are open.

Start Excel 2007 or 2010 software. MATLAB and Spreadsheet Link EX
software automatically start.

From Excel, open the following file provided with the Bioinformatics
Toolbox software:

matlabroot\toolbox\bioinfo\biodemos\Filtered_Yeastdata.xlsm

Note matlabroot is the MATLAB root folder, which is where MATLAB
software is installed on your system.

In the Excel software, enable macros. Click the Developer tab, and then
select Macro Security from the Code group. (If the Developer tab is not
displayed on the Excel ribbon, consult Excel Help to display it.)

Running the Example for the Entire Data Set

In the provided Excel file, note that columns A through H contain data
from DeRisi et al. Also note that cells J5, J6, J7, and J12 contain formulas
using Spreadsheet Link EX functions MLPutMatrix and MLEvalString.

Tip To view a cell’s formula, select the cell, and then view the formula in

%

the formula bar at the top of the Excel window.
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2 Execute the formulas in cells J5, J6, J7, and J12, by selecting the cell,
pressing F2, and then pressing Enter.

Each of the first three cells contains a formula using the Spreadsheet Link
EX function MLPutMatrix, which creates a MATLAB variable from the
data in the spreadsheet. Cell J12 contains a formula using the Spreadsheet
Link EX function MLEvalString, which runs the Bioinformatics Toolbox
clustergram function using the three variables as input. For more
information on adding formulas using Spreadsheet Link EX functions, see
“Entering Functions into Worksheet Cells” in the Spreadsheet Link EX
documentation.
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Cells J5, J6, and J7 contain formulas
that use the MLPutMatrix function
to create three MATLAB variables.

Cell J12 contains a formula

that uses the MLEvalString function

to run the Bioinformatics Toolbox function
clustergram.

Fush the data intg’3 MATLAE variables

J === MLFutpdatrix"data" B4:HE17)

=== MLPAtMatrix"Genes" AL ABTT
0 === W¥PutMatrix"TimeSteps" B3:H3)

Fun the clustergram command on the data using the 3 variables

0 === MLEvalString("clustergramidata, 'HowLabels' Genes, 'Calumnls

Fun the rmacro function Clustergram on the data using cell ranges

0| === Clustergram({B4.HB17 Ad.AB17 B3 H3)

Cell J17 contains a formula
that uses a macro function,
Clustergram, created in
Visual Basic Editor.

3 Note that cell J17 contains a formula using a macro function Clustergram,
which was created in the Visual Basic Editor. Running this macro does the
same as the formulas in cells J5, J6, J7, and J12. Optionally, view the
Clustergram macro function by clicking the Developer tab, and then

A
clicking the Visual Basic button j (If the Developer tab is not on the
Excel ribbon, consult Excel Help to display it.)
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For more information on creating macros using Visual Basic Editor, see
“Use Spreadsheet Link EX Functions in Macros” in the Spreadsheet Link

EX documentation.

4 Execute the formula in cell J17 to analyze and visualize the data:
a Select cell J17.
b Press F2.

¢ Press Enter.

The macro function Clustergram runs creating three MATLAB variables
(data, Genes, and TimeSteps) and displaying a Clustergram window
containing dendrograms and a heat map of the data.
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Editing Formulas to Run the Example on a Subset
of the Data

1 Edit the formulas in cells J5 and J6 to analyze a subset of the data. Do
this by editing the formulas’ cell ranges to include data for only the first
30 genes:

a Select cell J5, and then press F2 to display the formula for editing.
Change H617 to H33, and then press Enter.

[=MLPuthatrix("data" B4 HIZ]

b Select cell J6, then press F2 to display the formula for editing. Change
A617 to A33, and then press Enter.

[=MLPuthatrix"Genes" A4 A33) |

2 Run the formulas in cells J5, J6, J7, and J12 to analyze and visualize
a subset of the data:

a Select cell J5, press F2, and then press Enter.
b Select cell J6, press F2, and then press Enter.
¢ Select cell J7, press F2, and then press Enter.
d Select cell J12, press F2, and then press Enter.
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Using the Spreadsheet Link EX Interface to Interact

With the Data in MATLAB
Use the MATLAB group on the right side of the Home tab to interact with

the data:
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4 | Start MATLAB
Send data to MATLAE

et data from MATLAB
Fun MATLAE command
Get MATLAE figure
MATLAE Function Wizard

Preferences

For example, create a variable in MATLAB containing a 3-by-7 matrix of
the data, plot the data in a Figure window, and then add the plot to your
spreadsheet:

1 Click-drag to select cells B5 through H7.

0.305 0.148 0129 -0.444 -0.707 -1.499 -1.935
0.157 0.175 0.467 -0.379 -0.52 -1.279 -2.125
0.248 0.756 0.334 0.851 1.02 1.646 1.157

2 From the MATLAB group, select Send data to MATLAB.
3 Type YAGenes for the variable name, and then click OK.

The variable YAGenes is added to the MATLAB Workspace as a 3-by-7
matrix.

4 From the MATLAB group, select Run MATLAB command.
5 Type plot(YAGenes') for the command, and then click OK.

A Figure window displays a plot of the data.
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Note Make sure you use the ' (transpose) symbol when plotting the data
in this step. You need to transpose the data in YAGenes so that it plots as
three genes over seven time intervals.

6 Select cell J20, and then click from the MATLAB group, select Get
MATLAB figure.

The figure is added to the spreadsheet.
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Get Information from Web Database

In this section...

“What Are get Functions?” on page 1-31

“Creating the getpubmed Function” on page 1-32

What Are get Functions?

Bioinformatics Toolbox includes several get functions that retrieve
information from various Web databases. Additionally, with some basic
MATLAB programming skills, you can create your own get function to
retrieve information from a specific Web database.

The following procedure illustrates how to create a function to retrieve
information from the NCBI PubMed database and read the information into
a MATLAB structure. The NCBI PubMed database contains biomedical
literature citations and abstracts.

service of the U.S. National Library

-

www.pubmed.gov
All Databases PubMed Nucleotide Protein Genome Structure OMIM PMC Journals Books
Search | PublMed | for | Go | Clear | Advanced Search (beta

[ Limits | Preview/index | History | ciipboard | Details |

About Entrez
Text Version To get started with PubMed, enter one or more search terms.

Search terms may be topics, authors or journals.

Set up an automated PubMed update in fewer than
NCB]| five minutes.
PubMed Servic

- 1. Create a My NCBI account.
Joumals Database 2 Save vour search
MeSH Database - -' . . .
Single Citation 3. Your PubMed updates can be e-mailed directly to yvou.

g:tt;:%itaticm Matcher Read the My NCBI Help material to explore other options. such as automated updates of
Clinical Queries ; other databases, setting search filters, and highlighting search terms.

Special Queries

LinkQut

My NCBI PubMed is a service of the U.S. National Librarv of Medicine that includes over 17 million citations
from MEDLINE and other life science journals for biomedical articles back to the 1950s. PubMed
includes links to full text articles and other related resources.

Overview

Help | FAQ
Tutorials
New/Moteworthy B
E-Utilities
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Creating the getpubmed Function

The following procedure shows you how to create a function named getpubmed
using the MATLAB Editor. This function will retrieve citation and abstract
information from PubMed literature searches and write the data to a
MATLAB structure.

Specifically, this function will take one or more search terms, submit them
to the PubMed database for a search, then return a MATLAB structure or
structure array, with each structure containing information for an article
found by the search. The returned information will include a PubMed
identifier, publication date, title, abstract, authors, and citation.

The function will also include property name/property value pairs that let
the user of the function limit the search by publication date and limit the
number of records returned.

1 From MATLAB, open the MATLAB Editor by selecting File > New >
Function.

2 Define the getpubmed function, its input arguments, and return values by
typing:

function pmstruct = getpubmed(searchterm,varargin)
% GETPUBMED Search PubMed database & write results to MATLAB structure

3 Add code to do some basic error checking for the required input SEARCHTERM.

% Error checking for required input SEARCHTERM
if (nargin<t)
error('GETPUBMED:NotEnoughInputArguments',...
'SEARCHTERM is missing.');
end

4 Create variables for the two property name/property value pairs, and set
their default values.

% Set default settings for property name/value pairs,

% 'NUMBEROFRECORDS' and 'DATEOFPUBLICATION'

maxnum = 50; % NUMBEROFRECORDS default is 50

pubdate = ''; % DATEOFPUBLICATION default is an empty string
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5 Add code to parse the two property name/property value pairs if provided
as input.

% Parsing the property name/value pairs
num_argin = numel(varargin);
for n = 1:2:num_argin

arg = varargin{n};

switch lower(arg)

% If NUMBEROFRECORDS is passed, set MAXNUM
case 'numberofrecords'
maxnum = varargin{n+1};

% If DATEOFPUBLICATION is passed, set PUBDATE
case 'dateofpublication'
pubdate = varargin{n+1};

end
end

6 You access the PubMed database through a search URL, which submits
a search term and options, and then returns the search results in a
specified format. This search URL is comprised of a base URL and defined
parameters. Create a variable containing the base URL of the PubMed
database on the NCBI Web site.

% Create base URL for PubMed db site
baseSearchURL = 'http://www.ncbi.nlm.nih.gov/sites/entrez?cmd=search’;

7 Create variables to contain five defined parameters that the getpubmed
function will use, namely, db (database), term (search term), report (report
type, such as MEDLINE®), format (format type, such as text), and dispmax
(maximum number of records to display).

% Set db parameter to pubmed
dbOpt = '&db=pubmed’;

% Set term parameter to SEARCHTERM and PUBDATE

% (Default PUBDATE is '')
termOpt = ['&term=',searchterm, '+AND+',pubdate];
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% Set report parameter to medline
reportOpt = '&report=medline’;

% Set format parameter to text
formatOpt = '&format=text';

% Set dispmax to MAXNUM
% (Default MAXNUM is 50)
maxOpt = ['&dispmax="',num2str(maxnum)];

8 Create a variable containing the search URL from the variables created
in the previous steps.

% Create search URL
searchURL = [baseSearchURL,dbOpt,termOpt,reportOpt,formatOpt,maxOpt];

9 Use the urlread function to submit the search URL, retrieve the search
results, and return the results (as text in the MEDLINE report type) in
medlineText, a character array.

medlineText = urlread(searchURL);

10 Use the MATLAB regexp function and regular expressions to parse and
extract the information in medlineText into hits, a cell array, where each
cell contains the MEDLINE-formatted text for one article. The first input
1s the character array to search, the second input is a search expression,
which tells the regexp function to find all records that start with PMID-,
while the third input, 'match’, tells the regexp function to return the
actual records, rather than the positions of the records.

hits = regexp(medlineText, 'PMID-.*?(?=PMID|</pre>$)', 'match');

11 Instantiate the pmstruct structure returned by getpubmed to contain six
fields.

pmstruct = struct('PubMedID','"', 'PublicationDate',"'"', 'Title',"'",...
"Abstract','', 'Authors','','Citation',"'");

12 Use the MATLAB regexp function and regular expressions to loop through
each article in hits and extract the PubMed ID, publication date, title,
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13

abstract, authors, and citation. Place this information in the pmstruct
structure array.

for n = 1:numel(hits)
pmstruct(n).PubMedID = regexp(hits{n},'(?<=PMID- ).*?(?=\n)', 'match', 'once');
pmstruct(n).PublicationDate = regexp(hits{n},'(?<=DP - ).*?(?=\n)','match', 'once');
pmstruct(n).Title = regexp(hits{n},'(?<=TI - ).*2(?=PG -|AB -)','match', 'once');
pmstruct(n).Abstract = regexp(hits{n},'(?<=AB - ).*?(?=AD -)','match', 'once');
pmstruct(n).Authors = regexp(hits{n},'(?<=AU - ).*?(?=\n)','match');
pmstruct(n).Citation = regexp(hits{n},'(?<=S0 - ).*?(?=\n)','match', 'once');

end

Select File > Save As.

When you are done, your file should look similar to the getpubmed.m
file included with the Bioinformatics Toolbox software. The sample
getpubmed.m file, including help, is located at:

matlabroot\toolbox\bioinfo\biodemos\getpubmed.m

Note The notation matlabroot is the MATLAB root directory, which is
the directory where the MATLAB software is installed on your system.

1-35



1 Getting Started

1-36



High-Throughput Sequence
Analysis

* “Work with Large Multi-Entry Text Files” on page 2-2

e “Manage Short-Read Sequence Data in Objects” on page 2-8

® “Store and Manage Feature Annotations in Objects” on page 2-23
® “Visualize and Investigate Short-Read Alignments” on page 2-31

¢ “Identifying Differentially Expressed Genes from RNA-Seq Data” on page
2-44

¢ “Exploring Protein-DNA Binding Sites from Paired-End ChIP-Seq Data”
on page 2-65

e “Exploring Genome-wide Differences in DNA Methylation Profiles” on page
2-87
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Work with Large Multi-Entry Text Files

In this section...

“Overview” on page 2-2

“What Files Can You Access?” on page 2-2

“Before You Begin” on page 2-3

“Create a BioIndexedFile Object to Access Your Source File” on page 2-4

“Determine the Number of Entries Indexed By a BioIndexedFile Object”
on page 2-5

“Retrieve Entries from Your Source File” on page 2-5

“Read Entries from Your Source File” on page 2-6

Overview

Many biological experiments produce huge data files that are difficult to
access due to their size, which can cause memory issues when reading the
file into the MATLAB Workspace. You can construct a BioIndexedFile
object to access the contents of a large text file containing nonuniform size
entries, such as sequences, annotations, and cross-references to data sets.
The BioIndexedFile object lets you quickly and efficiently access this data
without loading the source file into memory.

You can use the BioIndexedFile object to access individual entries or a
subset of entries when the source file is too big to fit into memory. You can
access entries using indices or keys. You can read and parse one or more
entries using provided interpreters or a custom interpreter function.

Use the BioIndexedFile object in conjunction with your large source file to:

® Access a subset of the entries for validation or further analysis.

® Parse entries using a custom interpreter function.

What Files Can You Access?
You can use the BioIndexedFile object to access large text files.
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Your source file can have these application-specific formats:

e FASTA
e FASTQ
e SAM

Your source file can also have these general formats:

¢ Table — Tab-delimited table with multiple columns. Keys can be in any
column. Rows with the same key are considered separate entries.

® Multi-row Table — Tab-delimited table with multiple columns. Keys
can be in any column. Contiguous rows with the same key are considered
a single entry. Noncontiguous rows with the same key are considered
separate entries.

¢ Flat — Flat file with concatenated entries separated by a character string,
typically //. Within an entry, the key is separated from the rest of the
entry by a white space.

Before You Begin

Before constructing a BioIndexedFile object, locate your source file on your
hard drive or a local network.

When you construct a BioIndexedFile object from your source file for the

first time, you also create an auxiliary index file, which by default is saved
to the same location as your source file. However, if your source file is in a
read-only location, you can specify a different location to save the index file.

Tip If you construct a BioIndexedFile object from your source file on
subsequent occasions, it takes advantage of the existing index file, which
saves time. However, the index file must be in the same location or a location
specified by the subsequent construction syntax.
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Tip If insufficient memory is not an issue when accessing your source file,
you may want to try an appropriate read function, such as genbankread, for
importing data from GenBank files. .

Additionally, several read functions such as fastaread, fastqgread, samread,
and sffread include a Blockread property, which lets you read a subset of
entries from a file, thus saving memory.

Create a BiolndexedFile Object to Access Your Source
File

To construct a BioIndexedFile object from a multi-row table file:

1 Create a variable containing the full absolute path of your source file. For
your source file, use the yeastgenes.sgd file, which is included with the
Bioinformatics Toolbox software.

sourcefile = which('yeastgenes.sgd');

2 Use the BioIndexedFile constructor function to construct a
BioIndexedFile object from the yeastgenes.sgd source file, which is a
multi-row table file. Save the index file in the Current Folder. Indicate that
the source file keys are in column 3. Also, indicate that the header lines in
the source file are prefaced with !, so the constructor ignores them.

gene2goObj = BioIndexedFile('mrtab', sourcefile, '.', ...
'KeyColumn', 3, 'HeaderPrefix','!")

The BioIndexedFile constructor function constructs gene2goObj, a
BioIndexedFile object, and also creates an index file with the same name
as the source file, but with an IDX extension. It stores this index file in the
Current Folder because we specified this location. However, the default
location for the index file is the same location as the source file.

Caution Do not modify the index file. If you modify it, you can get invalid
results. Also, the constructor function cannot use a modified index file to
construct future objects from the associated source file.
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Determine the Number of Entries Indexed By a
BiolndexedFile Object

To determine the number of entries indexed by a BioIndexedFile object, use
the NumEntries property of the BioIndexedFile object. For example, for
the gene2goObj object:

gene2goObj .NumEntries
ans =

6476

Note For a list and description of all properties of a BioIndexedFile object,
see BioIndexedFile class.

Retrieve Entries from Your Source File
Retrieve entries from your source file using either:

¢ The index of the entry
¢ The entry key

Retrieve Entries Using Indices

Use the getEntryByIndex method to retrieve a subset of entries from your
source file that correspond to specified indices. For example, retrieve the first
12 entries from the yeastgenes.sgd source file:

subset_entries = getEntryByIndex(gene2goObj, [1:12]);

Retrieve Entries Using Keys

Use the getEntryByKey method to retrieve a subset of entries from your
source file that are associated with specified keys. For example, retrieve all
entries with keys of AAC1 and AAD10 from the yeastgenes.sgd source file:

subset_entries = getEntryByKey(gene2goObj, {'AAC1' 'AAD10'});
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The output subset entries is a single string of concatenated entries.
Because the keys in the yeastgenes.sgd source file are not unique, this
method returns all entries that have a key of AAC1 or AAD10.

Read Entries from Your Source File

The BioIndexedFile object includes a read method, which you can use to
read and parse a subset of entries from your source file. The read method
parses the entries using an interpreter function specified by the Interpreter
property of the BioIndexedFile object.

Set the Interpreter Property

Before using the read method, make sure the Interpreter property of the
BioIndexedFile object is set appropriately.

If you constructed a The Interpreter property ...
BiolndexedFile object from

A source file with an By default is a handle to a function

application-specific format appropriate for that file type and

(FASTA, FASTQ, or SAM) typically does not require you to change
it.

A source file with a table, By default is [ ], which means the

multi-row table, or flat format interpreter is an anonymous function

in which the output is equivalent to the
input. You can change this to a handle
to a function that accepts a single string
of one or more concatenated entries
and returns a structure or an array of
structures containing the interpreted
data.

There are two ways to set the Interpreter property of the BioIndexedFile
object:

® When constructing the BioIndexedFile object, use the Interpreter
property name/property value pair
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e After constructing the BioIndexedFile object, set the Interpreter
property

Note For more information on setting the Interpreter property of a
BioIndexedFile object, see BioIndexedFile class.

Read a Subset of Entries

The read method reads and parses a subset of entries that you specify using
either entry indices or keys.

Example

To quickly find all the gene ontology (GO) terms associated with a particular
gene because the entry keys are gene names:

1 Set the Interpreter property of the gene2goObj BioIndexedFile object
to a handle to a function that reads entries and returns only the column
containing the GO term. In this case the interpreter is a handle to an
anonymous function that accepts strings and extracts strings that start
with the characters GO.

gene2goObj.Interpreter = @(x) regexp(x, 'GO:\d+', 'match')

2 Read only the entries that have a key of YATZ2, and return their GO terms.

GO_YAT2_entries = read(gene2goObj, 'YAT2')

GO_YAT2_entries

'G0:0004092' 'G0:0005737' 'GO:0006066' 'GO:0006066' 'GO:0009437'
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Manage Short-Read Sequence Data in Objects

In this section...

“Overview” on page 2-8

Object” on page 2-11

“Represent Sequence and Quality Data in a BioRead Object” on page 2-9
“Represent Sequence, Quality, and Alignment/Mapping Data in a BioMap

“Retrieve Information from a BioRead or BioMap Object” on page 2-15
“Set Information in a BioRead or BioMap Object” on page 2-17
“Determine Coverage of a Reference Sequence” on page 2-18

“Construct Sequence Alignments to a Reference Sequence” on page 2-20

“Filter Read Sequences Using SAM Flags” on page 2-21

Overview

High-throughput sequencing instruments produce large amounts of short-read
sequence data that can be challenging to store and manage. Using objects to
contain this data lets you easily access, manipulate, and filter the data.

Bioinformatics Toolbox includes two objects for working with short-read

sequence data.

Object Contains This Information | Construct from One of
These
BioRead ® Sequence headers e FASTQ file
® Read sequences e SAM file

® Sequence qualities (base
calling)

FASTQ structure (created
using the fastqread
function)

SAM structure (created
using the samread function)

Cell arrays containing
header, sequence, and
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Object

Contains This Information

Construct from One of
These

quality information
(created using the
fastqgread function)

BioMap

® Sequence headers
® Read sequences

® Sequence qualities (base
calling)

® Sequence alignment and
mapping information
(relative to a single

e SAM file
e BAM file

e SAM structure (created
using the samread function)

® BAM structure (created
using the bamread function)

e Cell arrays containing

reference sequence),

including mapping quality header, sequence, quality,

and mapping/alignment
information (created using
the samread or bamread
function)

Represent Sequence and Quality Data in a BioRead
Obiject

Prerequisites

A BioRead object represents a collection of short-read sequences. Each
element in the object is associated with a sequence, sequence header, and
sequence quality information.

Construct a BioRead object in one of two ways:

¢ Indexed — The data remains in the source file. Constructing the object
and accessing its contents is memory efficient. However, you cannot modify
object properties, other than the Name property. This is the default method
if you construct a BioRead object from a FASTQ- or SAM-formatted file.

® In Memory — The data is read into memory. Constructing the object
and accessing its contents is limited by the amount of available memory.
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However, you can modify object properties. When you construct a BioRead
object from a FASTQ structure or cell arrays, the data is read into memory.
When you construct a BioRead object from a FASTQ- or SAM-formatted file,
use the InMemory name-value pair argument to read the data into memory.

Construct a BioRead Object from a FASTQ- or SAM-Formatted
File

Note This example constructs a BioRead object from a FASTQ-formatted file.
Use similar steps to construct a BioRead object from a SAM-formatted file.

Use the BioRead constructor function to construct a BioRead object from a
FASTQ-formatted file and set the Name property:

BRObj 1

BioRead('SRR005164_1_50.fastq', 'Name', 'MyObject')

BRObj1
BioRead with properties:

Quality: [50x1 File indexed property]
Sequence: [50x1 File indexed property]
Header: [50x1 File indexed property]
NSeqgs: 50
Name: 'MyObject'

The constructor function construct a BioRead object and, if an index file does
not already exist, it also creates an index file with the same file name, but
with an .IDX extension. This index file, by default, is stored in the same
location as the source file.
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Caution Your source file and index file must always be in sync.

® After constructing a BioRead object, do not modify the index file, or you
can get invalid results when using the existing object or constructing new
objects.

¢ If you modify the source file, delete the index file, so the object constructor
creates a new index file when constructing new objects.

Note Because you constructed this BioRead object from a source file, you
cannot modify the properties (except for Name) of the BioRead object.

Represent Sequence, Quality, and
Alignment/Mapping Data in a BioMap Object

Prerequisites

A BioMap object represents a collection of short-read sequences that map
against a single reference sequence. Each element in the object is associated
with a read sequence, sequence header, sequence quality information, and
alignment/mapping information.

When constructing a BioMap object from a BAM file, the maximum size of the
file is limited by your operating system and available memory.

Construct a BioMap object in one of two ways:

¢ Indexed — The data remains in the source file. Constructing the object
and accessing its contents is memory efficient. However, you cannot modify
object properties, other than the Name property. This is the default method
if you construct a BioMap object from a SAM- or BAM-formatted file.

¢ In Memory — The data is read into memory. Constructing the object
and accessing its contents is limited by the amount of available memory.
However, you can modify object properties. When you construct a BioMap
object from a structure, the data stays in memory. When you construct
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a BioMap object from a SAM- or BAM-formatted file, use the InMemory
name-value pair argument to read the data into memory.

Construct a BioMap Object from a SAM- or BAM-Formatted File

Note This example constructs a BioMap object from a SAM-formatted file.
Use similar steps to construct a BioMap object from a BAM-formatted file.

1 If you do not know the number and names of the reference sequences in

your source file, determine them using the saminfo or baminfo function
and the ScanDictionary name-value pair argument.

samstruct = saminfo('ex2.sam', 'ScanDictionary', true);
samstruct.ScannedDictionary

ans =

'seql’
'seqg2'

Tip The previous syntax scans the entire SAM file, which is time
consuming. If you are confident that the Header information of the SAM
file 1s correct, omit the ScanDictionary name-value pair argument, and
inspect the SequenceDictionary field instead.

Use the BioMap constructor function to construct a BioMap object from
the SAM file and set the Name property. Because the SAM-formatted file
in this example, ex2.sam, contains multiple reference sequences, use the
SelectRef name-value pair argument to specify one reference sequence,
seqi:

BMObj2 = BioMap('ex2.sam', 'SelectRef', 'seql', 'Name', 'MyObject')
BMObj2 =

BioMap with properties:
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SequenceDictionary: 'seql'
Reference: [1501x1 File indexed property]
Signature: [1501x1 File indexed property]
Start: [1501x1 File indexed property]
MappingQuality: [1501x1 File indexed property]
Flag: [1501x1 File indexed property]
MatePosition: [1501x1 File indexed property]
Quality: [1501x1 File indexed property]
Sequence: [1501x1 File indexed property]
Header: [1501x1 File indexed property]
NSeqs: 1501
Name: 'MyObject'

The constructor function constructs a BioMap object and, if index files do not
already exist, it also creates one or two index files:

If constructing from a SAM-formatted file, it creates one index file that has
the same file name as the source file, but with an .IDX extension. This
index file, by default, is stored in the same location as the source file.

If constructing from a BAM-formatted file, it creates two index files that
have the same file name as the source file, but one with a .BAI extension
and one with a .LINEARINDEX extension. These index files, by default,
are stored in the same location as the source file.

Caution Your source file and index files must always be in sync.

After constructing a BioMap object, do not modify the index files, or you
can get invalid results when using the existing object or constructing new
objects.

If you modify the source file, delete the index files, so the object constructor
creates new index files when constructing new objects.
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Note Because you constructed this BioMap object from a source file, you
cannot modify the properties (except for Name and Reference) of the BioMap
object.

Construct a BioMap Object from a SAM or BAM Structure

Note This example constructs a BioMap object from a SAM structure using
samread. Use similar steps to construct a BioMap object from a BAM structure
using bamread.

1 Use the samread function to create a SAM structure from a SAM-formatted
file:

SAMStruct = samread('ex2.sam');

2 To construct a valid BioMap object from a SAM-formatted file, the file must
contain only one reference sequence. Determine the number and names
of the reference sequences in your SAM-formatted file using the unique
function to find unique names in the ReferenceName field of the structure:

unique ({SAMStruct.ReferenceName})
ans =
‘seql’ ‘seq2’
3 Use the BioMap constructor function to construct a BioMap object from a
SAM structure. Because the SAM structure contains multiple reference

sequences, use the SelectRef name-value pair argument to specify one
reference sequence, seqi:

BMObj1 BioMap (SAMStruct, 'SelectRef', 'seql')

BMObj 1

BioMap with properties:
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Retrieve Information from a BioRead or BioMap

SequenceDictionary:
Reference:
Signature:

Start:
MappingQuality:
Flag:
MatePosition:
Quality:
Sequence:
Header:

NSeqs:

Name:

Obiject

You can retrieve all or a subset of information from a BioRead or BioMap

object.

Retrieve a Property from a BioRead or BioMap Obiject
You can retrieve a specific property from elements in a BioRead or BioMap

object.

For example, to retrieve all headers from a BioRead object, use the Header

property as follows:

{'seq1'}
{1501x1
{1501x1
[1501x1
[1501x1
[1501x1
[1501x1
{1501x1
{1501x1
{1501x1
1501

allHeaders = BRObj1.Header;

This syntax returns a cell array containing the headers for all elements in the

BioRead object.

Similarly, to retrieve all start positions of aligned read sequences from a
BioMap object, use the Start property of the object:

allStarts = BMObj1.Start;

This syntax returns a vector containing the start positions of aligned read
sequences with respect to the position numbers in the reference sequence in

a BioMap object.

cell}
cell}
uint32]
uint8]
uinti16]
uint32]
cell}
cell}
cell}
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Retrieve Multiple Properties from a BioRead or BioMap Object
You can retrieve multiple properties from a BioRead or BioMap object in a
single command using the get method. For example, to retrieve both start
positions and headers information of a BioMap object, use the get method as
follows:

multiProp = get(BMObj1, {'Start', 'Header'});

This syntax returns a cell array containing all start positions and headers
information of a BioMap object.

Note Property names are case sensitive.

For a list and description of all properties of a BioRead object, see BioRead
class. For a list and description of all properties of a BioMap object, see BioMap
class.

Retrieve a Subset of Information from a BioRead or BioMap
Object

Use specialized get methods with a numeric vector, logical vector, or cell
array of headers to retrieve a subset of information from an object. For
example, to retrieve the first 10 elements from a BioRead object, use the
getSubset method:

newBRObj = getSubset(BRObji1, [1:10]);

This syntax returns a new BioRead object containing the first 10 elements in
the original BioRead object.

For example, to retrieve the first 12 positions of sequences with headers
SRR005164.1, SRR005164.7, and SRR005164.16, use the getSubsequence
method:

subSeqs = getSubsequence(BRObj1,
{'SRR005164.1"', 'SRR005164.7', 'SRR005164.16'}, [1:12]")

subSeqs
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'"TGGCTTTAAAGC'
'CCCGAAAGCTAG'
"AATTTTGCGGCT'

For example, to retrieve information about the third element in a BioMap
object, use the getInfo method:

Info_3 = getInfo(BMObj1, 3);

This syntax returns a tab-delimited string containing this information for
the third element:

® Sequence header

e SAM flags for the sequence

e Start position of the aligned read sequence with respect to the reference
sequence

e Mapping quality score for the sequence
¢ Signature (CIGAR-formatted string) for the sequence
® Sequence

® Quality scores for sequence positions

Note Method names are case sensitive.

For a complete list and description of methods of a BioRead object, see
BioRead class. For a complete list and description of methods of a BioMap
object, see BioMap class.

Set Information in a BioRead or BioMap Obiject

Prerequisites

To modify properties (other than Name and Reference) of a BioRead or BioMap
object, the data must be in memory, and not indexed. To ensure the data is
in memory, do one of the following:
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e Construct the object from a structure as described in “Construct a BioMap
Object from a SAM or BAM Structure” on page 2-14.

¢ Construct the object from a source file using the InMemory name-value
pair argument.

Provide Custom Headers for Sequences
First, create an object with the data in memory:

BRObj1 = BioRead('SRR005164_1_50.fastq', 'InMemory',true);

To provide custom headers for sequences of interest (in this case sequences 1
to 5), do the following:

BRObj1.Header(1:5) = {'H1', 'H2', 'H3', 'H4', 'H5'};
Alternatively, you can use the setHeader method:
BRObj1 = setHeader (BRObj1, {'H1', 'H2', 'H3', 'H4', 'H5'}, [1:5]);

Several other specialized set methods let you set the properties of a subset of
elements in a BioRead or BioMap object.

Note Method names are case sensitive.

For a complete list and description of methods of a BioRead object, see
BioRead class. For a complete list and description of methods of a BioMap
object, see BioMap class.

Determine Coverage of a Reference Sequence

When working with a BioMap object, you can determine the number of read
sequences that:

e Align within a specific region of the reference sequence

e Align to each position within a specific region of the reference sequence
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For example, you can compute the number, indices, and start positions of
the read sequences that align within the first 25 positions of the reference
sequence. To do so, use the getCounts, getIndex, and getStart methods:

Cov getCounts(BMObj1, 1, 25)

Cov

12

Indices = getIndex(BMObj1, 1, 25)

Indices =
1
2
3
4
5
6
7
8
9
10
11
12
startPos = getStart(BMObj1, Indices)
startPos =
1
3
5
6
9
13
13
15
18
22
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22
24

The first two syntaxes return the number and indices of the read sequences
that align within the specified region of the reference sequence. The last
syntax returns a vector containing the start position of each aligned read
sequence, corresponding to the position numbers of the reference sequence.

For example, you can also compute the number of the read sequences that
align to each of the first 10 positions of the reference sequence. For this
computation, use the getBaseCoverage method:

Cov getBaseCoverage (BMObj1, 1, 10)

Cov

1 1 2 2 3 4 4 4 5 5

Construct Sequence Alignments to a Reference
Sequence
It is useful to construct and view the alignment of the read sequences that

align to a specific region of the reference sequence. It is also helpful to know
which read sequences align to this region in a BioMap object.

For example, to retrieve the alignment of read sequences to the first 12
positions of the reference sequence in a BioMap object, use the getAlignment
method:

[Alignment_1_12, Indices] = getAlignment(BMObj2, 1, 12)
Alignment_1_12 =

CACTAGTGGCTC
CTAGTGGCTC
AGTGGCTC
GTGGCTC

GCTC

Indices =
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Return the headers of the read sequences that align to a specific region of
the reference sequence:

alignedHeaders getHeader (BMObj2, Indices)

alignedHeaders

'B7_591:4:96:693:509'
'"EAS54_65:7:152:368:113"
'"EAS51_64:8:5:734:57"'
'B7_591:1:289:587:906'
'EAS56_59:8:38:671:758'

Filter Read Sequences Using SAM Flags

SAM- and BAM-formatted files include the status of 11 binary flags for each
read sequence. These flags describe different sequencing and alignment
aspects of a read sequence. For more information on the flags, see theSAM
Format Specification. The filterByFlag method lets you filter the read
sequences in a BioMap object by using these flags.

Filter Unmapped Read Sequences

1 Construct a BioMap object from a SAM-formatted file.

BMObj2 = BioMap('ex1.sam');

2 Use the filterByFlag method to create a logical vector indicating the read
sequences in a BioMap object that are mapped.

LogicalVec_mapped = filterByFlag(BMObj2, 'unmappedQuery', false);

3 Use this logical vector and the getSubset method to create a new BioMap
object containing only the mapped read sequences.
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filteredBMObj_1 = getSubset(BMObj2, LogicalVec_mapped);

Filter Read Sequences That Are Not Mapped in a Pair

1 Construct a BioMap object from a SAM-formatted file.

BMObj2 = BioMap('ex1.sam');

2 Use the filterByFlag method to create a logical vector indicating the read
sequences in a BioMap object that are mapped in a proper pair, that is, both
the read sequence and its mate are mapped to the reference sequence.

LogicalVec_paired = filterByFlag(BMObj2, 'pairedInMap', true);

3 Use this logical vector and the getSubset method to create a new BioMap
object containing only the read sequences that are mapped in a proper pair.

filteredBMObj_2 = getSubset(BMObj2, LogicalVec_paired);
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Store and Manage Feature Annotations in Objects

In this section...

“Represent Feature Annotations in a GFFAnnotation or GTFAnnotation
Object” on page 2-23

“Construct an Annotation Object” on page 2-23
“Retrieve General Information from an Annotation Object” on page 2-24

“Access Data in an Annotation Object” on page 2-25

“Use Feature Annotations with Short-Read Sequence Data” on page 2-26

Represent Feature Annotations in a GFFAnnotation
or GTFAnnotation Object

The GFFAnnotation and GTFAnnotation objects represent a collection of
feature annotations for one or more reference sequences. You construct
these objects from GFF (General Feature Format) and GTF (Gene Transfer
Format) files. Each element in the object represents a single annotation.
The properties and methods associated with the objects let you investigate
and filter the data based on reference sequence, a feature (such as CDS or
exon), or a specific gene or transcript.

Construct an Annotation Object

Use the GFFAnnotation constructor function to construct a GFFAnnotation
object from either a GFF- or GTF-formatted file:

GFFAnnotObj GFFAnnotation('tair8_1.gff"')

GFFAnnotObj
GFFAnnotation with properties:

FieldNames: {1x9 cell}
NumEntries: 3331

Use the GTFAnnotation constructor function to construct a GTFAnnotation
object from a GTF-formatted file:
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GTFAnnotObj = GTFAnnotation('hum37_2_ 1M.gtf')

GTFAnnotObj
GTFAnnotation with properties:

FieldNames: {1x11 cell}
NumEntries: 308

Retrieve General Information from an Annotation

Obiject

Determine the field names and the number of entries in an annotation object
by accessing the FieldNames and NumEntries properties. For example, to see
the field names for each annotation object constructed in the previous section,

query the FieldNames property:
GFFAnnotObj.FieldNames
ans =
Columns 1 through 6
'Reference’ 'Start’ "Stop’ 'Feature'
Columns 7 through 9
'Strand’ ‘Frame' "Attributes’
GTFAnnotObj.FieldNames
ans =
Columns 1 through 6
'Reference’ 'Start’ "Stop’ 'Feature'
Columns 7 through 11

‘Source'’ 'Score' ‘Strand’ 'Frame'

'Source'’

'Gene'’

"Attributes’

'Score'

‘Transcript'’
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Determine the range of the reference sequences that are covered by feature
annotations by using the getRange method with the annotation object
constructed in the previous section:

range = getRange(GFFAnnotObj)

range

3631 498516

Access Data in an Annotation Object

Create a Structure of the Annotation Data

Creating a structure of the annotation data lets you access the field values.
Use the getData method to create a structure containing a subset of the data
in a GFFAnnotation object constructed in the previous section.

% Extract annotations for positions 1 through 10000 of the
% reference sequence
AnnotStruct = getData(GFFAnnotObj,1,10000)

AnnotStruct =

60x1 struct array with fields:

Reference

Start

Stop

Feature

Source

Score

Strand

Frame

Attributes

Access Field Values in the Structure
Use dot indexing to access all or specific field values in a structure.

For example, extract the start positions for all annotations:
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Starts = AnnotStruct.Start;

Extract the start positions for annotations 12 through 17. Notice that you
must use square brackets when indexing a range of positions:

Starts_12_17 = [AnnotStruct(12:17).Start]

Starts_12_17

4706 5174 5174 5439 5439 5631
Extract the start position and the feature for the 12th annotation:

Start_12

AnnotStruct(12).Start

Start_12

4706

Feature_12 AnnotStruct(12).Feature

Feature_12
CDS

Use Feature Annotations with Short-Read Sequence
Data

Investigate the results of short-read sequence experiments by using
GFFAnnotation and GTFAnnotation objects with BioMap objects. For example,
you can:

¢ Determine counts of short-read sequences aligned to regions of a reference

sequence associated with specific annotations, such as in RNA-Seq
workflows.

¢ Find annotations within a specific range of a peak of interest in a reference
sequence, such as in ChIP-Seq workflows.

Determine Annotations of Interest

1 Construct a GTFAnnotation object from a GTF- formatted file:
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GTFAnnotObj = GTFAnnotation('hum37_2 1M.gtf');

2 Use the getReferenceNames method to return the names for the reference
sequences for the annotation object:

refNames = getReferenceNames (GTFAnnotObj)

refNames
'chr2'

3 Use the getFeatureNames method to retrieve the feature names from the
annotation object:

featureNames getFeatureNames (GTFAnnotObj)

featureNames

'CDS'

‘exon'
'start_codon'
'stop_codon'

4 Use the getGeneNames method to retrieve a list of the unique gene names
from the annotation object:

geneNames getGeneNames (GTFAnnotObj)

geneNames

'uc002qvu.2'
'uc002qvv.2'
'uc002qvw.2'
'uc002qvx.2'
'uc002qvy.2'
'uc002qvz.2'
'uc002qwa.2'
'uc002qwb .2
'uc002qwec. 1"
'uc002qwd.2'
'uc002qwe . 3"
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'uc002qwf.2'
'uc002qwg.2'
'uc002qwh.2'
‘uc002qwi.3'
'uc002qwk.2'
'uc002qwl.2'’
'uc002qwm. 1"’
'uc002qwn. 1’
‘uc002qwo .1’
'uc002qwp.2'
'uc002qwq.2'
'uc010ewe.2'
'uc010ewf.1'
‘uc010ewg.2'
'uc010ewh.1'
'uc010ewi.2'
‘uc010yim.1'

The previous steps gave us a list of available reference sequences, features,
and genes associated with the available annotations. Use this information
to determine annotations of interest. For instance, you might be interested
only in annotations that are exons associated with the uc002qvv.2 gene on
chromosome 2.

Filter Annotations

Use the getData method to filter the annotations and create a structure
containing only the annotations of interest, which are annotations that are
exons associated with the uc002qvv.2 gene on chromosome 2.

AnnotStruct

getData(GTFAnnotObj, 'Reference', 'chr2',...
'Feature', 'exon','Gene', 'uc002qvv.2")

AnnotStruct

12x1 struct array with fields:
Reference
Start
Stop
Feature

2-28



Store and Manage Feature Annotations in Obijects

Gene
Transcript
Source
Score
Strand
Frame
Attributes

The return structure contains 12 elements, indicating there are 12
annotations that meet your filter criteria.

Extract Position Ranges for Annotations of Interest

After filtering the data to include only annotations that are exons associated
with the uc002qvv.2 gene on chromosome 2, use the Start and Stop fields to
create vectors of the start and end positions for the ranges associated with the
12 annotations.

StartPos = [AnnotStruct.Start];
EndPos = [AnnotStruct.Stopl;

Determine Counts of Short-Read Sequences Aligned to
Annotations

Construct a BioMap object from a BAM-formatted file containing short-read
sequence data aligned to chromosome 2.

BMObj3 = BioMap('ex3.bam');

Then use the range for the annotations of interest as input to the getCounts
method of a BioMap object. This returns the counts of short reads aligned to
the annotations of interest.

counts = getCounts(BMObj3,StartPos,EndPos, 'independent', true)

counts
1399
54

221
97
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Visualize and Investigate Short-Read Alignments

In this section...

“When to Use the NGS Browser to Visualize and Investigate Data” on page
2-31

“Open the NGS Browser” on page 2-32

“Import Data into the NGS Browser” on page 2-33

“Zoom and Pan to a Specific Region of the Alignment” on page 2-36
“View Coverage of the Reference Sequence” on page 2-37

“View the Pileup View of Short Reads” on page 2-38

“Compare Alignments of Multiple Data Sets” on page 2-39

“View Location, Quality Scores, and Mapping Information” on page 2-40
“Flag Reads” on page 2-41

“Evaluate and Flag Mismatches” on page 2-42

“View Insertions and Deletions” on page 2-43

“View Feature Annotations” on page 2-43

“Print and Export the Browser Image” on page 2-43

When to Use the NGS Browser to Visualize and
Investigate Data

The NGS Browser lets you visually verify and investigate the alignment of
short-read sequences to a reference sequence, in support of analyses that
measure genetic variations and gene expression. The NGS Browser lets you:
¢ Visualize short-read data aligned to a nucleotide reference sequence.

¢ Compare multiple data sets aligned against a common reference sequence.
® View coverage of different bases and regions of the reference sequence.

¢ Investigate quality and other details of aligned reads.

Identify mismatches due to base calling errors or polymorphisms.

Visualize insertions and deletions.
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® Retrieve feature annotations relative to a specific region of the reference

sequence.

® Investigate regions of interest in the alignment, determined by various

analyses.

You can visualize and investigate the aligned data before, during, or after any
preprocessing (filtering, quality recalibration) or analysis steps you perform

on the aligned data.

Open the NGS Browser

To open the NGS Browser, type the following in the MATLAB Command

Window:
ngsbrowser
A NGS Browser o)==
File Desktop Window Help
Center on Position: 0 «p @
Track List " x
Overview B El_ %
Name Type Visible  Data Source
Ruler
Settings a x
Visible range for display (kb): |10
Show Overview
Specify nucleotide colors:
-n M- C - -7 H-N

Read name

Base Pos
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Import Data into the NGS Browser

Ruler indicates maximum coveragein display range

Rubberband indicates range displaye

Overview 1,560 bp
€ l I
/ 300 1,000
Ruler /
784 bp
Ap SIZIIZI bp E-EIEI bp F"IZIIZI bp BEIIZI bp FJDIZI bp
|
e ref |||||||.||||III||||I|||||||||||||||II||I||||-| IIIIII IIIIIIIII IIIIIII | ||II-I|| IIIII
El ex1
| |
I
[ 11 |
| [ |
I |
| 1
| [l
| | 1|
[ | Il I
| I
I |
| [ |
| |
| Il |
[ | [ ]
| | |
[ 1 | I b
[l
| | |
=l feat L | L
eatures 9.33

Browser Displaying Reference Track, One Alignment Track, and One Annotation Track
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Import a Reference Sequence

You can import a single reference sequence into the NGS Browser. The
reference sequence must be in a FASTA file.

1 Select File > Add Data from File.

2 In the Open dialog box, select a FASTA file, and then click Open.

Tip You can use the getgenbank function with the ToFile and SequenceOnly
name-value pair arguments to retrieve a reference sequence from the
GenBank database and save it to a FASTA-formatted file.

Import Short-Read Alignment Data

You can import multiple data sets of short-read alignment data. The
alignment data must be in either of the following:

® BioMap object

Tip Construct a BioMap object from a SAM- or BAM-formatted file to
investigate, subset, and filter the data before importing it into the NGS
Browser.

e SAM- or BAM-formatted file

Note Your SAM- or BAM-formatted file must:
= Have reads ordered by start position in the reference sequence.

= Have an IDX index file (for a SAM-formatted file) or BAI and
LINEARINDEX index files (for a BAM-formatted file) stored in the same
location as your source file. Otherwise, the source file must be stored
in a location to which you have write access, because MATLAB needs
to create and store index files in this location.
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Tip Try using SAMtools to check if the reads in your SAM- or
BAM-formatted file are ordered by position in the reference sequence, and
also to reorder them, if needed.

Tip If you do not have index files (IDX or BAI and LINEARINDEX) stored
in the same location as your source file, and your source file is stored in a
location to which you do not have write access, you cannot import data from
the source file directly into the browser. Instead, construct a BioMap object
from the source file using the IndexDir name-value pair argument, and
then import the BioMap object into the browser.

To import short-read alignment data:

1 Select File > Add Data from File or File > Import Alignment Data
from MATLAB Workspace.

2 Select a SAM-formatted file, BAM-formatted file, or BioMap object.

3 If you select a file containing multiple reference sequences, in the Select
Reference dialog box, select a reference or scan the file for available
references and their mapped reads counts. Click OK.

4 Repeat the previous steps to import additional data sets.

Import Feature Annotations

You can import multiple sets of feature annotations from GFF- or
GTF-formatted files that contain data for a single reference sequence.

1 Select File > Add Data from File.

2 In the Open dialog box, select a GFF- or GTF-formatted file, and then
click Open.

3 Repeat the previous steps to import additional annotations.
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Zoom and Pan to a Specific Region of the Alignment
To zoom in and out:

Use the H R toolbar buttons,
or click-drag an edge of the rubberband in the Overview area.

- <=

1,000

To pan across the alignment:

Use the F toolbar buttons,
or click-drag the rubberband in the Overview area.
- q.n -

1,000 3_J

Tip Use the left and right arrow keys to pan in one base pair (bp) increments.
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View Coverage of the Reference Sequence

At the top of each alignment track, the coverage view displays the coverage
of each base in the reference sequence. The vertical ruler on the left edge of
the coverage view indicates the maximum coverage in the display range.
Hover the mouse pointer over a position in the coverage view to display the
location and counts.

cT CTTCCACOCTCTCATCT C TLCCACT TLCGC

r4s h
Counts: 45
Location: 896

Note The browser computes coverage at the base pair resolution, instead
of binning, even when zoomed out.

To change the percent coverage displayed, click anywhere in the alignment
track, and then edit the Alignment Coverage settings.

Vertical viewing range(%):

Min: |0
Max: 100

Tip Set Max to a value greater than 100, if needed, when comparing the
coverage of multiple tracks of reads.
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View the Pileup View of Short Reads

Each alignment track includes a pileup view of the short reads aligned to
the reference sequence.

T TCCCATTT CCCCTCT CCOTTCTATTTCOGOGT T

ra1

Limit the depth of the reads displayed in the pileup view by setting the
Maximum display read depth in the Alignment Pileup settings.

Maximum display read depth: |1,000
Mapping quality threshold: |20

BT AW W0 N9 N SN oN

Tip Limiting the depth of short reads in the pileup view does not change the
counts displayed in the coverage view.
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Compare Alignments of Multiple Data Sets

Compare multiple data sets, with each data set in its own track, against a
common reference sequence. Use the Track List to show/hide, order, and
delete tracks of data.

4\ NGS Browser =R ==

File Desktop  Window  Help

Center on Position: 155,537,955 || @

Browser
Ovenview 159 mb ~|E: B 8
+ t — Name Type Visible Data Source
S0M 100M 150M -
hs_ref GRCh37.p2_chi7 [Sequence | [ [Misandbox.
Ruler 1 s1BMObj Short Read...| (¥ |MATLABW...
151 bp 1 sSBMObj Short Read..| [7] |MATLABW...
155,537,880 bp 155,537,920 bp 155,537,940 bp 155,537,960 bp 155,537,980 bp 155,538,000 bp 155,538,020 bp | _
LT | A P | o T h
hs_ref GRCh3T.p2 -
et RnaT-e2..- | | NN A0 OO O A R O OO e 2
= s1BMObj 14 -
0
1
1
1 Settings 2 x
1 Vertical viewing range(%):
1 Min: 0
Max:
1 2% 100
j 3 B ]
EISEROL] #1| Maximum display read depth: [1,000
Mapping quality threshold: |20
0 ~ Flag duplicate reads
1
1 0 - Flag reads with unmapped pair
: Shade mismatch bases by Phred quality:
(Requires reference sequence)
1
1 Min: |5
Max: |30
1
- [ Show all bases (Requires sufficient zoom)
[T Color by strand:
: ~ Forward reads
b ~ Reverse reads
n
1
1
1
1 Visible range for display (kb): (10
Show Overview
n Specify nuclestide colors:
~AM-c -6 -7 H-N
1
[ ]
1
1

Counts: 2 Base Pos 155,538,030
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View Location, Quality Scores, and Mapping
Information

Hover the mouse pointer over a position in a read to display strand direction,
location, quality, and mapping information for the base, the read, and its
paired mate.

Fead name = EAS]_95:7:55:506:125
Alignrent start = 817 (+]

Cigar = 35M

Mapped = yes

Mapping quality = 99

Location: 822

Base=C

Base Phred quality = 60

Pair = EASL 95:7:55:506:125:0 (-)
Pair is mapped = yes
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Flag Reads
Click anywhere in an alignment track to display the Alignment Pileup
settings.

Maximum display read depth: 1,000

Mapping quality threshold: |20

[ - Flag duplicate reads

Shade mismatch bases by Phred quality:
(Requires reference sequence)

= Flag reads with unmapped pair

Min: |3
Max: [3p

[7] Show all bases (Requires sufficient zoom)

[] Color by strand:

= Forward reads

= Reverse reads

Flag Reads with Low Mapping Quality
Set the Mapping quality threshold in the Alignment Pileup section to flag
low-quality reads. Reads with a mapping quality below this level appear in a

lighter shade of gray.

Flag Duplicate Reads

Select Flag duplicate reads and select an outline color.

Flag Reads with Unmapped Pairs

Select Flag reads with unmapped pair and select an outline color.
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Evaluate and Flag Mismatches
Mismatches display as colored blocks or letters, depending on the zoom level.

Zoomed out view of read — Mismatches display as bars

C T C C T

Zoomed in view of read — Mismatches display as letters

In addition to the base Phred quality information that displays in the tooltip,
you can visualize quality differences by using the Shade mismatch bases
by Phred quality settings.

Shade rismatch bases by Phred quality:
(Requires reference sequence)

Min: |3
Max: |3p

\"'x_lr"\ '\ '\. '\'\"\'\'\

The mismatch blocks or letters display in:

¢ Light shade — Mismatch bases with Phred scores below the minimum

¢ Graduation of medium shades — Mismatch bases with Phred scores within
the minimum to maximum range

e Dark shade — Mismatch bases with Phred scores above the maximum
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View Insertions and Deletions

The NGS Browser designates insertions with a ! symbol. Hover the mouse
pointer over the insertion symbol to display information about it.

!

Read name = EASS6_65:1:163:846:223
Inzertion: CATAG

The NGS Browser designates deletions with dashes.

View Feature Annotations

After importing a feature annotation file, you can zoom and pan to view
feature annotations associated with a region of interest in the alignment.
Hover the mouse pointer over the feature annotation.

L

Location: 180 866 ., 181,324
Type: CDS

Score = 0.0

Parent: ¥Y38C1A48.4

Source: curated

Print and Export the Browser Image

Print or export the browser image by selecting File > Print Image or File >
Export Image.

2-43



2 High-Throughput Sequence Analysis

2-44

Identifying Differentially Expressed Genes from RNA-Seq

Data

This example shows how to load RNA-seq data and test for differential
expression using a negative binomial model.

Introduction

RNA-seq is an emerging technology for surveying gene expression and
transcriptome content by directly sequencing the mRNA molecules in a
sample. RNA-seq can provide gene expression measurements and is regarded
as an attractive approach to analyze a transcriptome in an unbiased and
comprehensive manner.

In this example, you will use Bioinformatics Toolbox™ and Statistics
Toolbox™ functions to load publicly available transcriptional profiling
sequencing data into MATLAB, compute the digital gene expression, and then
identify differentially expressed genes in RNA-seq data from hormone treated
prostate cancer cell line samples [1].

The Prostate Cancer Data Set

In the prostate cancer study, the prostate cancer cell line LNCap was
treated with androgen/DHT. Mock-treated and androgen-stimulated LNCap
cells were sequenced using the Illumina 1G Genome Analyzer [1]. For the
mock-treated cells, there were four lanes totaling ~10 million reads. For the
DHT-treated cells, there were three lanes totaling ~7 million reads. All
replicates were technical replicates. Samples labeled s1 through s4 are from
mock-treated cells. Samples labeled s5, s6, and s8 are from DHT-treated
cells. The read sequences are stored in FASTA files. The sequence IDs break
down as follows: seq_(unique sequence id)_(number of times this sequence
was seen in this lane).

This example assumes that you:
(1) Downloaded and uncompressed the seven FASTA files (s1.fa, s2.fa,

s3.fa, s4.fa, s5.fa, s6.fa and s8.fa) containing the raw, 35bp, unmapped
short reads from the author’s Web Site.


http://yeolab.ucsd.edu/yeolab/Papers.html
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(2) Produced a SAM-formatted file for each of the seven FASTA files by
mapping the short reads to the NCBI version 37 of the human genome using a
mapper such as Bowtie [2],

(3) Ordered the SAM-formatted files by reference name first, then by genomic
position.

For the published version of this example, 4,388,997 short reads were mapped
using the Bowtie aligner [2]. The aligner was instructed to report one best
valid alignment. No more than two mismatches were allowed for alignment.
Reads with more than one reportable alignment were suppressed, i.e. any
read that mapped to multiple locations was discarded. The alignment was
output to seven SAM files (s1.sam, s2.sam, s3.sam, s4.sam, s5.sam, s6.sam
and s8.sam). Because the input files were FASTA files, all quality values
were assumed to be 40 on the Phred quality scale [2]. We then used SAMtools
[3] to sort the mapped reads in the seven SAM files, one for each replicate.

Creating an Annotation Object of Target Genes

Download from Ensembl a tab-separated-value (T'SV) table with all protein
encoding genes to a text file, ensemblmart_genes_hum37.txt. For this
example, we are using Ensamble release 64. Using Ensembl’s BioMart
service, you can select a table with the following attributes: chromosome
name, gene biotype, gene name, gene start/end, and strand direction.

Use the provided helper function ensemblmart2gff to convert the downloaded
TSV file to a GFF formatted file. Then use GFFAnnotation to load the file
into MATLAB.

GFFfilename = ensemblmart2gff('ensemblmart_genes_hum37.txt');
genes = GFFAnnotation(GFFfilename)
genes =

GFFAnnotation with properties:

FieldNames: {1x9 cell}
NumEntries: 21184

2-45


http://www.ensembl.org/biomart/martview/

2 High-Throughput Sequence Analysis

2-46

Create a subset with the genes present in chromosomes only (without contigs).
The GFFAnnotation object contais 20012 annotated protein-coding genes in
the Ensembl database

Chr\sz{I1I’I2I,I3I,I4I,I5I’I6I,I7I,I8I,I9I’I1OI,I11I,I12I’I13I,I14I,...
I15I’I16I,I17I,I18I’I19I,I20I,I21I’I22I,IXI,IYI,IMTI};
getSubset(genes, 'reference',chrs)

genes

genes
GFFAnnotation with properties:

FieldNames: {1x9 cell}
NumEntries: 20012

Copy the gene information into a structure and display the first entry.

getData(genes,1)

ans =

Reference: '1'
Start: 205111632
Stop: 205180727
Feature: 'DSTYK'
Source: 'protein_coding'
Score: '0.0'
Strand: '-'
Frame: '.'
Attributes: '

Importing Mapped Short Read Alignment Data

The size of the sorted SAM files in this data set are in the order of 250-360MB.
You can access the mapped reads in s1.sam by creating a BioMap. BioMap has
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an interface that provides direct access to the mapped short reads stored in
the SAM-formatted file, thus minimizing the amount of data that is actually
loaded into memory.

bm

BioMap('s1.sam')

bm =
BioMap with properties:

SequenceDictionary: {1x25 cell}

Reference: [458367x1 File indexed property]
Signature: [458367x1 File indexed property]
Start: [458367x1 File indexed property]
MappingQuality: [458367x1 File indexed property]
Flag: [458367x1 File indexed property]
MatePosition: [458367x1 File indexed property]
Quality: [458367x1 File indexed property]
Sequence: [458367x1 File indexed property]
Header: [458367x1 File indexed property]

NSeqs: 458367

Name :

Use the getSummary method to obtain a list of the existing references and the
actual number of short read mapped to each one. Observe that the order of
the references is equivalent to the previously created cell string chrs.

getSummary (bm)

BioMap summary:
Name: "'
Container_Type: 'Data is file indexed.'
Total_Number_of_Sequences: 458367
Number_of_References_in_Dictionary: 25

Number_of_Sequences Genomic_Range
gi|224589800|ref |NC_000001.10]| 39037 564571 2492
gi|224589811|ref|NC_000002.11| 23102 39107 2431
gi|224589815|ref |NC_000003.11| 23788 578280 1977
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01224589816 | ref |NC_000004.11| 16273 56044
01224589817 | ref |NC_000005.9 | 20875 50342
0i|224589818|ref |NC_000006.11| 16743 277774
01224589819 | ref |NC_000007.13| 17022 146474
gi|224589820 | ref |NC_000008.10]| 12199 162668
0i|224589821 | ref |NC_000009.11| 13988 21790
0i|224589801 | ref|NC_000010.10] 15707 179281
0i|224589802| ref |NC_000011.9| 37506 203411
01224589803 | ref |NC_000012.11]| 21714 79745
gi|224589804 | ref |NC_000013.10] 6078 19335895
01224589805 | ref |[NC_000014.8| 14644 19123810
01224589806 | ref |[NC_000015.9| 13199 20145084
01224589807 | ref |NC_000016.9| 15423 92212
0i|224589808 | ref |NC_000017.10] 22089 56680
01224589809 | ref |[NC_000018.9| 5986 111538
01224589810 | ref |NC_000019.9| 17690 63006
gi|224589812|ref |NC_000020.10]| 10026 119233
0i|224589813 | ref |NC_000021.8| 6119 9421584
0i|224589814 | ref |NC_000022.10]| 7366 16150315
gi|224589822| ref |NC_000023.10]| 12939 2774622
01224589823 | ref |[NC_000024.9 | 2819 2711686
gi|17981852|ref [NC_001807.4] 66035 12

You can access the alignments, and perform operations like getting counts
and coverage from bm. For more examples of getting read coverage at the
chromosome level, see Exploring Protein-DNA Binding Sites from Paired-End
ChIP-Seq Data.

Determining Digital Gene Expression

Next, you will determine the mapped reads associated with each Ensembl
gene. Because the strings used in the SAM files to denote the reference names
are different to those provided in the annotations, we find a vector with the
reference index for each gene:

geneReference = segmatch(genes.Reference,chrs, 'exact',true);

For each gene, count the mapped reads that overlap any part of the gene.
The read counts for each gene are the digital gene expression of that gene.

1909
1806
1708
1588
1462
1410
1355
1343
1337
1150
1072
1025
901
810
779
590
628
480
512
1545
590
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Use the getCounts method of a BioMap to compute the read count within a
specified range.

counts = getCounts(bm,genes.Start,genes.Stop,1:genes.NumEntries,geneReferen

Gene expression levels can be best respresented by a DataMatrix, with each
row representing a gene and each column representing a sample. Create a
DataMatrix with seven columns, one for each sample. Copy the counts of
the first sample to the first column.

filenames = {'s1.sam', 's2.sam', 's3.sam', 's4.sam','s5.sam', 's6.sam', 's8.sam'
colnames = {'Mock_1','Mock_2','Mock_3"', 'Mock_4','DHT_1','DHT_2','DHT_3'};

Incap_counts = bioma.data.DataMatrix(NaN([genes.NumEntries,7]),genes.Featur
Incap_counts(:,1) = counts;

Incap_counts(1:10,:)

ans =
Mock_1 Mock_2 Mock_3 Mock_4 DHT_1 DHT_2
DSTYK 21 NaN NaN NaN NaN NaN
KCNJ2 1 NaN NaN NaN NaN NaN
DPF3 2 NaN NaN NaN NaN NaN
KRT78 0 NaN NaN NaN NaN NaN
GPR19 1 NaN NaN NaN NaN NaN
SO0X9 8 NaN NaN NaN NaN NaN
C17orf63 13 NaN NaN NaN NaN NaN
AL929472 .1 0 NaN NaN NaN NaN NaN
INPP5B 19 NaN NaN NaN NaN NaN
NME4 10 NaN NaN NaN NaN NaN
DHT_3
DSTYK NaN
KCNJ2 NaN
DPF3 NaN
KRT78 NaN
GPR19 NaN

2-49



2 High-Throughput Sequence Analysis

2-50

SO0X9 NaN
C17orf63 NaN
AL929472 .1 NaN
INPP5B NaN
NME4 NaN

Determine the number of genes that have counts greater than or equal to
50 in chromosome 1.

lichr1 = geneReference == 1; % logical index to genes in chromosome 1
sum(lncap_counts(:,1) >= 50 & lichr1)

ans =

188

Repeat this step for the other six samples (SAM files) in the data set to
get their gene counts and copy the information to the previously created
DataMatrix.

for 1 = 2:7
bm = BioMap(filenames{i});
counts = getCounts(bm,genes.Start,genes.Stop,1:genes.NumEntries,geneRef
Incap_counts(:,i) = counts;

end

Inspect the first 10 rows in the count table.

Incap_counts(1:10, :)

ans =
Mock_1 Mock_2 Mock_3 Mock_4 DHT_1 DHT_2
DSTYK 21 15 15 24 24 24
KCNJ2 1 0 2 0 0 2
DPF3 2 2 2 2 2 1
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KRT78 0 0 0 0 0 0
GPR19 1 2 1 1 0 0
SOX9 8 13 19 15 27 22
C170rf63 13 12 16 24 19 12
AL929472.1 0 0 0 1 0 0
INPP5B 19 23 27 24 35 32
NME4 10 11 14 22 11 20
DHT_3
DSTYK 15
KCNJ2 2
DPF3 1
KRT78 0
GPR19 0
SOX9 11
C170rf63 9
AL929472.1 0
INPP5B 9
NME4 8

The DataMatrix 1lncap_counts contains counts for samples from two
biological conditions: mock-treated and DHT-treated.

cond_Mock
cond_DHT

logical([1 1 1 1
logical([0 0 0 O

00 0]);
111]);
You can plot the counts for a chromosome along the chromosome genome
coordinate. For example, plot the counts for chromosome 1 for mock-treated
sample Mock_1 and DHT-treated sample DHT_1. Add the ideogram for
chromosome 1 to the plot using the chromosomeplot function.

ichr1 = find(lichr1); % linear index to genes in chromosome 1
[~,h] sort(genes.Start(ichri));

ichr1 = ichri(h); % linear index to genes in chromosome 1 sorted by
% genomic position

figure

plot(genes.Start(ichri1), lncap_counts(ichri,'Mock_1'), '.-r',...
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genes.Start(ichr1), lncap_counts(ichr1,'DHT_1'), '.-b');
ylabel('Gene Counts')
title('Gene Counts on Chromosome 1')
fixGenomicPositionLabels(gca) % formats tick labels and adds datacursors
chromosomeplot('hs_cytoBand.txt', 1, 'AddToPlot', gca)

Gend Courls on Chaamosoma 1
1] 50000000 100000000 150000000 200000000
L& Lo s e et i
1600 | 4
1400 -
1200 - -

1000 -

Gene Counls

B0

B0 -

Inference of Differential Signal in RNA Expression

For RNA-seq experiments, the read counts have been found to be linearly
related to the abundance of the target transcripts [4]. The interest lies

in comparing the read counts between different biological conditions.
Current observations suggest that typical RNA-seq experiments have low
background noise, and the gene counts are discrete and could follow the
Poisson distribution. While it has been noted that the assumption of the
Poisson distribution often predicts smaller variation in count data by ignoring
the extra variation due to the actual differences between replicate samples
[6]. Anders et.al.,(2010) proposed an error model for statistical inference

of differential signal in RNA-seq expression data that could address the
overdispersion problem [6]. Their approach uses the negative binomial
distribution to model the null distribution of the read counts. The mean and
variance of the negative binomial distribution are linked by local regression,
and these two parameters can be reliably estimated even when the number of
replicates is small [6].
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In this example, you will apply this statistical model to process the count
data and test for differential expression. The details of the algorithm can be
found in reference [6]. The model of Anders et.al., (2010) has three sets of
parameters that need to be estimated from the data:

1. Library size parameters;
2. Gene abundance parameters under each experimental condition;

3. The smooth functions that model the dependence of the raw variance on
the expected mean.

Estimating Library Size Factor

The expectation values of all gene counts from a sample are proportional to
the sample’s library size. The effective library size can be estimated from the
count data.

Compute the geometric mean of the gene counts (rows in 1ncap_counts)
across all samples in the experiment as a pseudo-reference sample.

geoMeans = exp(mean(log(lncap_counts), 2));

Each library size parameter is computed as the median of the ratio of the
sample’s counts to those of the pseudo-reference sample.

ratios = dmbsxfun(@rdivide, lncap_counts(geoMeans >0, :), geoMeans(geoMeans
sizeFactors = median(ratios, 1);

The counts can be transformed to a common scale using size factor adjustment.

base_counts = dmbsxfun(@rdivide, lncap_counts, sizeFactors);

Use the boxplot function to inspect the count distribution of the mock-treated
and DHT-treated samples and the size factor adjustment.

figure

subplot(2,1,1)

maboxplot(log2(lncap_counts), 'title','Raw Read Counts',...
‘orientation', 'horizontal')

subplot(2,1,2)
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maboxplot(log2(base_counts),

‘title','Size Factor Adjusted Read Counts',...

‘orientation’',

"horizontal')

Raw Read Counts

OHT_3
OHT_2
OHT_1
Mock_4
Mock 3
Mlock 2
Maock 1

OHT 3
OHT 2
OHT_1
Mlock_4
Mock 3
Mlock 2
Mlock_1 ,

Estimating Negative Binomial Distribution Parameters

The expectation value of counts for a gene is also proportional to the gene
abundance parameter. You can estimate the gene abundance parameter
from the average of counts from samples corresponding to an experimental
condition. For example, compute the mean counts and sample variances from

mock-treated samples.

base_mean_mock = mean(base_counts(:, cond_Mock), 2);
base_var_mock = var(base_counts(:, cond_Mock), 0, 2);

To avoid code duplication in the example for computing parameters
for samples of different conditions, we provide a helper function,
estimateBaseParams, to compute the mean, the variance, the smooth function
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fit data for raw variance estimation, and the diagnostic variance residual
distribution from replicates under the same condition. For example, compute
the base means and variances for DHT-treated samples.

[base_mean_dht, base_var_dht] = estimateBaseParams(lncap_counts(:, cond_DHT
sizeFactors(cond_DHT),..
‘MeanAndVar');

In the model, the full variances of the negative binomial distribution of the
counts of a gene are considered as the sum of a shot noise term and a raw
variance term. The shot noise term is the read counts of the gene, while
the raw variance can be predicted from the mean, i.e., genes with a similar
expression level have similar variance across the replicates (samples of the
same biological condition). A smooth function that models the dependence of
the raw variance on the mean is obtained by fitting the sample mean and
variance within replicates for each gene using the local regression function
malowess. For example, get the smooth fit data from the sample mean and
variance of the mock-treated samples.

[rawVarSmooth_X_mock, rawVarSmooth_Y_mock] =
estimateBaseParams(lncap_counts(:, cond_Moc
sizeFactors(cond_Mock), .
"SmoothFunc');

Find the raw variances for each gene from its base mean value by
interpolation.

raw_var_mock_fit = interpi(rawVarSmooth_X_mock, rawVarSmooth_Y_mock,...
log(base_mean_mock), 'linear', 0);

Add the bias correction term [6] to get the raw variances.

zConst = sum(1 ./sizeFactors(cond_Mock), 2) / length(sizeFactors(cond_Mock)
raw_var_mock = raw_var_mock_fit - base_mean_mock * zConst;

Plot the sample variance and the raw variance data to check the fit of the
variance function.

[base_mean_mock_sort, sidx] = sort(logi10(base_mean_mock));
raw_var_mock_sort = log10(raw_var_mock_fit(sidx));
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figure

plot(logi10(base_mean_mock), log10(base_var_mock), '*")

hold on

line(base_mean_mock_sort, real(raw_var_mock_sort), 'Color', 'r',
ylabel('log10(base variances) of mock-treated samples')
xlabel('log10(base means) of mock-treated samples')

log10ibase variances] of mock-treated samples
[}

ab P BRRIAN :
* o+ **_ +
2 1 1 1 1 1
-1 0 1 2 3 4 5

log10{base means) of mock-treated samples

The fit (red line) follows the single-gene estimates well, even though the

spread of the latter is considerable, as one would expect, given that each

raw variance value is estimated from only four values (four mock-treaded
replicates).

As RNA-seq experiments typically have few replicates, the single-gene
estimate of the base variance can deviate wildly from the fitted value. To see
whether this might be too wild, the cumulative probability for the ratio of

'LineWidth
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single-gene estimate of the base variance to the fitted value is calculated from
the chi-square distribution, as explained in reference [6].

Compute the cumulative probabilities of the variance ratios of mock-treated
samples

df_mock = sum(cond_Mock) - 1;
varRatio_mock = base_var_mock ./ raw_var_mock_fit;
pchisq_mock = chi2cdf(df_mock * varRatio_mock, df_mock);

Compute the empirical cumulative density functions (ECDF) stratified by base
count levels, and show the ECDF's curves. Group the counts into seven levels.

count_levels = [0 3; 3.1 12; 12.1 30; 30.1 65; 65.1 130; 130.1 310; 310.1 2

figure;
hold on
cm = jet(7);
for i = 1:7
[Y1,X1] = ecdf(pchisq_mock(base_mean_mock>count_levels(i, 1) &...
base_mean_mock<count_levels(i,2)));
plot(X1,Y1, 'LineWidth',2, " 'color',cm(i,:))

end
plot([0,1],[0,1] ,'k', 'linewidth', 2)
set(gca, 'Box', 'on')

legend('0-3', '3-12', '12-30', '31-65', '65-130', '131-310', '311-2500',...
‘Location', 'NorthWest')

xlabel('Chi-squared probability of residual')

ylabel('ECDF')

title('Residuals ECDF plot for mock-treated samples')
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Residuals ECDF plot for mock-treated samples
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The ECDF curves of count levels greater than 3 and below 130 follows the
diagonal well (black line). If the ECDF curves are below the black line,
variance is underestimated. If the ECDF curves are above the black line,
variance is overestimated [6]. For very low counts (below 3), the deviations
become stronger, but at these levels, shot noise dominates. For the high count
cases, the variance is overestimated. The reason might be there aren’t enough
genes with high counts. Get the number of genes in each of the count levels.

num_in_count_levels = zeros(1, 7);
for i = 1:7
num_in_count_levels(i) = sum(base_mean_mock>count_levels(i, 1
base_mean_mock<count_levels(i,2));
end

num_in_count_levels
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num_in_count_levels =
Columns 1 through 6
3996 3330 3451 2407 1172 427
Column 7
116
Increasing the sequence depth, which in turn increases the number of genes
with higher counts, improves the variance estimation.

You can produce the same ECDF plot for the DHT-treated samples by
following the same steps.

pchisq_dht = estimateBaseParams(lncap_counts(:, cond_DHT),...

sizeFactors(1, cond_DHT),..

‘Diagnostic');

figure;
hold on
for i = 1:7
[Y1,X1] = ecdf(pchisq_dht(base_mean_dht>count_levels(i, 1) & ...
base_mean_dht<count_levels(i,2)));
plot(X1,Y1, 'LineWidth',2, " 'color',cm(i,:))

end
plot([0,1],[0,1] ,'k', 'linewidth', 2)
set(gca, 'Box', 'on')

legend('0-3', '3-12', '12-30', '31-65', '65-130', '131-310', '311-2500',...

‘Location', 'NorthWest')
xlabel('Chi-squared probability of residual')
ylabel('ECDF')
title('Residuals ECDF plot for DHT-treated samples')
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Residuals ECDF plot for DHT-treated samples
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In both cases, most of the ECDF curves follow the diagonal well. The fits
are reasonably good.

Testing for Differential Expression

Having estimated and verified the mean-variance dependence, you can
test for differentially expressed genes between the samples from the mock-
and DHT- treated conditions. For your convenience, we provide the helper
function estimateNBParams to estimate the mean and full variance of the
two-parametric negative binomial distribution for each gene from the three
sets of parameters discussed above.

[mu_mock, full var_mock, mu_dht, full var_dht] =...
estimateNBParams(lncap_counts, sizeFactors, cond_DHT, cond_Mock);

Compute the p-values for the statistical significance of the change from
DHT-treated condition to mock-treated condition. The helper function
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computePVal implements the numerical computation of the p-values
presented in the reference [6]. We use the nbinpdf function to compute
the negative binomial probability density. Note: The computation was not
optimized, and it will take several minutes to run.

Get the gene counts for each condition:

k_mock = sum(lncap_counts(:, cond_Mock), 2);
k_dht = sum(lncap_counts(:, cond_DHT), 2);

pvals = computePVal(k_dht, mu_dht, full_var_dht,...
k_mock, mu_mock, full_var_mock);

You can empirically adjust the p-values from the multiple tests for false
discovery rate (FDR) with the Benjamini-Hochberg procedure [7] using the
mafdr function.

p_fdr = mafdr(pvals, 'BHFDR', true);

Determine the fold change estimated from the DHT-treated to the
mock-treated condition.

foldChange = base_mean_dht ./ base_mean_mock;

Determine the base 2 logarithm of the fold change.

log2FoldChange = log2(foldChange);

Determine the mean expression level estimated from both conditions.

base_mean_com = estimateBaseParams(lncap_counts, sizeFactors, 'MeanAndVar')
Assume a p-value cutoff of 0.01.

de_idx = p_fdr < 0.01;

Plot the log2 fold changes against the base means, and color those genes with
p-values less than the cutoff value red.

figure;
plot(log2(base_mean_com(~de_idx, :)), log2FoldChange(~de_idx,:), 'b.")
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hold on

plot(log2(base_mean_com(de_idx, :)), log2FoldChange(de_idx, :), 'r."')
xlabel('log2 Mean')

ylabel('log2 Fold Change')

log2 Fold Change
-+
s
Ly

-4 2 1] 2 4 5] a 10 12 14
log2 Mean

You can identify up- or down- regulated genes for mean base count levels
over 3.

up_idx = find(p_fdr < 0.01 & log2FoldChange >= 2 & base_mean_com > 3 );
numel (up_idx)

ans =

180
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down_idx = find(p_fdr < 0.01 & log2FoldChange <= -2 & base_mean_com > 3 );
numel (down_idx)

ans =

282

This analysis identified 462 genes (out of 20,012 genes) that were differentially
up- or down- regulated by hormone treatment.
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Exploring Protein-DNA Binding Sites from Paired-End
ChiIP-Seq Data

This example shows how to perform a genome-wide analysis of a transcription
factor in the Arabidopsis Thaliana (Thale Cress) model organism.

For enhanced performance, it is recommended that you run this example on a
64-bit platform, because the memory footprint is close to 2 Gb. On a 32-bit
platform, if you receive "Out of memory" errors when running this example,
try increasing the virtual memory (or swap space) of your operating system or
try setting the 3GB switch (32-bit Windows XP only). These techniques are
described in this document.

Introduction

ChIP-Seq is a technology that is used to identify transcription factors that
interact with specific DNA sites. First chromatin immunoprecipitation
enriches DNA-protein complexes using an antibody that binds to a particular
protein of interest. Then, all the resulting fragments are processed using
high-throughput sequencing. Sequencing fragments are mapped back to the
reference genome. By inspecting over-represented regions it is possible to
mark the genomic location of DNA-protein interactions.

In this example, short reads are produced by the paired-end Illumina
platform. Each fragment is reconstructed from two short reads successfully
mapped, with this the exact length of the fragment can be computed. Using
paired-end information from sequence reads maximizes the accuracy of
predicting DNA-protein binding sites.

Data Set

This example explores the paired-end ChIP-Seq data generated by Wang
et.al. [1] using the Illumina platform. The data set has been courteously
submitted to the Gene Expression Omnibus repository with accession number
GSM424618. The unmapped paired-end reads can be obtained from the
NCBI FTP site.

This example assumes that you:
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(1) downloaded the file SRR054715. sra containing the unmapped short read
and converted it to FASTQ formatted files using the NCBI SRA Toolkit.

(2) produced a SAM formatted file by mapping the short reads to the Thale
Cress reference genome, using a mapper such as BWA [2], Bowtie, or SSAHA2
(which is the mapper used by authors of [1]), and,

(3) ordered the SAM formatted file by reference name first, then by genomic
position.

For the published version of this example, 8,655,859 paired-end short reads
are mapped using the BWA mapper [2]. BWA produced a SAM formatted
file (aratha.sam) with 17,311,718 records (8,655,859 x 2). Repetitive hits
were randomly chosen, and only one hit is reported, but with lower mapping
quality. The SAM file was ordered and converted to a BAM formatted file
using SAMtools [3] before being loaded into MATLAB.

The last part of the example also assumes that you downloaded the
reference genome for the Thale Cress model organism (which includes five
chromosomes). Uncomment the following lines of code to download the
reference from the NCBI repository:

o® o° o°

o°

(

(
getgenbank('NC_003074', 'FileFormat', 'fasta', 'tofile', 'ach3.fasta’

(

(

o°

Creating a MATLAB Interface to a BAM Formatted File

To create local alignments and look at the coverage we need to construct a
BioMap. BioMap has an interface that provides direct access to the mapped
short reads stored in the BAM formatted file, thus minimizing the amount of
data that is actually loaded to the workspace. Create a BioMap to access all
the short reads mapped in the BAM formatted file.

bm

BioMap('aratha.bam')

getgenbank('NC_003070', 'FileFormat', 'fasta', 'tofile', 'ach1.fasta’
getgenbank('NC_003071', 'FileFormat', 'fasta', 'tofile', 'ach2.fasta’

getgenbank('NC_003075', 'FileFormat', 'fasta', 'tofile', 'ach4.fasta’
getgenbank('NC_003076', 'FileFormat', 'fasta', 'tofile', 'ach5.fasta’
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BioMap

Properties:
SequenceDictionary: {5x1 cell}

Reference: [14637324x1 File indexed property]
Signature: [14637324x1 File indexed property]
Start: [14637324x1 File indexed property]
MappingQuality: [14637324x1 File indexed property]
Flag: [14637324x1 File indexed property]
MatePosition: [14637324x1 File indexed property]
Quality: [14637324x1 File indexed property]
Sequence: [14637324x1 File indexed property]
Header: [14637324x1 File indexed property]

NSeqs: 14637324

Name: "'

Use the getSummary method to obtain a list of the existing references and the
actual number of short read mapped to each one.

getSummary (bm)

BioMap summary:
Name: "'
Container_Type: 'Data is file indexed.'
Total Number_of_Sequences: 14637324
Number_of_ References_in_Dictionary: 5

Number_of_Sequences Genomic_Range
Chri1 3151847 1 30427671
Chr2 3080417 1000 19698292
Chr3 3062917 94 23459782
Chr4 2218868 1029 18585050
Chrb 3123275 11 26975502
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The remainder of this example focuses on the analysis of one of the five
chromosomes, Chr1. Create a new BioMap to access the short reads mapped to
the first chromosome by subsetting the first one.

bm1

getSubset(bm, 'SelectReference', 'Chri')

bm1

BioMap

Properties:

SequenceDictionary: {'Chri'}
Reference: [3151847x1 File indexed property]
Signature: [3151847x1 File indexed property]
Start: [3151847x1 File indexed property]
MappingQuality: [3151847x1 File indexed property]
Flag: [3151847x1 File indexed property]
MatePosition: [3151847x1 File indexed property]
Quality: [3151847x1 File indexed property]
Sequence: [3151847x1 File indexed property]
Header: [3151847x1 File indexed property]

NSeqs: 3151847

Name: "'

By accessing the Start and Stop positions of the mapped short read you can
obtain the genomic range.

x1 = min(getStart(bmi))
X2 max (getStop(bm1))

X1

X2
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30427671

Exploring the Coverage at Different Resolutions

To explore the coverage for the whole range of the chromosome, a binning
algorithm is required. The getBaseCoverage method produces a coverage
signal based on effective alignments. It also allows you to specify a bin width
to control the size (or resolution) of the output signal. However internal
computations are still performed at the base pair (bp) resolution. This means
that despite setting a large bin size, narrow peaks in the coverage signal can
still be observed. Once the coverage signal is plotted you can program the
figure’s data cursor to display the genomic position when using the tooltip.
You can zoom and pan the figure to determine the position and height of
the ChIP-Seq peaks.

[cov,bin] = getBaseCoverage(bm1,x1,x2, 'binWidth',1000, 'binType', 'max"');
figure

plot(bin,cov)

axis([x1,x2,0,100]) % sets the axis limits
fixGenomicPositionLabels % formats tick labels and adds datacursors
xlabel('Base position')

ylabel( 'Depth')

title('Coverage in Chromosome 1')
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100 T T T

60 B

- B

60 - B

50 B

Depth

40+

a0

l
0 1 1 I 1
5000000 10000000 15000000 20000000 25000000 30000000

Base position
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It is also possible to explore the coverage signal at the bp resolution (also
referred to as the pile-up profile). Explore one of the large peaks observed in
the data at position 4598837.

p1 = 4598837-1000;

p2 = 4598837+1000;

figure

plot(p1:p2,getBaseCoverage(bmi,p1,p2))
xlim([p1,p2]) % sets the x-axis limits

fixGenomicPositionLabels % formats tick labels and adds datacursors
xlabel('Base position')

ylabel( 'Depth')

title('Coverage in Chromosome 1')

Cowerage in Chromosorme 1
900 T T T T T T T T

Il L 1 L =L o — 1 4 1
4590000 4598200 4590400 4596600 4598600 4599000 4599200 4599400 4599600 4599800
Base position

Identifying and Filtering Regions with Artifacts

Observe the large peak with coverage depth of 800+ between positions
4599029 and 4599145. Investigate how these reads are aligning to the
reference chromosome. You can retrieve a subset of these reads enough to
satisfy a coverage depth of 25, since this is sufficient to understand what is
happening in this region. Use getIndex to obtain indices to this subset. Then
use getCompactAlignment to display the corresponding multiple alignment of
the short-reads.
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i = getIndex(bmi1,4599029,4599145, 'depth',25);
bmx = getSubset(bmi,i,'inmemory',false)
getCompactAlignment (bmx,4599029,4599145)

bmx =
BioMap

Properties:
SequenceDictionary: {'Chri1'}

Reference: [62x1 File indexed property]
Signature: [62x1 File indexed property]
Start: [62x1 File indexed property]
MappingQuality: [62x1 File indexed property]
Flag: [62x1 File indexed property]
MatePosition: [62x1 File indexed property]
Quality: [62x1 File indexed property]
Sequence: [62x1 File indexed property]
Header: [62x1 File indexed property]

NSeqs: 62

Name: "'

ans =

AGTT AATCAAATAGAAAGCCCCGAGGGCGCCATATCCTAGGCGC AAACTATGTGATTGAATAAATCCTCCTC
AGTGC TCAAATAGAAAGCCCCGAGGGCGCCATATTCTAGGAGCCC GAATAAATCCTCCTC
AGTTCAA CCCGAGGGCGCCATATTCTAGGAGCCCAAACTATGTGATT

AGTTCAATCAAATAGAAAGC TTCTAGGAGCCCAAACTATGTGATTGAATAAATCCTCCTC
AGTT AAGGAGCCCAAAATATGTGATTGAATAAATCCACCTC
AGTACAATCAAATAGAAAGCCCCGAGGGCGCCATA  TAGGAGCCCAAACTATGTGATTGAATAAATCCTCCTC
CGTACAATCAAATAGAAAGCCCCGAGGGCGCCATATTC GGAGCCCAAACTATGTGATTGAATAAATCCTCCTC
CGTACAATCAAATAGAAAGCCCCGAGGGCGCCATATTC GGAGCCCAAACTATGTGATTGAATAAATCCTCCTC
CGTACAATCAAATAGAAAGCCCCGAGGGCGCCATATTC GGAGCCCAAGCTATGTGATTGAATAAATCCTCCTC
CGTACAATCAAATAGAAAGCCCCGAGGGCGCCATATTC GGAGCCCAAACTATGTGATTGAATAAATCCTCCTC
AGTTCAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTA GAGCCCAAACTATGTGATTGAATAAATCCTCCTC
GATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTA GAGCCCAAACTATGTGATTGAATAAATCTTCCTC
GATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTA GAGCCCAAACTATGTGATTGAATAAATCCTCCTC
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GATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTA GAGCCCAAACTATGTGATTGAATAAATCCTCCTC

GATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTA GAGCCCAAATTATGTGATTGAATAAATCCTCCTC

ATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAG CCCAAACTATGTGATTGAATAAATCCTCCTC

ATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAG CACAAACTATGTGATTGAATAAATCCTCCTC

ATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAG CCAAACTATGTGATTGAATAAATCCTCCTC
ATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAG
ATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTCG
ATACAATCAAATAGAAAGCCCCGGGGGCGCCATATTCTAG
ATTGAGTCAAATAGAAAGCCCCGAGGGCGCCATATTCTAG
ATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAG
ATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAG
ATACAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAG

CAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAGGAG
CAATCAAATAGAAAGCCCCGAGGGCGCCATATTCTAGGAG

TAGGAGCCCAAACTATGTGATTGAATAAATCCTCCTC

TAGGAGCCCAAACTATGCCATTGAATAAATCCTCCGC

GGAGCCCAAGCTATGTGATTGAATAAATCCTCCTC

GAGCCCAAACTATGTGATTGAATAAATCCTCCTC

GAGCCCAAACTATGTGATTGAATAAATCCTCCTC

GAGCCCAAACTATGTGATTGAATAAATCCTCCTC

GAGCCCAAACTATGTGATTGAATAAATCCTCCTC

GAGCCCAAACTATGTGATTGAATAAATCCTCCTC

In addition to visually confirming the alignment, you can also explore the
mapping quality for all the short reads in this region, as this may hint to a
potential problem. In this case, less than one percent of the short reads have
a Phred quality of 60, indicating that the mapper most likely found multiple
hits within the reference genome, hence assigning a lower mapping quality.

figure

i = getIndex(bm1,4599029,4599145);
hist(double(getMappingQuality(bmi,i)))

title('Mapping Quality of the reads between 4599029 and 4599145')
xlabel('Phred Quality Score')

ylabel('Number of Reads')
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Most of the large peaks in this data set occur due to satellite repeat regions or
due to its closeness to the centromere [4], and show characteristics similar to
the example just explored. You may explore other regions with large peaks
using the same procedure.

To prevent these problematic regions, two techniques are used. First, given
that the provided data set uses paired-end sequencing, by removing the reads
that are not aligned in a proper pair reduces the number of potential aligner
errors or ambiguities. You can achieve this by exploring the flag field of the
SAM formatted file, in which the second less significant bit is used to indicate
if the short read is mapped in a proper pair.

i = find(bitget(getFlag(bmi),2));
bm1_filtered = getSubset(bmi,i)
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bm1_filtered =

BioMap
Properties:
SequenceDictionary: {'Chri1'}
Reference: [3040724x1 File indexed property]
Signature: [3040724x1 File indexed property]
Start: [3040724x1 File indexed property]
MappingQuality: [3040724x1 File indexed property]
Flag: [3040724x1 File indexed property]
MatePosition: [3040724x1 File indexed property]
Quality: [3040724x1 File indexed property]
Sequence: [3040724x1 File indexed property]
Header: [3040724x1 File indexed property]
NSeqs: 3040724
Name: "'

Second, consider only uniquely mapped reads. You can detect reads that are
equally mapped to different regions of the reference sequence by looking at
the mapping quality, because BWA assigns a lower mapping quality (less
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than 60) to this type of short read.

i = find(getMappingQuality(bm1_filtered)==60);

bm1_filtered = getSubset(bmi_filtered,i)

bm1_filtered =

BioMap
Properties:
SequenceDictionary: {'Chri1'}

Reference: [2313252x1 File indexed property]
Signature: [2313252x1 File indexed property]
Start: [2313252x1 File indexed property]
MappingQuality: [2313252x1 File indexed property]
Flag: [2313252x1 File indexed property]
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MatePosition: [2313252x1 File indexed property]
Quality: [2313252x1 File indexed property]
Sequence: [2313252x1 File indexed property]
Header: [2313252x1 File indexed property]
NSeqs: 2313252
Name: "'

Visualize again the filtered data set using both, a coarse resolution with 1000
bp bins for the whole chromosome, and a fine resolution for a small region of
20,000 bp. Most of the large peaks due to artifacts have been removed.

[cov,bin] = getBaseCoverage(bmi_filtered,x1,x2, 'binWidth',1000, 'binType',"'nm
figure

plot(bin,cov)

axis([x1,x2,0,100]) % sets the axis limits

fixGenomicPositionLabels % formats tick labels and adds datacursors
xlabel('Base Position')

ylabel('Depth')

title('Coverage in Chromosome 1 after Filtering')

p1 = 24275801-10000;

p2 = 24275801+10000;

figure
plot(p1:p2,getBaseCoverage(bmi_filtered,p1,p2))
xlim([p1,p2]) % sets the x-axis limits

fixGenomicPositionLabels % formats tick labels and adds datacursors
xlabel('Base Position')

ylabel('Depth')

title('Coverage in Chromosome 1 after Filtering')
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Recovering Sequencing Fragments from the Paired-End Reads

In Wang’s paper [1] it is hypothesized that paired-end sequencing data has
the potential to increase the accuracy of the identification of chromosome
binding sites of DNA associated proteins because the fragment length can be
derived accurately, while when using single-end sequencing it is necessary
to resort to a statistical approximation of the fragment length, and use it
indistinctly for all putative binding sites.
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Use the paired-end reads to reconstruct the sequencing fragments. First,
get the indices for the forward and the reverse reads in each pair. This
information is captured in the fifth bit of the flag field, according to the SAM

file format.

fow_idx
rev_idx

find(~bitget(getFlag(bmi_filtered),5));
find(bitget(getFlag(bmi_filtered),5));

SAM-formatted files use the same header strings to identify pair mates. By

pairing the header strings you can determine how the short reads in BioMap
are paired. To pair the header strings, simply order them in ascending order
and use the sorting indices (hf and hr) to link the unsorted header strings.

[~,hf] = sort(getHeader(bmi1_filtered,fow_idx));

[~1hr]
mate_idx =

zeros (numel(fow_idx),1);
mate_idx(hf) = rev_idx(hr);

sort(getHeader(bmi_filtered,rev_idx));

Use the resulting fow_idx and mate_idx variables to retrieve pair mates. For
example, retrieve the paired-end reads for the first 10 fragments.

for j = 1:

10

disp(getInfo(bmi_filtered, fow_idx(j)))
disp(getInfo(bmi_filtered, mate_idx(j)))

end

SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.

sra.
sra.
sra.
sra.
sra.
sra.
sra.
sra.
sra.
.6820328

sra

sra.
.1559757

sra

sra.
.5658991

sra

6849385
6849385
6992346
6992346
8438570
8438570
1676744
1676744
6820328

1559757

5658991

163 20 60 40M AACCCTAAACCTCTGAATCCTTAATCCCTAAATCCCTAA
83 229 60 40M CCTATTTCTTGTGGTTTTCTTTCCTTCACTTAGCTATGC
99 20 60 40M AACCCTAAACCTCTGAATCCTTAATCCCTAAATCCCTAAA
147 239 60 40M GTGGTTTTCTTTCCTTCACTTAGCTATGGATGGTTTAT

163 47
83 274
163 67
83 283
163 73
83 267

60
60
60
60
60
60

40M
40M
40M
40M
40M
40M

CTAAATCCCTAAATCTTTAAATCCTACATCCATGAATCC
TATCTTCATTTGTTATATTGGATACAAGCTTTGCTACGA
ATCCTACATCCATGAATCCCTAAATACCTAATCCCCTAA
TTGTTATATTGGATACAAGCTTTGCTACGATCTACATTT
CATCCATGAATCCCTAAATACCTAATTCCCTAAACCCGA
GTTGGTGTATCTTCATTTGTTATATTGGATACGAGCTTT

163 103 60 40M TAAACCCGAAACCGGTTTCTCTGGTTGAAACTCATTGT
83 311 60 40M GATCTACATTTGGGAATGTGAGTCTCTTATTGTAACCTT
163 103 60 40M CAAACCCGAAACCGGTTTCTCTGGTTGAAACTCATTGT
83 311 60 40M GATCTACATTTGGGAATGTGAGTCTCTTATTGTAACCTT
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SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.
SRR054715.

sra.
sra.
.1007474

sra

sra.
. 7345693

sra

sra.

4625439
4625439

1007474

7345693

163 143 60 40M ATATAATGATAATTTTAGCGTTTTTATGCAATTGCTTA
83 347 60 40M CTTAGTGTTGGTTTATCTCAAGAATCTTATTAATTGTTT
163 210 60 40M ATTTGAGGTCAATACAAATCCTATTTCTTGTGGTTTGC
83 408 60 40M TATTGTCATTCTTACTCCTTTGTGGAAATGTTTGTTCTA
99 213 60 40M TGAGGTCAATACAAATCCTATTTCTTGTGGTTTTCTTTC
147 393 60 40M TTATTTTTGGACATTTATTGTCATTCTTACTCCTTTGC

Use the paired-end indices to construct a new BioMap with the minimal
information needed to represent the sequencing fragments. First, calculate
the insert sizes.

J = getStop(bm1_filtered, fow_idx);
K = getStart(bmi_filtered, mate_idx);
L=K-dJ - 1;

Obtain the new signature (or CIGAR string) for each fragment by using the
short read original signatures separated by the appropriate number of skip
CIGAR symbols (N).

n = numel(L);

cigars = cell(n,1);

for i = 1:n

cigars{i} = sprintf('SsdN' ,L(1));

end

cigars = strcat( getSignature(bmi_filtered, fow_idx),...
cigars,...
getSignature(bmi_filtered, mate_idx));

Reconstruct the sequences for the fragments by concatenating the respective
sequences of the paired-end short reads.

seqs = strcat( getSequence(bmi_filtered, fow_idx),...
getSequence(bmi1_filtered, mate_idx));

Calculate and plot the fragment size distribution.

J getStart(bmi_filtered,fow_idx);
K = getStop(bm1_filtered,mate_idx);
L=K-J+1;

figure

hist(double(L),100)
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title(sprintf('Fragment Size Distribution\n %d Paired-end Fragments Mapped
xlabel('Fragment Size')
ylabel('Count')

Fragment Size Distribution
w10t 1156826 Paired-end Fragments Mapped to Chromosome 1
1EI T T T T T T T

Count
()]
1

EI 1 1 1 1
1] A0 100 150 200 250 300 350 400
Fragment Size

Construct a new BioMap to represent the sequencing fragments. With this,
you will be able explore the coverage signals as well as local alignments of
the fragments.

bm1_fragments BioMap('Sequence',seqs, 'Signature',cigars, 'Start',J)

bm1_fragments =

BioMap

Properties:
SequenceDictionary: {Ox1 cell}
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Reference: {0x1 cell}
Signature: {1156626x1 cell}
Start: [1156626x1 uint32]
MappingQuality: [Ox1 uint8]
Flag: [Ox1 uint16]
MatePosition: [Ox1 uint32]
Quality: {Ox1 cell}
Sequence: {1156626x1 cell}
Header: {0Ox1 cell}
NSeqs: 1156626
Name: "'

Exploring the Coverage Using Fragment Alignments

Compare the coverage signal obtained by using the reconstructed fragments
with the coverage signal obtained by using individual paired-end reads.
Notice that enriched binding sites, represented by peaks, can be better
discriminated from the background signal.

cov_reads = getBaseCoverage(bmi_filtered,x1,x2, 'binWidth',1000, 'binType','n
[cov_fragments,bin] = getBaseCoverage(bmi_fragments,xi,x2,'binWidth',1000,"

figure
plot(bin,cov_reads,bin,cov_fragments)
xlim([x1,x2]) % sets the x-axis limits

fixGenomicPositionLabels % formats tick labels and adds datacursors
xlabel('Base position')

ylabel('Depth')

title('Coverage Comparison')

legend('Short Reads', 'Fragments')
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Perform the same comparison at the bp resolution. In this dataset, Wang
et.al. [1] investigated a basic helix-loop-helix (bHLH) transcription factor.
bHLH proteins typically bind to a consensus sequence called an E-box (with a
CANNTG motif). Use fastaread to load the reference chromosome, search for
the E-box motif in the 3’ and 5’ directions, and then overlay the motif positions
on the coverage signals. This example works over the region 1-200,000,
however the figure limits are narrowed to a 3000 bp region in order to better
depict the details.

p1 = 1
p2 = 200000;

cov_reads = getBaseCoverage(bmi1_filtered,pi1,p2);
[cov_fragments,bin] = getBaseCoverage(bm1_fragments,pi,p2);

chri1 = fastaread('achi.fasta');

mp1 = regexp(chri.Sequence(pl1:p2), 'CA..TG')+3+p1;
mp2 = regexp(chri.Sequence(pl1:p2), 'GT..AC')+3+p1;
motifs = [mp1 mp2];

figure

plot(bin,cov_reads,bin,cov_fragments)

hold on

plot([1;1;1]1*motifs,[0;max(ylim);NaN],'r")
x1im([111000 114000]) % sets the x-axis limits
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fixGenomicPositionLabels % formats tick labels and adds datacursors
xlabel('Base position')

ylabel('Depth')

title('Coverage Comparison')

legend('Short Reads', 'Fragments','E-box motif')

Coverage Comparison
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Observe that it is not possible to associate each peak in the coverage signals
with an E-box motif. This is because the length of the sequencing fragments is
comparable to the average motif distance, blurring peaks that are close. Plot
the distribution of the distances between the E-box motif sites.

motif_sep = diff(sort(motifs));

figure

hist(motif_sep(motif_sep<500),50)

title('Distance (bp) between adjacent E-box motifs')
xlabel('Distance (bp)')

ylabel('Counts')
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Finding Significant Peaks in the Coverage Signal

Use the function mspeaks to perform peak detection with Wavelets denoising
on the coverage signal of the fragment alignments. Filter putative ChIP peaks
using a height filter to remove peaks that are not enriched by the binding
process under consideration.

putative_peaks = mspeaks(bin,cov_fragments, 'noiseestimator',20,...
"heightfilter',10, 'showplot',true);

hold on
plot([1;1;1]*motifs(motifs>p1 & motifs<p2),[0;max(ylim);NaN],'r")
x1lim([111000 114000]) % sets the x-axis limits

fixGenomicPositionLabels % formats tick labels and adds datacursors
legend('Coverage from Fragments', 'Wavelet Denoised Coverage', 'Putative ChIP
xlabel('Base position')

ylabel('Depth')

title('ChIP-Seq Peak Detection')
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Use the knnsearch function to find the closest motif to each one of the
putative peaks. As expected, most of the enriched ChIP peaks are close to an
E-box motif [1]. This reinforces the importance of performing peak detection
at the finest resolution possible (bp resolution) when the expected density of
binding sites is high, as it is in the case of the E-box motif. This example also
illustrates that for this type of analysis, paired-end sequencing should be
considered over single-end sequencing [1].

h = knnsearch(motifs',putative_peaks(:,1));

distance = putative_peaks(:,1)-motifs(h(:))"';

figure

hist(distance(abs(distance)<200),50)

title('Distance to Closest E-box Motif for Each Detected Peak')
xlabel('Distance (bp)')

ylabel('Counts')
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Exploring Genome-wide Differences in DNA Methylation
Profiles

This example shows how to perform a genome-wide analysis of DNA
methylation in the human by using genome sequencing.

Note: For enhanced performance, MathWorks recommends that you run

this example on a 64-bit platform, because the memory footprint is close to

2 GB. On a 32-bit platform, if you receive "Out of memory" errors when
running this example, try increasing the virtual memory (or swap space) of
your operating system or try setting the 3GB switch (32-bit Windows XP only).
These techniques are described in this document.

Introduction

DNA methylation is an epigenetic modification that modulates gene
expression and the maintenance of genomic organization in normal and
disease processes. DNA methylation can define different states of the cell, and
it is inheritable during cell replication. Aberrant DNA methylation patterns
have been associated with cancer and tumor suppressor genes.

In this example you will explore the DNA methylation profiles of two
human cancer cells: parental HCT116 colon cancer cells and DICERex5
cells. DICERex5 cells are derived from HCT116 cells after the truncation of
the DICER1 alleles. Serre et al. in [1] proposed to study DNA methylation
profiles by using the MBD2 protein as a methyl CpG binding domain and
subsequently used high-throughput sequencing (HTseq). This technique

is commonly know as MBD-Seq. Short reads for two replicates of the two
samples have been submitted to NCBI's SRA archive by the authors of [1].
There are other technologies available to interrogate DNA methylation status
of CpG sites in combination with HTseq, for example MeDIP-seq or the use of
restriction enzymes. You can also analyze this type of data sets following the
approach presented in this example.

Data Sets

You can obtain the unmapped single-end reads for four sequencing
experiments from the NCBI FTP site. Short reads were produced using
Illumina’s Genome Analyzer II. Average insert size 1s 120 bp, and the length
of short reads is 36 bp.
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This example assumes that you:

(1) downloaded the files SRR030222. sra, SRR030223.sra, SRR030224.sra
and SRR030225. sra containing the unmapped short reads for two replicates
of from the DICERex5 sample and two replicates from the HCT116 sample
respectively. Converted them to FASTQ-formatted files using the NCBI SRA
Toolkit.

(2) produced SAM-formatted files by mapping the short reads to the reference
human genome (NCBI Build 37.5) using the Bowtie [2] algorithm. Only
uniquely mapped reads are reported.

(3) compressed the SAM formatted files to BAM and ordered them by
reference name first, then by genomic position by using SAMtools [3].

This example also assumes that you downloaded the reference human genome
(GRCh37.p5). You can use the bowtie-inspect command to reconstruct the
human reference directly from the bowtie indices. Or you may download the
reference from the NCBI repository by uncommenting the following line:

% getgenbank('NC_000009', 'FileFormat', 'fasta', 'tofile', 'hsch9.fasta');
Creating a MATLAB Interface to the BAM-Formaitted Files

To explore the signal coverage of the HCT116 samples you need to construct a
BioMap. BioMap has an interface that provides direct access to the mapped
short reads stored in the BAM-formatted file, thus minimizing the amount

of data that is actually loaded into memory. Use the function baminfo to
obtain a list of the existing references and the actual number of short reads
mapped to each one.

info = baminfo('SRR030224.bam', 'ScanDictionary',true);
fprintf('%-35s%s\n', 'Reference’', 'Number of Reads');
for i = 1:numel(info.ScannedDictionary)
fprintf('%-35s%d\n',info.ScannedDictionary{i}, ...
info.ScannedDictionaryCount(1i));

end
Reference Number of Reads
gi| 224589800 |ref|NC_000001.10]| 205065
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0i|224589811|ref |[NC_000002
0i|224589815 | ref |NC_000003
0i|224589816 | ref |NC_000004

0i|224589817 | ref [NC_000005.

0i|224589818|ref |NC_000006
0i|224589819 | ref |[NC_000007
01224589820 | ref |[NC_000008
0i|224589821 | ref |NC_000009
0i|224589801 | ref |[NC_000010
0i|224589802 | ref [NC_000011
0i|224589803 | ref |NC_000012
0i|224589804 | ref |[NC_000013
0i|224589805 | ref |[NC_000014
0i|224589806 | ref |[NC_000015
0i|224589807 | ref |[NC_000016
0i|224589808 | ref |NC_000017
0i|224589809 | ref |[NC_000018
0i|224589810 | ref |NC_000019
0i|224589812|ref |[NC_000020
0i|224589813|ref [NC_000021
gi|224589814 |ref |NC_000022
01224589822 | ref |[NC_000023
01224589823 | ref |NC_000024

11
11
11
9|
11
13
10|
11
10|
9|
11
10|
8|
9|
9|
10|
9|
9|
10|
8|
10|
10|
9|

gi|17981852|ref|NC_001807.4|

Unmapped

187019
73986
84033
96898
87990
120816
111229
106189
112279
104466
87091
53638
64049
60183
146868
195893
60344
166420
148950
310048
76037
32421
18870
1015
6805842

In this example you will focus on the analysis of chromosome 9. Create a
BioMap for the two HCT116 sample replicates.

bm_hct116_1
bm_hct116_2

bm_hct116_1
BioMap with properties:

SequenceDictionary:

'gi|224589821|ref|NC_000009.11|"

Reference: [106189x1 File indexed property]
Signature: [106189x1 File indexed property]

BioMap (' SRR030224.bam', 'SelectRef','gi|224589821|ref|NC_0000C
BioMap (' SRR030225.bam', 'SelectRef ', 'gi|224589821|ref|NC_0000C
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Start: [106189x1 File indexed property]
MappingQuality: [106189x1 File indexed property]
Flag: [106189x1 File indexed property]
MatePosition: [106189x1 File indexed property]
Quality: [106189x1 File indexed property]
Sequence: [106189x1 File indexed property]
Header: [106189x1 File indexed property]

NSeqs: 106189

Name:

bm_hct116_2 =
BioMap with properties:

SequenceDictionary: 'gi|224589821|ref|NC_000009.11|"
Reference: [107586x1 File indexed property]
Signature: [107586x1 File indexed property]

Start: [107586x1 File indexed property]
MappingQuality: [107586x1 File indexed property]
Flag: [107586x1 File indexed property]
MatePosition: [107586x1 File indexed property]
Quality: [107586x1 File indexed property]
Sequence: [107586x1 File indexed property]
Header: [107586x1 File indexed property]

NSeqs: 107586

Name:

Using a binning algorithm provided by the getBaseCoverage method, you can
plot the coverage of both replicates for an initial inspection. For reference,
you can also add the ideogram for the human chromosome 9 to the plot using
the chromosomeplot function.

figure

ha = gca;

hold on

n = 141213431; % length of chromosome 9

[cov,bin] = getBaseCoverage(bm_hct116_1,1,n, 'binWidth',100);

h1 = plot(bin,cov,'b"); % plots the binned coverage of bm_hct116_1
[cov,bin] = getBaseCoverage(bm_hct116_2,1,n, 'binWidth',100);

h2 = plot(bin,cov,'g"); % plots the binned coverage of bm_hct116_2
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chromosomeplot('hs_cytoBand.txt', 9, 'AddToPlot', ha) % plots an ideogram a
axis(ha,[1 n 0 100]) % zooms-in the y-axis
fixGenomicPositionLabels(ha) % formats tick labels and adds datacursors
legend([h1 h2],'HCT116-1','HCT116-2"', 'Location', 'NorthEast')
ylabel('Coverage')

title('Coverage for two replicates of the HCT116 sample')

set(gcf, 'Position',max(get(gcf, 'Position'),[0 O 900 0])) % resize window
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Because short reads represent the methylated regions of the DNA, there

is a correlation between aligned coverage and DNA methylation. Observe
the increased DNA methylation close to the chromosome telomeres; it is
known that there is an association between DNA methylation and the role of
telomeres for maintaining the integrity of the chromosomes. In the coverage
plot you can also see a long gap over the chromosome centromere. This is due
to the repetitive sequences present in the centromere, which prevent us from
aligning short reads to a unique position in this region. For the data sets used
in this example, only about 30% of the short reads were uniquely mapped to
the reference genome.

Correlating CpG Islands and DNA Methylation

DNA methylation normally occurs in CpG dinucleotides. Alteration of the
DNA methylation patterns can lead to transcriptional silencing, especially in
the gene promoter CpG islands. But, it is also known that DNA methylation
can block CTCF binding and can silence miRNA transcription among other
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relevant functions. In general, it is expected that mapped reads should
preferably align to CpG rich regions.

Load the human chromosome 9 from the reference file hs37.fasta. For this
example, it 1s assumed that you recovered the reference from the Bowtie
indices using the bowtie-inspect command; therefore hs37.fasta contains
all the human chromosomes. To load only the chromosome 9 you can use the
option nave-value pair BLOCKREAD with the fastaread function.

chr9

fastaread('hs37.fasta', 'blockread',9)

chr9

Header: [1x91 char]
Sequence: [1x141213431 char]

Use the cpgisland function to find the CpG clusters. Using the standard
definition for CpG islands [4], 200 or more bp islands with 60% or greater
CpGobserved/CpGexpected ratio, leads to 1682 GpG islands found in
chromosome 9.

cpgi cpgisland(chr9.Sequence)

cpgi =

Starts: [1x1682 double]
Stops: [1x1682 double]

Use the getCounts method to calculate the ratio of aligned bases that are
inside CpG islands. For the first replicate of the sample HCT116, the ratio
is close to 45%.

aligned_bases_in_CpG_islands = getCounts(bm_hct116_1,cpgi.Starts,cpgi.Stops

aligned_bases_total = getCounts(bm_hct116_1,1,n, 'method’', 'sum")
ratio = aligned_bases_in_CpG_islands ./ aligned_bases_total
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aligned_bases_in_CpG_islands =

1724363

aligned_bases_total =

3822804

ratio =

0.4511

You can explore high resolution coverage plots of the two sample replicates
and observe how the signal correlates with the CpG islands. For example,
explore the region between 23,820,000 and 23,830,000 bp. This is the 5’ region
of the human gene ELAVL2.

ri 23820001; % set the region limits

r2 23830000,

fhELAVL2 = figure; % keep the figure handle to use it later

hold on

% plot high-resolution coverage of bm_hct116_1

h1 = plot(ri:r2,getBaseCoverage(bm_hct116_1,r1,r2, 'binWidth',1),'b");
% plot high-resolution coverage of bm_hct116_2

h2 = plot(ri:r2,getBaseCoverage(bm_hct116_2,r1,r2, 'binWidth',1),'qg");

% mark the CpG islands within the [r1 r2] region
for i=1:numel(cpgi.Starts)
if cpgi.Starts(i)>r1 && cpgi.Stops(i)<r2 % is CpG island inside [r1 r2]7?
px = [cpgi.Starts([i i]) cpgi.Stops([1i 1i])]; % x-coordinates for patc
py = [0 max(ylim) max(ylim) 0]; % y-coordinates for patc
hp patch(px,py, 'r', 'FaceAlpha',.1, 'EdgeColor','r','Tag', 'cpgi');
end
end

axis([r1 r2 0 20]) % zooms-in the y-axis
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fixGenomicPositionLabels(gca) % formats tick labels and adds datacursors
legend([h1 h2 hp], 'HCT116-1"','HCT116-2"','CpG Islands')
ylabel('Coverage')

xlabel('Chromosome 9 position')

title('Coverage for two replicates of the HCT116 sample')
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Statistical Modelling of Count Data

To find regions that contain more mapped reads than would be expected by
chance, you can follow a similar approach to the one described by Serre et al.
[1]. The number of counts for non-overlapping contiguous 100 bp windows is
statistically modeled.

First, use the getCounts method to count the number of mapped reads
that start at each window. In this example you use a binning approach
that considers only the start position of every mapped read, following the
approach of Serre et al. However, you may also use the OVERLAP and METHOD
name-value pairs in getCounts to compute more accurate statistics. For
instance, to obtain the maximum coverage for each window considering base
pair resolution, set OVERLAP to 1 and METHOD to MAX.

n numel(chr9.Sequence); % length of chromosome

1:100:n; % windows of 100 bp

counts_1 = getCounts(bm_hct116_1,w,w+99, 'independent',true, 'overlap', 'start
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counts_2 = getCounts(bm_hct116_2,w,w+99, 'independent’',true, 'overlap', 'start

First, try to model the counts assuming that all the windows with counts are
biologically significant and therefore from the same distribution. Use the
negative bionomial distribution to fit a model the count data.

nbp = nbinfit(counts_1);
Plot the fitted model over a histogram of the empirical data.

figure

hold on

emphist = histc(counts_1,0:100); % calculate the empirical distribution
bar(0:100,emphist./sum(emphist), 'c', 'grouped') % plot histogram
plot(0:100,nbinpdf(0:100,nbp(1),nbp(2)),'b"', 'linewidth',2); % plot fitted n
axis([0 50 0 .001])

legend('Empirical Distribution', 'Negative Binomial Fit')
ylabel('Frequency')

xlabel('Counts')

title('Frequency of counts for 100 bp windows (HCT116-1)")
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The poor fitting indicates that the observed distribution may be due to the
mixture of two models, one that represents the background and one that
represents the count data in methylated DNA windows.

A more realistic scenario would be to assume that windows with a small
number of mapped reads are mainly the background (or null model). Serre et
al. assumed that 100-bp windows contaning four or more reads are unlikely
to be generated by chance. To estimate a good approximation to the null
model, you can fit the left body of the emprirical distribution to a truncated
negative binomial distribution. To fit a truncated distribution use the mle
function. First you need to define an anonymous function that defines the
right-truncated version of nbinpdf.

rtnbinpdf = @(x,p1,p2,t) nbinpdf(x,p1,p2) ./ nbincdf(t-1,p1,p2);

Define the fitting function using another anonymous function.
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rtnbinfit = @(x,t) mle(x, 'pdf',@(x,p1,p2) rtnbinpdf(x,pl1,p2,t), 'start’',nbin

Before fitting the real data, let us assess the fiting procedure with some
sampled data from a known distribution.

nbp = [0.5 0.2]; % Known coefficients

X = nbinrnd(nbp(1),nbp(2),10000,1); % Random sample

trun = 6; % Set a truncation threshold

nbphat1 = nbinfit(x); % Fit non-truncated model to all data

nbphat2 = nbinfit(x(x<trun)); % Fit non-truncated model to truncated data (
nbphat3 = rtnbinfit(x(x<trun),trun); % Fit truncated model to truncated dat
figure

hold on

emphist = histc(x,0:100); % Calculate the empirical distribution

bar(0:100,emphist./sum(emphist),‘c', 'grouped') % plot histogram
h1 = plot(0:100,nbinpdf(0:100,nbphati(1),nbphat1(2)),'b-0', 'linewidth',2);
h2 plot(0:100,nbinpdf(0:100,nbphat2(1),nbphat2(2)),'r',  'linewidth',2);
h3 plot(0:100,nbinpdf (0:100,nbphat3(1),nbphat3(2)),'g', 'linewidth',2);
axis([0 25 0 .2])
legend([h1 h2 h3], 'Neg-binomial fitted to all data',...

'Neg-binomial fitted to truncated data',...

'"Truncated neg-binomial fitted to truncated data')
ylabel('Frequency')
xlabel('Counts')
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Identifying Significant Methylated Regions

For the two replicates of the HCT116 sample, fit a right-truncated negative
binomial distribution to the observed null model using the rtnbinfit
anonymous function previously defined.

trun = 4; % Set a truncation threshold (as in [1])
pn1 = rtnbinfit(counts_1(counts_1<trun),trun); % Fit to HCT116-1 counts
pn2 = rtnbinfit(counts_2(counts_2<trun),trun); % Fit to HCT116-2 counts

Calculate the p-value for each window to the null distribution.

pvallt = 1 - nbincdf(counts_1,pni1(1), (

pni(2
pval2 = 1 - nbincdf(counts_2,pn2(1),pn2(2));

)

)3
))

Calculate the false discovery rate using the mafdr function. Use the
name-value pair BHFDR to use the linear-step up (LSU) procedure ([6]) to

2-98



Exploring Genome-wide Differences in DNA Methylation Profiles

calculate the FDR adjusted p-values. Setting the FDR < 0.01 permits you to
1dentify the 100-bp windows that are significantly methylated.

fdr1 = mafdr(pvalil, 'bhfdr',true);
fdr2 mafdr (pval2, 'bhfdr',true);

w1l = fdr1<.01; % logical vector indicating significant windows in HCT116-1
w2 = fdr2<.01; % logical vector indicating significant windows in HCT116-2
w12 = w1 & w2; % logical vector indicating significant windows in both repl

Number_of_sig windows_HCT116_1 = sum(w1)
Number_of_sig windows_HCT116_2 sum(w2)
Number_of_sig windows_HCT116 = sum(w12)

Number_of_sig_windows_HCT116_1

1662

Number_of_sig_windows_HCT116_2

1674

Number_of_sig_windows_HCT116 =

1346

Overall, you identified 1662 and 1674 non-overlapping 100-bp windows in the
two replicates of the HCT116 samples, which indicates there is significant
evidence of DNA methylation. There are 1346 windows that are significant in
both replicates.

For example, looking again in the promoter region of the ELAVL2 human
gene you can observe that in both sample replicates, multiple 100-bp windows

have been marked significant.

figure(fhELAVL2) % bring back to focus the previously plotted figure
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plot(w(wi1)+50,counts_1(w1),'bs') %
plot(w(w2)+50,counts_2(w2), 'gs'
axis([r1 r2 0 100])

title('Significant 100-bp windows in both replicates of the HCT116 sample')

) plot significant windows in HCT116-1
) plot significant windows in HCT116-2
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Finding Genes With Significant Methylated Promoter Regions

DNA methylation is involved in the modulation of gene expression. For
instance, it is well known that hypermethylation is associated with the
inactivation of several tumor suppresor genes. You can study in this data set
the methylation of gene promoter regions.

First, download from Ensembl a tab-separated-value (T'SV) table with all
protein encoding genes to a text file, ensemblmart_genes_hum37.txt. For
this example, we are using Ensamble release 64. Using Ensembl’s BioMart
service, you can select a table with the following attributes: chromosome
name, gene biotype, gene name, gene start/end, and strand direction.

Use the provided helper function ensemblmart2gff to convert the downloaded
TSV file to a GFF formatted file. Then use GFFAnnotation to load the file into
MATLAB and create a subset with the genes present in chromosome 9 only.
This results 800 annotated protein-coding genes in the Ensembl database.

GFFfilename = ensemblmart2gff('ensemblmart_genes_hum37.txt');
a = GFFAnnotation(GFFfilename)
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a9 = getSubset(a, 'reference','9")
numGenes = a9.NumEntries

GFFAnnotation with properties:
FieldNames: {1x9 cell}
NumEntries: 21184

a9 =

GFFAnnotation with properties:
FieldNames: {1x9 cell}
NumEntries: 800

numGenes =
800

Find the promoter regions for each gene. In this example we consider the
proximal promoter as the -500/100 upstream region.

downstream 500;
upstream = 100;

geneDir = strcmp(a9.Strand, '+'); % logical vector indicating strands in th

% calculate promoter's start position for genes in the forward direction
promoterStart(geneDir) = a9.Start(geneDir) - downstream;

% calculate promoter's end position for genes in the forward direction
promoterStop(geneDir) = a9.Start(geneDir) + upstream;

% calculate promoter's start position for genes in the reverse direction
promoterStart(~geneDir) = a9.Stop(~geneDir) - upstream;

% calculate promoter's end position for genes in the reverse direction
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promoterStop(~geneDir) = a9.Stop(~geneDir) + downstream;

Use a dataset as a container for the promoter information, as we can later
add new columns to store gene counts and p-values.

promoters = dataset({a9.Feature, 'Gene'});
promoters.Strand = char(a9.Strand);
promoters.Start = promoterStart';
promoters.Stop = promoterStop';

Find genes with significant DNA methylation in the promoter region by
looking at the number of mapped short reads that overlap at least one base
pair in the defined promoter region.

promoters.Counts_1 getCounts(bm_hct116_1,promoters.Start,promoters.Stop,.
'overlap',1, 'independent’',true);
promoters.Counts_2 = getCounts(bm_hct116_2,promoters.Start,promoters.Stop,.

'overlap',1,'independent’',true);
Fit a null distribution for each sample replicate and compute the p-values:

trun = 5; % Set a truncation threshold

pni rtnbinfit (promoters.Counts_1(promoters.Counts_1<trun),trun); %
pn2 rtnbinfit (promoters.Counts_2(promoters.Counts_2<trun),trun); %
promoters.pval_1 = 1 - nbincdf(promoters.Counts_1,pn1(1),pn1(2)); %
promoters.pval_2 1 - nbincdf(promoters.Counts_2,pn2(1),pn2(2)); %

Number_of_sig_promoters = sum(promoters.pval_1<.01 & promoters.pval_2<.01)

Ratio_of_sig_methylated_promoters = Number_of_sig_promoters./numGenes

Number_of_sig_promoters =

74

Ratio_of_sig_methylated_promoters =

0.0925
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Observe that only 74 (out of 800) genes in chromosome 9 have significantly
DNA methylated regions (pval<0.01 in both replicates). Display a report of

the 30 genes with the most significant methylated promoter regions.

[~,order] = sort(promoters.pval_1.*promoters.pval_2);
promoters(order(1:30),[1 2 3 45 7 6 8])

ans

Gene
'DMRT3'
'CNTFR'
'GABBR2'
'CACNA1B'
"BARX1'
'"FAM78A'
'FOXB2'
'"TLE4'
"ASTN2'
'FOXE1'
"MPDZ'
"PTPRD'

'PALM2-AKAP2'

'FAMG9B '
"WNK2'
"IGFBPL1'
'AKAP2'
‘C9orf4'
'COL5AT
"LHX3'
'OLFM1"
'NPR2'
'‘DBC1"
"SOHLH1'
'PIP5K1B'
'PRDM12"
'"ELAVL2'

Start
976464
34590021
101471379
140771741
96717554
134151834
79634071
82186188
120177248
100615036
13279489
10612623
112542089
139606522
95946698
38424344
112542269
111929471
137533120
139096855
137966768
35791651
122131645
138591274
71320075
133539481
23826235

Stop
977064
34590621
101471979
140772341
96718154
134152434
79634671
82186788
120177848
100615636
13280089
10613223
112542689
139607122
95947298
38424944
112542869
111930071
137533720
139097455
137967368
35792251
122132245
138591874
71320675
133540081
23826835

Counts_1

223
219
404
454
264
497
163
157
141
149
129
145
134
112
108
110
107
102
84
74
75
68
61
56
59
53
50
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2-104

'ZFP37'
'RP11-35N6.1"
'DMRT2

pval_
6.6613e-16
6.6613e-16
6.6613e-16
6.6613e-16
6.6613e-16
6.6613e-16
1.4e-13
3.5649e-13
4.3566e-12
1.2447e-12
2.8679e-11
2.3279e-12
1.3068e-11
4.1911e-10
7.897e-10
.7523e-10
.2538e-10
.0467e-09
.6266¢e-08
.8171e-07
.5457e-07
.8093e-07
.5082e-06
.4322e-06
.0943e-06
.6364e-06
.2778e-06
.0943e-06
.7771e-06
.7762e-06
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Counts_2
253
226
400
408
286
499
165
151
163
133
148
127
135
144
125
114
106
96
97
91
69
73
62
67
63
61
62
47
42
46

115818939 115819539 59
103790491 103791091 60
1049854 1050454 54

pval_

6.6613e-16
6.6613e-16
6.6613e-16
6.6613e-16
6.6613e-16
6.6613e-16
6.0363e-13
4.7348e-12
8.098e-13
.7598e-11
.3683e-12
.6448e-10
.0276e-11
.3295e-11
.2131e-10
.1364e-09
.7513e-09
.6795e-08
.4452e-08
.5644e-08
.0074e-06
.4629e-07
.9575e-06
.3692e-06
.5345e-06
.4518e-06
.9575e-06
.0746e-05
.8037e-05
.6016e-05

WO WMNMNWLBDNN-_2L2NNMNOO 22O 2 O2ADNN=220O0=2NOO

Finding Intergenic Regions that are Significantly Methylated
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Serre et al. [1] reported that, in these data sets, approximately 90% of the
uniquely mapped reads fall outside the 5’ gene promoter regions. Using

a similar approach as before, you can find genes that have intergenic
methylated regions. To compensate for the varying lengths of the genes, you
can use the maximum coverage, computed base-by-base, instead of the raw
number of mapped short reads. Another alternative approach to normalize
the counts by the gene length is to set the METHOD name-value pair to rpkm
in the getCounts function.

intergenic = dataset({a9.Feature, 'Gene'});
intergenic.Strand = char(a9.Strand);
intergenic.Start = a9.Start;
intergenic.Stop = a9.Stop;

intergenic.Counts_1 getCounts(bm_hct116_1,intergenic.Start,intergenic.Sto
‘overlap', 'full', 'method', 'max', 'independent’',true);
intergenic.Counts_2 = getCounts(bm_hct116_2,intergenic.Start,intergenic.Sto
‘overlap', 'full', 'method', 'max', 'independent’',true);
trun = 10; % Set a truncation threshold
pn1 = rtnbinfit(intergenic.Counts_1(intergenic.Counts_1<trun),trun); % Fit
)

pn2 = rtnbinfit(intergenic.Counts_2(intergenic.Counts_2<trun),trun); % Fit
intergenic.pval_1 = 1 - nbincdf(intergenic.Counts_1,pni1(1),pn1(2)); % p-val
intergenic.pval_2 = 1 - nbincdf(intergenic.Counts_2,pn2(1),pn2(2)); % p-val
Number_of_sig _genes = sum(intergenic.pval_1<.01 & intergenic.pval_2<.01)

Ratio_of_sig_methylated_genes = Number_of_sig_genes./numGenes
[~,order] = sort(intergenic.pval_1.*intergenic.pval_2);

intergenic(order(1:30),[1 2 3 4 5 7 6 8])

Number_of_sig_genes =

62

Ratio_of_sig_methylated_genes =
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ans

0.0775

Gene

"AL772363.1"

'CACNA1B'
'SUSD1"
'C9orf172'
"NR5AT
'BARX1"
"KCNT1'
'GABBR2'
'FOXB2'
"NDOR1'
'KIAA1045'
"ADAMTSL2'
'"PAX5
"OLFM1"
'PBX3'
"FOXET1'
'‘MPDZ'
"ASTN2'
"ARRDC1"'
"IGFBPL1"'
"LHX3'
"PAPPA'
'"CNTFR'
'DMRT3'
'TUSC1'
"ELAVL2'
'SMARCA2'
'GAS1!'
"GRINT'
'TLE4'

pval_1
8.3267e-15

Strand

Counts_2
98

Start
140762377
140772241
114803065
139738867
127243516
96713628
138594031
101050391
79634571
140100119
34957484
136397286
36833272
137967268
128508551
100615536
13105703
119187504
140500106
38408991
139088096
118916083
34551430
976964
25676396
23690102
2015342
89559279
140032842
82186688

pval_2
1.8097e-14

Stop
140787022
141019076
114937688
139741797
127269709
96717654
138684992
101471479
79635869
140113813
34984679
136440641
37034476
138013025
128729656
100618986
13279589
120177348
140509812
38424444
139096955
119164601
34590121
991731
25678856
23826335
2193624
89562104
140063207
82341658

Counts_1

106

106
88
99
86
77
58
65
51
54
50
55
48
55
45
49
51
43
49
45
44
44
41
40
46
35
36
34
36
36
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.3267e-15
.2901e-12
.4385e-14
.2677e-12
.0112e-11
.5424¢-08
.9078e-09
.2131e-07
.7601e-08
.0134e-07
.4307e-08
5.585e-07
.4307e-08
.4079e-06
.1027e-07
.2131e-07
.6058e-06
.1027e-07
.4079e-06
.9155e-06
.9155e-06
.8199¢e-06
.5537e-06
.0346¢e-06
.0371e-05
.2358e-05
.1245e-05
.2358e-05
.2358e-05
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For instance, explore the methylation profile of the BARX1 gene, the sixth
significant gene with intergenic methylation in the previous list. The GTF
formatted file ensemblmart_barx1.gtf contains structural information for
this gene obtained from Ensembl using the BioMart service.

Use GTFAnnotation to load the structural information into MATLAB. There

98
112
96
90
62
73
58
58
55
55
45
49
42
51
46
42
43
36
39
36
35
37
37
31
41
40
41
38
37

O ONWNODD OO -2 B 2424202 =20DMNMNOCOONNW= =

.8097e-
.1102e-
.5083e-
.5391e-
.5691e-
.9018e-
.5469e -
.5469e -
.5525e-
.5525e-
.7163e-
.8188e-
.7861e-
.4566¢€ -
.8461e-
.7861e-
.2894e-
.2564e-
.7417e-
.2564e-
.7377e-
.0816e-
.0816e-
.3417e-
.4736e-
.4251e-
.4736e-
.5629e -
.0816e-

are two annotated transcripts for this gene.

barx1 = GTFAnnotation('ensemblmart_barx1.gtf')

14
16
14
13
09
11
09
09
08
08
07
07
06
08
07
06
06
05
06
05
05
06
06
05
06
06
06
06
06
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transcripts = getTranscriptNames(barx1)

barx1 =
GTFAnnotation with properties:
FieldNames: {1x11 cell}
NumEntries: 18
transcripts =

'ENST00000253968'
'ENST00000401724"'

Plot the DNA methylation profile for both HCT116 sample replicates with
base-pair resolution. Overlay the CpG islands and plot the exons for each of

the two transcripts along the bottom of the plot.

range = barx1.getRange;

r1 = range(1)-1000; % set the region limits

r2 = range(2)+1000;

figure

hold on

% plot high-resolution coverage of bm_hct116_1

h1 = plot(ri1:r2,getBaseCoverage(bm_hct116_1,r1,r2, 'binWidth',1),'b");

% plot high-resolution coverage of bm_hct116_2

h2 = plot(ri1:r2,getBaseCoverage(bm_hct116_2,r1,r2, 'binWidth',1),'g");

% mark the CpG islands within the [r1 r2] region
for i=1:numel(cpgi.Starts)

if cpgi.Starts(i)>r1 && cpgi.Stops(i)<r2 % is CpG island inside [r1 r2]

px = [cpgi.Starts([i i]) cpgi.Stops([i i]1)];

py = [0 max(ylim) max(ylim) O0];
hp
end

end

% X-coordinates for pa
% y-coordinates for pa

patch(px,py,'r', 'FaceAlpha',.1, 'EdgeColor','r','Tag', 'cpgi');
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% mark the exons at the bottom of the axes

for i = 1:numel(transcripts)
exons = getSubset(barx1,'Transcript',transcripts{i}, 'Feature', 'exon');
for j = 1:exons.NumEntries

px = [exons.Start([j j]);exons.Stop([j j1)1'; % x-coordinates for pa

py = [0 1 1 0]-i*2-1; % y-coordinates for pa

hg = patch(px,py,'b', 'FaceAlpha',.1, 'EdgeColor','b','Tag"', 'exon');
end

end

axis([r1 r2 -numel(transcripts)*2-2 80]) % zooms-in the y-axis
fixGenomicPositionLabels(gca) % formats tick labels and adds datacursors
ylabel('Coverage')

xlabel('Chromosome 9 position')

title('High resolution coverage in the BARX1 gene')

legend([h1 h2 hp hq]l, 'HCT116-1"','HCT116-2', 'CpG Islands', 'Exons', 'Location’

High resnlution coverage m 1he BARXI geno

-l HCT1i6-1
70 HET118-2 -
G stands

Covarage
8 B
=]
i [
——
— —
———
-
=‘.._'
b—-
.
I

S | 'v il
B !
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3 =]

713000 S67 14000 6715000 967 mcm 26717000 96716000
Chromosome 9 posilion

Observe the highly methylated region in the 5’ promoter region (right-most
CpG island). Recall that for this gene trasciption occurs in the reverse strand.
More interesting, observe the highly methylated regions that overlap the
initiation of each of the two annotated transcripts (two middle CpG islands).

Differential Analysis of Methylation Patterns
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In the study by Serre et al. another cell line is also analyzed. New cells
(DICERex5) are derived from the same HCT116 colon cancer cells after
truncating the DICER1 alleles. It has been reported in literature [5] that
there 1s a localized change of DNA methylation at small number of gene
promoters. In this example, you be find significant 100-bp windows in two
sample replicates of the DICERex5 cells following the same approach as the
parental HCT116 cells, and then you will search statistically significant
differences between the two cell lines.

The helper function getWindowCounts captures the similar steps to find
windows with significant coverage as before. getWindowCounts returns
vectors with counts, p-values, and false discovery rates for each new replicate.

bm_dicer_1 = BioMap('SRR030222.bam', 'SelectRef', 'gi|224589821|ref|NC_000009
bm_dicer_2 BioMap ( 'SRR030223.bam', 'SelectRef', 'gi|224589821|ref|NC_00000S
[counts_3,pval3, fdr3] getWindowCounts (bm_dicer_1,4,w,100);
[counts_4,pval4,fdr4] = getWindowCounts(bm_dicer_2,4,w,100);

w3 fdr3<.01; % logical vector indicating significant windows in DICERex5_
w4 fdr4<.01; % logical vector indicating significant windows in DICERex5-
w34 = w3 & w4; % logical vector indicating significant windows in both repl
Number_of_sig_windows_DICERex5_1 = sum(w3)

Number_of_sig windows_DICERex5_2 = sum(w4)

Number_of_sig windows_DICERex5 = sum(w34)

Number_of_sig_windows_DICERex5_1

908

Number_of_sig_windows_DICERex5_2

1041

Number_of_sig_windows_DICERex5 =

759
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To perform a differential analysis you use the 100-bp windows that are
significant in at least one of the samples (either HCT116 or DICERex5).

wd = w34 | wi2; % logical vector indicating windows included in the diff. a

counts = [counts_1(wd) counts_2(wd) counts_3(wd) counts_4(wd)];
ws = w(wd); % window start for each row in counts

Use the function manorm to normalize the data. The PERCENTILE name-value
pair lets you filter out windows with very large number of counts while
normalizing, since these windows are mainly due to artifacts, such as
repetitive regions in the reference chromosome.

counts_norm = round(manorm(counts, 'percentile',90).*100);

Use the function mattest to perform a two-sample t-test to identify
differentially covered windows from the two different cell lines.

pval = mattest(counts_norm(:,[1 2]),counts_norm(:,[3 4]), 'bootstrap',true,.
'showhist',true, 'showplot',true);
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Histograms of t-test Results

t-scores p-values
120 T T T T 400 T
350
100 1
300
a0 T
250
= =
(] (]
= =
2 &0 1 % 200
[=n f=n
x
L L
150
40 T
100
20 T
50
a a
-10 5 1] 5 10 1] 05 1

t-score p-value

Create a report with the 25 most significant differentially covered windows.
While creating the report use the helper function findClosestGene to
determine if the window is intergenic, intragenic, or if it is in a proximal
promoter region.

[~,ord] = sort(pval);

fprintf('Window Pos Type p-value HCT116 DICERe
for i = 1:25
j = ord(i);

[~,msg] = findClosestGene(a9,[ws(j) ws(j)+99]);
fprintf('%10d %-25s %7.61%5d%5d %5d%5d\n',
ws(j),msg,pval(j),counts_norm(j,:));
end

Window Pos Type p-value HCT116 DICERex5
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140311701
139546501
10901
120176801
139914801
126128501
71939501
124461001
140086501
79637201
136470801
140918001
100615901
98221901
138730601
89561701
977401
37002601
139744401
126771301
93922501
94187101
136044401
139611201
139716201

Intergenic
Intragenic
Intragenic
Intergenic
Intergenic
Intergenic

Prox. Promoter (FAM189A2)

Intergenic
Intergenic
Intragenic
Intragenic
Intergenic
Intergenic
Intergenic
Intergenic
Intergenic
Intergenic
Intergenic
Intergenic
Intragenic
Intragenic
Intragenic
Intragenic
Intergenic
Intergenic

(EXD3)

(ASTN2)
(ABCA2)
(CRB2)

(DAB2IP)
(TPRN)

CACNA1B)
FOXE1)
PTCH1)
CANSAP1 )
GAS1)
DMRT3)
PAX5)

(
(
(
(
(
(
(
(PHPT1)

(FAM6G9B)
(C9orf86)

el elNelNelelelNeolNeolNeoNele e lNolNeolNeolNe e lNolNeolNolole o No ol

.000022
.001684
.002478
.002531
.002770
.002968
.005178
.005243
.006053
.006998
.006998
.007555
.007758
.009231
.009552
.009618
.009656
.009808
.010087
.010638
.010672
.010696
.010756
.010756
.010946

13
21
258
266
64
94
107
77
47
52
52
176
262
26
26
77
236
133
47
43
34
73
39
39
73

13
21
257
270
63
93
101
76
42
51
51
169
253
30
21
76
245
127
46
46
34
80
34
34
72

104
91
434
155
26
129

39
123
32
32
71
123
104
97
6
129
207
32
97
149
6
110
110
136

105
93
428
155
25
130

37
124
31
31
68
118
99
93
12
124
211
31
93
161
6
105
105
130

Plot the DNA methylation profile for the promoter region of gene FAM189A2,

the most signicant differentially covered promoter region from the previous
list. Overlay the CpG islands and the FAM189A2 gene.

range = getRange(getSubset(a9, 'Feature', 'FAM189A2'));

ri = range(1)-1000;
r2 = range(2)+1000;

% plot high-resolution coverage of all replicates

figure
hold on
h1 = plot(ri:
h2 = plot(ri:
h3 = plot(ri:
h4 = plot(ri:

r2,getBaseCoverage(bm_hct116_1,r1,r2, 'binWidth',1),'b
r2,getBaseCoverage(bm_hct116_2,r1,r2, 'binWidth',1),'g"’
r2,getBaseCoverage(bm_dicer_1,r1,r2, 'binWidth',1),'r'
r2,getBaseCoverage(bm_dicer_2,r1,r2, 'binWidth',1),'m
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% mark the CpG islands within the [r1 r2] region
for i=1:numel(cpgi.Starts)
if cpgi.Starts(i)>r1 && cpgi.Stops(i)<r2 % is CpG island inside [r1 r2]
px = [cpgi.Starts([i i]) cpgi.Stops([i i])]; % x-coordinates for pat
py [0 max(ylim) max(ylim) O0]; % y-coordinates for pat
hp = patch(px,py,'r', 'FaceAlpha',.1, 'EdgeColor','r','Tag', 'cpgi');
end

end

% mark the gene at the bottom of the axes

px = range([1 1 2 2]);
py = [0 1 1 0]-2;
hq = patch(px,py,'b', 'FaceAlpha',.1, 'EdgeColor','b','Tag', 'gene');

axis([r1 r1+4000 -4 30]) % zooms-in

fixGenomicPositionLabels(gca) % formats tick labels and adds datacursors
ylabel('Coverage')

xlabel('Chromosome 9 position')

title('DNA Methylation profiles along the promoter region of the FAM189A2 ¢
legend([h1 h2 h3 h4 hp hq], 'HCT116-1','HCT116-2', 'DICERex5-1"', 'DICERex5-2',

DMA Methylation profiles along the promater region of the FAMIESAZ gene
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Chromosome 9 position

Observe that the CpG islands are clearly unmethylated for both of the
DICERex5 replicates.
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Sequence Analysis

Sequence analysis is the process you use to find information about a nucleotide
or amino acid sequence using computational methods. Common tasks in
sequence analysis are identifying genes, determining the similarity of two
genes, determining the protein coded by a gene, and determining the function
of a gene by finding a similar gene in another organism with a known function.

“Exploring a Nucleotide Sequence Using Command Line” on page 3-2
“Exploring a Nucleotide Sequence Using Graphical Interface” on page 3-22
“Exploring a Protein Sequence Using Graphical Interface” on page 3-33
“Sequence Alignment” on page 3-38

“Viewing and Aligning Multiple Sequences” on page 3-58
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Exploring a Nucleotide Sequence Using Command Line

In this section...

“Overview of Example” on page 3-2

“Searching the Web for Sequence Information” on page 3-2
“Reading Sequence Information from the Web” on page 3-5
“Determining Nucleotide Composition” on page 3-6
“Determining Codon Composition” on page 3-11

“Open Reading Frames” on page 3-15

“Amino Acid Conversion and Composition” on page 3-18

Overview of Example

After sequencing a piece of DNA, one of the first tasks is to investigate the
nucleotide content in the sequence. Starting with a DNA sequence, this
example uses sequence statistics functions to determine mono-, di-, and
trinucleotide content, and to locate open reading frames.

Searching the Web for Sequence Information

The following procedure illustrates how to use the MATLAB Help browser
to search the Web for information. In this example you are interested in
studying the human mitochondrial genome. While many genes that code for
mitochondrial proteins are found in the cell nucleus, the mitochondrial has
genes that code for proteins used to produce energy.

First research information about the human mitochondria and find the
nucleotide sequence for the genome. Next, look at the nucleotide content for
the entire sequence. And finally, determine open reading frames and extract
specific gene sequences.

1 Use the MATLAB Help browser to explore the Web. In the MATLAB
Command Window, type

web('http://www.ncbi.nlm.nih.gov/")
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A separate browser window opens with the home page for the NCBI Web
site.

2 Search the NCBI Web site for information. For example, to search for the
human mitochondrion genome, from the Search list, select Genome , and in
the Search list, enter mitochondrion homo sapiens.

c y = e
,-:_:NCB| Resources () How To [

-
S

N C B J Search | Genoma =l

|mi‘tochondrinn homao sapiens Search [EEWEED

250K

THRT B AL
us,hn_“ 1[ sGenome

L Protein Genome Structure OMIM PMC
Search |Genome ;I fDrlmi‘tnchnndrion homo sapisns| Go | Clear | Save Search
[’ Limit= T Preview/Index T History T Clipboard T Detailz \I
Dizplay |Summar}' x| show |23 ;”Sendtn =1

!
All: 49
Items 1 - 20 of 45 Page ”'I of 3 Hext

71 NC 003415 Links
Ancylostoma duodenale mitochondrion, complete genome
DMA; circular; Length: 13,721 nt
Organelle: mitochondrion
Created: 2002/02/21

3 Select a result page. For example, click the link labeled NC_012920.

The MATLAB Help browser displays the NCBI page for the human
mitochondrial genome.
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Reading Sequence Information from the Web

The following procedure illustrates how to find a nucleotide sequence in

a public database and read the sequence information into the MATLAB
environment. Many public databases for nucleotide sequences are
accessible from the Web. The MATLAB Command Window provides an
integrated environment for bringing sequence information into the MATLAB
environment.

The consensus sequence for the human mitochondrial genome has the
GenBank accession number NC_012920. Since the whole GenBank entry is
quite large and you might only be interested in the sequence, you can get
just the sequence information.

1 Get sequence information from a Web database. For example, to retrieve
sequence information for the human mitochondrial genome, in the
MATLAB Command Window, type

mitochondria = getgenbank('NC_012920', 'SequenceOnly',true)

The getgenbank function retrieves the nucleotide sequence from the
GenBank database and creates a character array.

mitochondria =
GATCACAGGTCTATCACCCTATTAACCACTCACGGGAGCTCTCCATGCAT
TTGGTATTTTCGTCTGGGGGGTGTGCACGCGATAGCATTGCGAGACGCTG
GAGCCGGAGCACCCTATGTCGCAGTATCTGTCTTTGATTCCTGCCTCATT
CTATTATTTATCGCACCTACGTTCAATATTACAGGCGAACATACCTACTA
AAGT .

2 If you don’t have a Web connection, you can load the data from a MAT file
included with the Bioinformatics Toolbox software, using the command

load mitochondria

The load function loads the sequence mitochondria into the MATLAB
Workspace.

3 Get information about the sequence. Type

whos mitochondria
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Information about the size of the sequence displays in the MATLAB
Command Window.

Name Size Bytes Class Attributes

mitochondria 1x16569 33138 char

Determining Nucleotide Composition

The following procedure illustrates how to determine the monomers and
dimers, and then visualize data in graphs and bar plots. Sections of a DNA
sequence with a high percent of A+T nucleotides usually indicate intergenic
parts of the sequence, while low A+T and higher G+C nucleotide percentages
indicate possible genes. Many times high CG dinucleotide content is located
before a gene.

After you read a sequence into the MATLAB environment, you can use
the sequence statistics functions to determine if your sequence has the
characteristics of a protein-coding region. This procedure uses the human
mitochondrial genome as an example. See “Reading Sequence Information
from the Web” on page 3-5.

1 Plot monomer densities and combined monomer densities in a graph. In
the MATLAB Command Window, type

ntdensity(mitochondria)

This graph shows that the genome is A+T rich.
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2 Count the nucleotides using the basecount function.

basecount(mitochondria)

A list of nucleotide counts is shown for the 5’-3’ strand.

ans

—A O O > 1

5124
5181
2169
4094
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3 Count the nucleotides in the reverse complement of a sequence using the
seqrcomplement function.

basecount(seqrcomplement(mitochondria))

As expected, the nucleotide counts on the reverse complement strand are
complementary to the 5-3” strand.

ans
4094
2169
5181
5124

—A O O > 1

4 Use the function basecount with the chart option to visualize the
nucleotide distribution.

figure
basecount(mitochondria, 'chart', 'pie');

A pie chart displays in the MATLAB Figure window.
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=

File Edit View Insert Tools Desktop Window Help k"

Jdde | b RRXTDEL- 20|80

5 Count the dimers in a sequence and display the information in a bar chart.

figure
dimercount(mitochondria, 'chart', 'bar')

ans =
AA: 1604
AC: 1495
AG: 795
AT: 1230

3-9



3 Sequence Analysis

3-10

CA:
CC:
CG:
CT:
GA:
GC:
GG:
GT:
TA:
TC:
TG:
TT:

1534
1771
435
1440
613
711
425
419
1373
1204
513
1004
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Determining Codon Composition

The following procedure illustrates how to look at codons for the six reading
frames. Trinucleotides (codon) code for an amino acid, and there are 64
possible codons in a nucleotide sequence. Knowing the percent of codons

in your sequence can be helpful when you are comparing with tables for
expected codon usage.

After you read a sequence into the MATLAB environment, you can analyze
the sequence for codon composition. This procedure uses the human
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mitochondria genome as an example. See “Reading Sequence Information
from the Web” on page 3-5.

1 Count codons in a nucleotide sequence. In the MATLAB Command
Window, type

codoncount (mitochondria)

The codon counts for the first reading frame displays.

AAA - 167 AAC - 171 AAG - 71 AAT - 130
ACA - 137 ACC - 191 ACG - 42 ACT - 153
AGA - 59 AGC - 87 AGG - 51 AGT - 54
ATA - 126 ATC - 131 ATG - 55 ATT - 113
CAA - 146 CAC - 145 CAG - 68 CAT - 148
CCA - 141 CCC - 205 CCG - 49 CCT - 173
CGA - 40 CGC - 54 CGG - 29 CGT - 27
CTA - 175 CTC - 142 CTG - 74 CTT - 101
GAA - 67 GAC - 53 GAG - 49 GAT - 35
GCA - 81 GCC - 101 GCG - 16 GCT - 59
GGA - 36 GGC - 47 GGG - 23 GGT - 28
GTA - 43 GTC - 26 GTG - 18 GTT - 41
TAA - 157 TAC - 118 TAG - 94 TAT - 107
TCA - 125 TCC - 116 TCG - 37 TCT - 103
TGA - 64 TGC - 40 TGG - 29 TGT - 26
TTA - 96 TTC - 107 TTG - 47 TTT - 78

2 Count the codons in all six reading frames and plot the results in heat maps.

for frame = 1:3
figure
subplot(2,1,1);
codoncount(mitochondria, 'frame',frame, 'figure',true,...
'geneticcode’', 'Vertebrate Mitochondrial');
title(sprintf('Codons for frame %d',frame));
subplot(2,1,2);
codoncount(mitochondria, 'reverse',true, 'frame',frame,...
'figure',true, 'geneticcode', 'Vertebrate Mitochondrial');
title(sprintf('Codons for reverse frame %d',frame));
end
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Heat maps display all 64 codons in the 6 reading frames.

=

File Edit View Insert Tools Desktop Window Help k"
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Codons for frame 1
Abs | AAC | ACA  ACC | CAA | CAC | CCA  CCC

CTA | CTC

Genetic Code: Vertebrate Mitochondrial

Codons for reverse frame 1

GGG GGT | GIG GIT PISGHNIER TTG | T1T

Genstic Cede: Verebrate Mitcchondrial
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RL=IE

File Edit View Insert Tools Desktop Window Help k"
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Codons for frame 2

Ass | AAC | ACA ACC | CAA |EAC| CCA  CCC
A EET

CTA RO

Genetic Code: Vertebrate Mitochondrial

Codons for reverse frame 2

Genetic Cede: Verebrate Mitcchendrial
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RL=IE

File Edit Wiew Insert Tools Desktop Window Help k"
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Codons for frame 3

AAA | AAC | ACA  ACC | CAA | CAC | CCA | CCC

EH)
CC

Genetic Code: Vertebrate Mitochondrial

Codons for reverse frame 3

Genetic Cede: Verebrate Mitcchoendrial

Open Reading Frames

The following procedure illustrates how to locate the open reading frames
using a specific genetic code. Determining the protein-coding sequence for a
eukaryotic gene can be a difficult task because introns (noncoding sections)
are mixed with exons. However, prokaryotic genes generally do not have
introns and mRNA sequences have the introns removed. Identifying the
start and stop codons for translation determines the protein-coding section,
or open reading frame (ORF), in a sequence. Once you know the ORF for a
gene or mRNA, you can translate a nucleotide sequence to its corresponding
amino acid sequence.
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After you read a sequence into the MATLAB environment, you can analyze
the sequence for open reading frames. This procedure uses the human
mitochondria genome as an example. See “Reading Sequence Information
from the Web” on page 3-5.

1 Display open reading frames (ORFs) in a nucleotide sequence. In the

MATLAB Command Window, type:

seqshoworfs(mitochondria);

If you compare this output to the genes shown on the NCBI page for
NC_012920, there are fewer genes than expected. This is because vertebrate
mitochondria use a genetic code slightly different from the standard genetic
code. For a list of genetic codes, see the “Genetic Code” table in the aa2nt
reference page.

Display ORF's using the Vertebrate Mitochondrial code.

orfs= seqshoworfs(mitochondria,...
'GeneticCode', 'Vertebrate Mitochondrial',...
"alternativestart',true);

Notice that there are now two large ORFs on the third reading frame. One
starts at position 4470 and the other starts at 5904. These correspond to
the genes ND2 (NADH dehydrogenase subunit 2 [Homo sapiens] ) and
COX1 (cytochrome c oxidase subunit I) genes.

Find the corresponding stop codon. The start and stop positions for ORFs
have the same indices as the start positions in the fields Start and Stop.

ND2Start = 4470;

StartIndex = find(orfs(3).Start == ND2Start)
ND2Stop = orfs(3).Stop(StartIndex)

The stop position displays.

ND2Stop =

5511
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4 Using the sequence indices for the start and stop of the gene, extract the
subsequence from the sequence.

ND2Seq = mitochondria(ND2Start:ND2Stop)

The subsequence (protein-coding region) is stored in ND2Seq and displayed
on the screen.

attaatcccctggcccaacccgtcatctactctaccatctttgcaggcac
actcatcacagcgctaagctcgcactgattttttacctgagtaggectag
aaataaacatgctagcttttattccagttctaaccaaaaaaataaaccct
cgttccacagaagctgccatcaagtatttcctcacgcaagcaaccgceate
cataatccttc

5 Determine the codon distribution.

codoncount (ND2Seq)

The codon count shows a high amount of ACC, ATA, CTA, and ATC.

AAA - 10 AAC - 14 AAG - 2 AAT - 6
ACA - 11 ACC - 24 ACG - 3 ACT - 5
AGA - O AGC - 4 AGG - O AGT - 1
ATA - 23 ATC - 24 ATG - 1 ATT - 8
CAA - 8 CAC - 3 CAG - 2 CAT - 1
CCA - 4 ccC - 12 ccG - 2 CCT - 5
CGA - O CGC - 3 CGG - O CGT - 1
CTA - 26 CTC - 18 CTG - 4 CTT - 7
GAA - 5 GAC - O GAG - 1 GAT - O
GCA - 8 GCC - 7 GCG - 1 GCT - 4
GGA - 5 GGC - 7 GGG - O GGT - 1
GTA - 3 GTC - 2 GTG - O GTT - 3
TAA - O TAC - 8 TAG - O TAT - 2
TCA - 7 TCC - 11 TCG - 1 TCT - 4
TGA - 10 TGC - O TGG - 1 TGT - O
TTA - 8 TTC - 7 TTG - 1 TTT - 8

6 Look up the amino acids for codons ATA, CTA, ACC, and ATC.

aminolookup('code',nt2aa('ATA'))
aminolookup('code',nt2aa('CTA"))
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aminolookup('code',nt2aa('ACC'))
aminolookup('code',nt2aa('ATC'))

The following displays:

Ile isoleucine
Leu leucine

Thr threonine
Ile isoleucine

Amino Acid Conversion and Composition

The following procedure illustrates how to extract the protein-coding sequence
from a gene sequence and convert it to the amino acid sequence for the
protein. Determining the relative amino acid composition of a protein will
give you a characteristic profile for the protein. Often, this profile is enough
information to identify a protein. Using the amino acid composition, atomic
composition, and molecular weight, you can also search public databases

for similar proteins.

After you locate an open reading frame (ORF) in a gene, you can convert it to
an amino sequence and determine its amino acid composition. This procedure
uses the human mitochondria genome as an example. See “Open Reading
Frames” on page 3-15.

1 Convert a nucleotide sequence to an amino acid sequence. In this example,
only the protein-coding sequence between the start and stop codons is
converted.

ND2AASeq = nt2aa(ND2Seq, 'geneticcode’,...
'Vertebrate Mitochondrial')

The sequence is converted using the Vertebrate Mitochondrial genetic
code. Because the property AlternativeStartCodons is set to 'true' by
default, the first codon att is converted to M instead of I.

MNPLAQPVIYSTIFAGTLITALSSHWFFTWVGLEMNMLAFIPVLTKKMNP
RSTEAAIKYFLTQATASMILLMAILFNNMLSGQWTMTNTTNQYSSLMIMM
AMAMKLGMAPFHFWVPEVTQGTPLTSGLLLLTWQKLAPISIMYQISPSLN
VSLLLTLSILSIMAGSWGGLNQTQLRKILAYSSITHMGWMMAVLPYNPNM
TILNLTIYIILTTTAFLLLNLNSSTTTLLLSRTWNKLTWLTPLIPSTLLS
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LGGLPPLTGFLPKWAIIEEFTKNNSLIIPTIMATITLLNLYFYLRLIYST
SITLLPMSNNVKMKWQFEHTKPTPFLPTLIALTTLLLPISPFMLMIL

2 Compare your conversion with the published conversion in the GenPept
database.

ND2protein = getgenpept('YP_003024027', 'sequenceonly’,true)

The getgenpept function retrieves the published conversion from the NCBI
database and reads it into the MATLAB Workspace.

3 Count the amino acids in the protein sequence.

aacount (ND2AASeq, 'chart', 'bar')

A bar graph displays. Notice the high content for leucine, threonine and
isoleucine, and also notice the lack of cysteine and aspartic acid.
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<) Figure No. 1 ol %]
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4 Determine the atomic composition and molecular weight of the protein.

atomiccomp (ND2AASeq)
molweight (ND2AASeq)

The following displays in the MATLAB Workspace:
ans =

1818

2882

420
471

oO=Z2IT O
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ans =
3.8960e+004
If this sequence was unknown, you could use this information to identify

the protein by comparing it with the atomic composition of other proteins
in a database.
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Exploring a Nucleotide Sequence Using Graphical
Interface

In this section...

“Overview of the Biological Sequence Viewer” on page 3-22

“Importing a Sequence into the Biological Sequence Viewer” on page 3-22
“Viewing Nucleotide Sequence Information” on page 3-24

“Searching for Words” on page 3-26

“Exploring Open Reading Frames” on page 3-29

“Closing the Biological Sequence Viewer” on page 3-32

Overview of the Biological Sequence Viewer

The Biological Sequence Viewer integrates many of the sequence functions
in the toolbox. Instead of entering commands in the MATLAB Command
Window, you can select and enter options.

Importing a Sequence into the Biological Sequence
Viewer

The first step when analyzing a nucleotide or amino acid sequence is to
import sequence information into the MATLAB environment. The Biological
Sequence Viewer can connect to Web databases such as NCBI and EMBL and
read information into the MATLAB environment.

The following procedure illustrates how to retrieve sequence information from
the NCBI database on the Web. This example uses the GenBank accession
number NM_000520, which is the human gene HEXA that is associated with

Tay-Sachs disease.

1 In the MATLAB Command Window, type

seqviewer

The Biological Sequence Viewer window opens without a sequence loaded.
Notice that the panes to the right and bottom are blank.
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2 To retrieve a sequence from the NCBI database, select File > Download
Sequence from > NCBI.

The Download Sequence from NCBI dialog box opens.

Download Sequence from MCEI S |
Enter Sequence Accession Mumber or Locus Mame
@ Mucleotide () Protein
OK ] ’ Cancel

3 In the Enter Sequence box, type an accession number for an NCBI
database entry, for example, NM_000520. Click the Nucleotide option
button, and then click OK.

The MATLAB software accesses the NCBI database on the Web, loads
nucleotide sequence information for the accession number you entered,
and calculates some basic statistics.
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4\ Biological Sequence Viewer - NM_000520 [E=REER =5
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< [ » 661 ggcacattch ttatbaacaa gactgagatt Jaggactihic COCUCLLECC Loaccguygc
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omplement Sequence|
everse Complement S
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Comments

Base Count
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« n r « b
4.2 BP/Pixel [ ®x2Zoomin | [ & X2Zoomout |
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Sequence s
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Untitled = [ NM_000520

Viewing Nucleotide Sequence Information

After you import a sequence into the Biological Sequence Viewer window,
you can read information stored with the sequence, or you can view graphic
representations for ORFs and CDSs.

1 In the left pane tree, click Comments. The right pane displays general
information about the sequence.

2 Now click Features. The right pane displays NCBI feature information,
including index numbers for a gene and any CDS sequences.

3 Click ORF to show the search results for ORF's in the six reading frames.
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IS ™
4\ Biological Sequence Viewer - NM_000520 [E=EER
File Edit Sequence Display Window Help | x
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4 Click Annotated CDS to show the protein coding part of a nucleotide

sequence.
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Searching for Words

The following procedure illustrates how to search for characteristic words and
sequence patterns. You will search for sequence patterns like the TATAA box
and patterns for specific restriction enzymes.

1 Select Sequence > Find Word.

2 In the Find Word dialog box, type a sequence word or pattern, for example,
atg, and then click Find.
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L

Find Word

Enter a Word:

atg

Regular Expression

l

Find l ’ Cancel

The Biological Sequence Viewer searches and displays the location of the

selected word.
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3 Clear the display by clicking the Clear Word Selection button | & | on
the toolbar.

Exploring Open Reading Frames

The following procedure illustrates how to identify the protein coding part of a
nucleotide sequence and copy it into a new view. Identifying coding sections
of a nucleotide sequence is a common bioinformatics task. After locating the
coding part of a sequence, you can copy it to a new view, translate it to an
amino acid sequence, and continue with your analysis.

1 In the left pane, click ORF.

The Biological Sequence Viewer displays the ORFs for the six reading
frames in the lower-right pane. Hover the cursor over a frame to display
information about it.

4.2 BP/Picel [ @ x2zoomin | [ & x2Zoom out

Map View 1 Looo 2000 za37 ~

Sequence

—_— |—D|—D|} e — - —
@1e—t @~ |Frame:1, StartBP: 208, EndBP: 1795, Length: 1588 —
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ORF

— — - i

cos MIER m r

Untitled = | NM_000520 =

2 Click the longest ORF on reading frame 2.

The ORF is highlighted to indicate the part of the sequence that is selected.
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3 Right-click the selected ORF and then select Export to Workspace. In
the Export to MATLAB Workspace dialog box, type a variable name, for
example, NM_000520_ORF_2, then click Export.
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Export to MATLAE Workspace | 2

Enter a Variable Name:

MM _000520_ORF_2

Export ] ’ Cancel

L A

The NM_000520_ORF_2 variable is added to the MATLAB Workspace.

4 Select File > Import from Workspace. Type the name of a variable
with an exported ORF, for example, NM_000520_ORF_2, and then click

Import.

The Biological Sequence Viewer adds a tab at the bottom for the new
sequence while leaving the original sequence open.
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5 In the left pane, click Full Translation. Select Display > Amino Acid
Residue Display > One Letter Code.

The Biological Sequence Viewer displays the amino acid sequence below
the nucleotide sequence.
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Closing the Biological Sequence Viewer

Close the Biological Sequence Viewer window from the MATLAB command
line using the following syntax:

seqviewer('close')
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Exploring a Protein Sequence Using Graphical Interface

In this section...

“Overview of the Biological Sequence Viewer” on page 3-33
“Viewing Amino Acid Sequence Statistics” on page 3-33

“Closing the Biological Sequence Viewer” on page 3-37

“References” on page 3-37

Overview of the Biological Sequence Viewer

The Biological Sequence Viewer integrates many of the sequence functions
in the toolbox. Instead of entering commands in the MATLAB Command
Window, you can select and enter options.

Viewing Amino Acid Sequence Statistics

The following procedure illustrates how to view an amino acid sequence for
an ORF located in a nucleotide sequence. You can import your own amino
acid sequence, or you can get a protein sequence from the GenBank database.
This example uses the GenBank accession number NP_000511.1, which is the
alpha subunit for a human enzyme associated with Tay-Sachs disease.

1 Select File > Download Sequence from > NCBI.
The Download Sequence from NCBI dialog box opens.

2 In the Enter Sequence box, type an accession number for an NCBI
database entry, for example, NP_000511.1. Click the Protein option
button, and then click OK.
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Download Sequence from MCEI ﬁ
Enter Sequence Accession Mumber or Locus Mame
MP_000511.1

() Mucleotide @ 'Pru:uteirg

QK ] ’ Cancel

L= A

The MATLAB software accesses the NCBI database on the Web and loads
amino acid sequence information for the accession number you entered.
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3 Select Display > Amino Acid Color Scheme, and then select Charge,
Function, Hydrophobicity, Structure, or Taylor. For example, select

Function.

The display colors change to highlight charge information about the amino
acid residues. The following table shows color legends for the amino acid
color schemes.
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Amino Acid Color Scheme Color Legend

Charge

¢ Acidic — Red
¢ Basic — Light Blue
Neutral — Black

Function

Acidic — Red
¢ Basic — Light Blue

Hydropobic, nonpolar — Black

Polar, uncharged — Green




Exploring a Protein Sequence Using Graphical Interface

Amino Acid Color Scheme

Color Legend

Hydrophobicity ¢ Hydrophilic — Light Blue
¢ Hydrophobic — Black
Structure ¢ Ambivalent — Dark Green
¢ External — Light Blue
¢ Internal — Orange
Taylor Each amino acid is assigned its own

color, based on the colors proposed by
W.R. Taylor.

Closing the Biological Sequence Viewer
Close the Biological Sequence Viewer window from the MATLAB command

line using the following syntax:

seqviewer('close')

References

[1] Taylor, W.R. (1997). Residual colours: a proposal for aminochromography.
Protein Engineering 10, 7, 743-746.
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Sequence Alignment
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In this section...

“Overview of Example” on page 3-38

“Finding a Model Organism to Study” on page 3-38

“Retrieving Sequence Information from a Public Database” on page 3-40
“Searching a Public Database for Related Genes” on page 3-43
“Locating Protein Coding Sequences” on page 3-45

“Comparing Amino Acid Sequences” on page 3-49

Overview of Example

Determining the similarity between two sequences is a common task in
computational biology. Starting with a nucleotide sequence for a human gene,
this example uses alignment algorithms to locate and verify a corresponding
gene in a model organism.

Finding a Model Organism to Study

The following procedure illustrates how to use the MATLAB Help browser
to search the Web for information. In this example, you are interested in
studying Tay-Sachs disease. Tay-Sachs is an autosomal recessive disease
caused by the absence of the enzyme beta-hexosaminidase A (Hex A). This
enzyme is responsible for the breakdown of gangliosides (GM2) in brain and
nerve cells.

First, research information about Tay-Sachs and the enzyme that is associated
with this disease, then find the nucleotide sequence for the human gene

that codes for the enzyme, and finally find a corresponding gene in another
organism to use as a model for study.

1 Use the MATLAB Help browser to explore the Web. In the MATLAB
Command window, type

web('http://www.ncbi.nlm.nih.gov/")



Sequence Alignment

The MATLAB Help browser opens with the home page for the NCBI Web
site.

2 Search the NCBI Web site for information. For example, to search for
Tay-Sachs, from the Search list, select NCBI Web Site, and in the for
box, enter Tay-Sachs.

National Center for Biotechnology Information

1onal Lib ¢ of Medicine National Institutes of Health

=

Structure

Search |NCBIWeb Site ¥| for |Tay-Sachs
Limits  Preview/Index  History Clipboard Deatails

Display IISummary j Shgw;|20 j Send to IText vl

7 1: Tay-Sachs Disease Related sites
Genes and dizesse provides short descriptions of inherited
disorders, It is hosted by the MNational Center for Biotechnology
Information (NCEBI), a division of the INational Library of
Medicine (NLM) at the MNational Institutes of Health (INIH).
Category: product-service information.article

3 Select a result page. For example, click the link labeled Tay-Sachs
Disease.

A page in the genes and diseases section of the NCBI Web site opens. This
section provides a comprehensive introduction to medical genetics. In
particular, this page contains an introduction and pictorial representation
of the enzyme Hex A and its role in the metabolism of the lipid GM2
ganglioside.
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_ -
ksl genes and disease
“r ~< . from the national center for biotechnology information
"'" ¢
*
Short Contents | Full C

Genes and Disease = B Nutritional and Metabolic
About this boak Diseases
N—utl‘itioPaI ‘de Tay-Sachs dizease
Metabolic Dizeazes
Adrenoleukodyetrophy | Tay-Sachs disesse, a heritable Phospnelpids
Diabetes, type 1 metabolic disorder commonly
Claucher disease aggoclated with Ashkenazl Jews, ollcess)
- has alzo been found in the French G
Mm Canadians of Scutheastern ﬁmaﬂi%
malabsorption Guebec, the Cajuns of Southwest
Hereditary Louisiana, and other populations & éa
hemochromatosis throughout the world, The severity
Maple syrup urine of expreseion and the age at onsst
disease of Tay-Sachs varies from infantile =
Menkes svndrome and juv§m'le form; thaTl: exhibit an{é) }HexA
AAENAEeE SYNCrome paralyels, dementia, blindnsss and

4 After completing your research, you have concluded the following:

The gene HEXA codes for the alpha subunit of the dimer enzyme
hexosaminidase A (Hex A), while the gene HEXB codes for the beta subunit
of the enzyme. A third gene, GM2A, codes for the activator protein GM2.
However, it is a mutation in the gene HEXA that causes Tay-Sachs.

Retrieving Sequence Information from a Public
Database

The following procedure illustrates how to find the nucleotide sequence for a
human gene in a public database and read the sequence information into the
MATLAB environment. Many public databases for nucleotide sequences (for
example, GenBank, EMBL-EBI) are accessible from the Web. The MATLAB
Command Window with the MATLAB Help browser provide an integrated
environment for searching the Web and bringing sequence information into
the MATLAB environment.

After you locate a sequence, you need to move the sequence data into the
MATLAB Workspace.
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1 Open the MATLAB Help browser to the NCBI Web site. In the MATLAB
Command Widow, type

web('http://www.ncbi.nlm.nih.gov/")
The MATLAB Help browser window opens with the NCBI home page.

2 Search for the gene you are interested in studying. For example, from the
Search list, select Nucleotide, and in the for box enter Tay-Sachs.

National Center for Biotechnology Information
MNational Library of Medicine Mational Institutes of Health

Structure

Bemroh INucIeutide j for ITay—Sachs

The search returns entries for the genes that code the alpha and beta
subunits of the enzyme hexosaminidase A (Hex A), and the gene that codes
the activator enzyme. The NCBI reference for the human gene HEXA has
accession number NM_000520.
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s

“ZNucleotide

Structure  PMC onomy  OMIM B
Go Clearl

Limits Previewndex History Clipboard Details

Display ISummary jShuw |20 j Send to IText -
Items 1-20 of 33 Page ||1 of 2 Mext

™ 1: WM_000405
Homo sapiens GM2 ganglicside activator protein (GR2A),
MR
gi| 18507969 | ref| MW _000405.2 | [1650T969]

2 WW_000521
Homo saplens hexosaminidase B (beta polypeptide) (HEXB),
mEMNA
g1l 131266866 | ref| NM_000521.2| [13128866)

™3 NM_000520
Homo sapiens hexosaminidase A (alpha polypeptide) (HEMA),
mREIMA
g1l 1312686865 | ref| NM_000520.2| [131258865)

3 Get sequence data into the MATLAB environment. For example, to get
sequence information for the human gene HEXA, type

humanHEXA = getgenbank('NM_000520")

Note Blank spaces in GenBank accession numbers use the underline
character. Entering 'NM 00520' returns the wrong entry.

The human gene is loaded into the MATLAB Workspace as a structure.

humanHEXA =

LocusName: 'NM_000520"'
LocusSequencelLength: '2255'
LocusNumberofStrands: ''
LocusTopology: 'linear'
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LocusMoleculeType: 'mRNA'
LocusGenBankDivision: 'PRI'
LocusModificationDate: '13-AUG-2006'
Definition: 'Homo sapiens hexosaminidase A (alpha polypeptide) (HEXA), mRNA.'
Accession: 'NM_000520'
Version: 'NM_000520.2'
GI: '13128865"'
Project: []
Keywords: []
Segment: []
Source: 'Homo sapiens (human)'
SourceOrganism: [4x65 char]
Reference: {1x58 cell}
Comment: [15x67 char]
Features: [74x74 char]
CDS: [1x1 struct]
Sequence: [1x2255 char]
SearchURL: [1x108 char]
RetrieveURL: [1x97 char]

Searching a Public Database for Related Genes

The following procedure illustrates how to find the nucleotide sequence for
a mouse gene related to a human gene, and read the sequence information
into the MATLAB environment. The sequence and function of many genes
is conserved during the evolution of species through homologous genes.
Homologous genes are genes that have a common ancestor and similar
sequences. One goal of searching a public database is to find similar genes.
If you are able to locate a sequence in a database that is similar to your
unknown gene or protein, it is likely that the function and characteristics of
the known and unknown genes are the same.

After finding the nucleotide sequence for a human gene, you can do a BLAST
search or search in the genome of another organism for the corresponding
gene. This procedure uses the mouse genome as an example.

1 Open the MATLAB Help browser to the NCBI Web site. In the MATLAB
Command window, type

web('http://www.ncbi.nlm.nih.gov"')
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2 Search the nucleotide database for the gene or protein you are interested in
studying. For example, from the Search list, select Nucleotide, and in the
for box enter hexosaminidase A.

National Center for Biotechnology Information

Natwonal Tibrary of Medicine Matwonal Institutes of Health

ELAST CIITM

T Structure

Bearah INucIentidB j for Ihexnsaminidase A

The search returns entries for the mouse and human genomes. The NCBI
reference for the mouse gene HEXA has accession number AKO80777.

Details

Limits Freview/Index History Clipboard

Display ISummaryr j o |20 j Send to IText -
Items 1-16 of 16 Cne page.
I 1: AROS0TTT Links

LIug musgculuz 9.5 daye embryo parthenogenote oDITA, RIKELN
full-length enriched lbrary, clone B120019109
product:hexosaminidase A, full insert sequence

gl| 26348756 | dbj | AKOB0TTT. 1| [26348756]

3 Get sequence information for the mouse gene into the MATLAB
environment. Type

mouseHEXA = getgenbank('AK080777"')
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The mouse gene sequence is loaded into the MATLAB Workspace as a

structure.

mouseHEXA =

LocusName:
LocusSequencelLength:
LocusNumberofStrands:
LocusTopology:
LocusMoleculeType:
LocusGenBankDivision:
LocusModificationDate:
Definition:
Accession:

Version:

GI:

Project:

Keywords:

Segment:

Source:
SourceOrganism:
Reference:

Comment:

Features:

CDS:

Sequence:

SearchURL:
RetrieveURL:

'AK080777'

'1839'

‘linear’

"mRNA'

"HTC'

'02-SEP-2005"
[1x150 char]
"AK080777'
'AK080777.1"
'26348756'

[]

"HTC; CAP trapper.'
[]

"Mus musculus
[4x65 char]
{1x8 cell}
[8x66 char]
[33x74 char]
[1x1 struct]
[1x1839 char]
[1x107 char]
[1x97 char]

(house mouse)'

Locating Protein Coding Sequences

The following procedure illustrates how to convert a sequence from nucleotides
to amino acids and identify the open reading frames. A nucleotide sequence
includes regulatory sequences before and after the protein coding section. By
analyzing this sequence, you can determine the nucleotides that code for

the amino acids in the final protein.

After you have a list of genes you are interested in studying, you can
determine the protein coding sequences. This procedure uses the human gene
HEXA and mouse gene HEXA as an example.
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1 If you did not retrieve gene data from the Web, you can load example data

from a MAT-file included with the Bioinformatics Toolbox software. In the
MATLAB Command window, type

load hexosaminidase

The structures humanHEXA and mouseHEXA load into the MATLAB
Workspace.

Locate open reading frames (ORFs) in the human gene. For example, for
the human gene HEXA, type

humanORFs = seqshoworfs (humanHEXA.Sequence)

segshoworfs creates the output structure humanORFs. This structure
contains the position of the start and stop codons for all open reading
frames (ORFs) on each reading frame.

humanORFs =

1x8 struct array with fields:
Start
Stop

The Help browser opens displaying the three reading frames with the
ORF's colored blue, red, and green. Notice that the longest ORF is in the
first reading frame.
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Frame 1

000001 agttgcocgacgcocoggoacaatcocgotgcacgtagcaggagocctcaggdtccaggoocggaagtga
000065 aagggcaggdtgtgggtococtoctggggtogocaggogcagagococycctotggtcacgtgattoge
000129 cgataagtcacgggggocgococgoctcacctgaccagggtoctcacgtggccagocccocctoocgagagd
000183 ggagaccagcgggccatgacaagotocaggotttggttttogotgeotgotggoggoagogtteg
000257 caggacgggogacggocctotggoocotggoctoagaacttocaaacotoogaccagogotacgt
000321 cotttaccogaacaactttoaattocagtacgatgtoagotoggoogogoagoocoggotgotea
000385 gtoctogacgaggoottocagegetatogtgacotgottttoggttoogggtottggoooogte
000449 cttacoteoacagggaaacggoatacactggagaagaatgtgttggttgtoteotgtagtoacaceo
000513 tggatgtaaccagottoctactttggagtoagtggagaattataccotgaccataaatgatgac
0Q0577 cagtgtttacteoctototgagactgtotggggagetotoocgaggtotggagacttttagoocage
000641 ttgtttggaaatotgotgagggeoacattetttateoaacaagactgagattgaggactttooceg
000705 ctttooctoacoggggottgotgttggatacatotogocattacotgocactototageoatootg
000769 gacactotggatgteoatggogtacaataaattgaacgtgttocactggeoateotggtagatgate
000833 cttoottoocatatgagagottoacttttocagagotoatgagaaaggggtoctacaacootgt
000887 cacocacatotacacageoacaggatgtgaaggaggteoattgaatacgoacggotooggggtateo
000961 cgtgtgottgoagagtttgacacteootggocacactttgtoctggggaccaggtatocotggat
001025 tactgactoottgeotactotgggtetgagoocototggoacotttggaccagtgaatocoagtet
001089 caataatacoctatgagttoatgageoacattottottagaagtoageototgtottocoagatttt
001153 tatotteoatottggaggagatgaggttgattteoacotgotggaagtocaacocagagatocagg
001217 actttatgaggaagaaaggottoggtgaggacttoaagoageotggagtocttotacatocagac
001281 gotgotggacateogtotettottatggoaagggeotatgtggtgtggoaggaggtgtttgataat
001345 aaagtaaagattocagoocagacacaatoatacaggtgtggogagaggatattocagtgaactata
001409 tgaaggagotggaactggtoaccaaggoeggottoocgggocottotototgococootggtacet
001473 gaacogtatateootatggoootgactggaaggatttotacatagtggaacoccctggoatttgaa
001537 ggtacococtgagoagaaggototggtgattggtggagaggettgtatgtggggagaatatgtag
001601 acaacacaaacctggtecccaggetetggeccagageaggggetgttgocgaaaggetgtggag
001665 caacaagttgacatctgacctgacatttgectatgaacgtttgtecacacttecgetgtgaattg
001729 ctgaggegaggtgtocaggeccaaccoctecaatgtaggettetgtgagecaggagtttgaacaga
0017393 coctgagoccoccaggocaccgaggaggogtgotggoctgtaggtgaatggtagtggagecaggetteca
001857 ctgecatcctggocaggggacggageccettgecttegtgeccocttgectgegtgeccetgtget
001521 tggagagaaaggggccggtgetggegetegeattecaataaagagtaatgtggeatttttetata
001985 ataaacatggattacctgtgtttaaaaaaaaaagtgtgaatggegttagggtaagggeacagec
002049 aggctggagtcagtgtetgececctgaggtettttaagttgagggetgggaatgaaacetatage
002113 ctttgtgetgttetgeoettgectgtgagetatgtcactcocccteoccactocctgaccatattcca
002177 gacacctgococtaatcoctcagoctgotcacttcacttoctgeattatatectocaaggeogttggta
002241 tatggaaaaagatgtaggggettggaggtgttetggacagtggggagggctecagacccaacet
002305 ggtcacagaagagectetoococcatgeoatacteatecacctoococtococtagagetatteoteect
002369 ttgggtttecttgetgettcaattttatacaaccattatttaaatattattaaacacatattgtt
002433 cteta

3 Locate open reading frames (ORFs) in the mouse gene. Type:
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mouseORFs = seqshoworfs(mouseHEXA.Sequence)
seqgshoworfs creates the structure mouseORFS.
mouseORFs =
1x38 struct array with fields:

Start

Stop

The mouse gene shows the longest ORF on the first reading frame.

Fratme 1

000001 getgotggaagyggadgotggeedgtgggecatyyoogygotygocagyctotgygygtttogotygotye
000055 tggoggoggogttyggoctigeottggeocacygecactgtgygeoccgtyggocccagtacatecaaaccta
000129 ccaccyggogotacacocctygtacococrcaacaacttocagttocggtaccatgtocagttogyooygoyg
000193 cagygcgggctgcgtogtocteogacygaggectttogacgeoctaccgtaacctgoctocttoggttocyg
000257 gotottggocococgacccagottoteoaaataaacagraaacygttygyyggaagaacattotyggtyggt
000321 ctocgtogtcacagctgaatgtaatgaatttectaatttggagtocggtagaaaattacacccta
000355 accattaatgatgaccagtgtttactogocteotgagactgtotgygggogotoctoogagytotyy
000449 agactttcagtcagecttgtttggaaatcagetgagggoacgttctttatcaacaagacaaagat
000513 taaagactttoctogattoococteocacoygyygyogtactgotggatacatoctogocattacoctyoca
000577 ttgtctagcatcctyggatacactggatgtcatyggecatacaataaattcaacgtgttccactgge
000641 acttgygtggacgactottoottooecatatgagagottoactttococagagotocaccagaaagyyg
000705 gtocttcaaccctygtcacteocacatectacacagecacaggatgtgaaggaggtcattgaatacgea
000759 aggcttoggggtatoogtygtygctyygoagaatttygacactoctyggocacactttgtoctyygyyyce
000533 caggtgocccctgggttattaacaccttgetactoctgggtctocatoctectotggoacatttggace
000897 gygtgaaccccagtotoaacagocacctatgacttocatgagoacacteottoctyggagatocageoteoa
000951 gtottococggacttttatctecacctyggyagygygatgaagtogacttcacctgoctggaagtoca
001025 acoccaacatcocagyccttoatyaagaaaaagyyotttactgacttocaagoagotyggagtoott
0010589 ctacatccagacgeotgetggacateogtetctgattatgacaagggetatgtggtgtyggocaggayg
001153 gtatttgataataaagtgaagygttcggecagatacaatcatacaggtgtyggcgggaagaaatge
001217 cagtagagtacatgttyggagatygcaagatatcaccagggoctggottooggygooctyotygtotye
001251 tcoctggtacctgaaccygtgtaaagtatyggoecctgactyggaaggacatgtacaaagtyggagoeo
001345 ctggogtttoatgygtacygooctygaacagaagyototggtoattyggagygyggagyoctygtatygtyyy
001409 gagagtatgtggacagcaccaacctyggtcocccagactotggoccagagogggtgocgtogetga
001473 gagactgtggagcagtaacotygacaactaatatagactttgoctttaaacgtttygtogeoattte
001537 cgttgtgagoctggtgagygagaggaatccaggeccagoccatcagtgtagygctgoctgtgagecagy
001601 agtttgagoagacttgagooaccagtgotgaacacecagyagyttyotyiootttagtoagot
001665 gogotgagoaccoaggagggbgotggocttaagagageaggtiococgyggecaggyotaatettto
001729 asctgoctocogyocadygdadadoacooctigoocgtytgeccotytgactacagagaadgady

001793 ctggtgotggoactggbgttcaataaagatctatgtggeocattttote
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Comparing Amino Acid Sequences

The following procedure illustrates how to use global and local alignment
functions to compare two amino acid sequences. You could use alignment
functions to look for similarities between two nucleotide sequences, but
alignment functions return more biologically meaningful results when you
are using amino acid sequences.

After you have located the open reading frames on your nucleotide sequences,
you can convert the protein coding sections of the nucleotide sequences to
their corresponding amino acid sequences, and then you can compare them
for similarities.

1 Using the open reading frames identified previously, convert the human
and mouse DNA sequences to the amino acid sequences. Because both the
human and mouse HEXA genes were in the first reading frames (default),
you do not need to indicate which frame. Type

humanProtein = nt2aa(humanHEXA.Sequence);
mouseProtein = nt2aa(mouseHEXA.Sequence);

2 Draw a dot plot comparing the human and mouse amino acid sequences.
Type

seqdotplot(mouseProtein,humanProtein,4,3)
ylabel('Mouse hexosaminidase A (alpha subunit)')
xlabel('Human hexosaminidase A (alpha subunit)')

Dot plots are one of the easiest ways to look for similarity between

sequences. The diagonal line shown below indicates that there may be a
good alignment between the two sequences.
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3 Globally align the two amino acid sequences, using the Needleman-Wunsch
algorithm. Type

[GlobalScore, GlobalAlignment] = nwalign(humanProtein,...

mouseProtein);
showalignment (GlobalAlignment)

showalignment displays the global alignment of the two sequences in
the Help browser. Notice that the calculated identity between the two
sequences 1s 60%.
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Identities = 431/812 (60%), Positives = 575/812 (71%)
001 SCRRPAQSAARSRSLRSRPEVHGCGVGEPGVAGAEPPLVT*FLDKSRGRESEDOGLTWPLPSER

11 I: | I 11 I
001 -———-——— AR —— GR-——————— G———mm———— A-———G-R——————— W-———

085 GDORAMTSSRLWFSLLLAAAFAGRATALWPWPONFQTSDORYVLYPHNEQFQYDVISALAQPGECS

Plzz D0 Leereee=e teerenrelr =0 == eneener=0 reeeer 1l
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070 VLDEAFRRYRNLLFGSGSWPRPSFSNEQUILGENILVVSVVIAECNEFPNLESVENYTLTINDD

183 QCLLLEETVWGALRGLETFSQLVWKSAEGTFFINKTEIEDFPRFPHRGLLLDTSEHYLPLSSIL

(NN N AN R R R RN R AR A RN RN RR RN RRRRRRARY
134 QCLLASETVWGALRGLETFSQLVWESAEGTFFINKTKIKDFPRFPHRGVLLDTSRHYLPLSSIL

257 DILDVMAYNELNVFHWHLVDDPSFPYESFTFPELMBEGSYNPVIHIYTAQDVEEVIEYARLRGL

FLRRRERER=eereere e teenr e tevr e ren e e e el
198 DILDVMAYNEFNVFHWHLVDDSSFEYESFTFPELTRKGSFNEVIHIYTAQDVKEVIEYARLRGT

321 EVLAEFDTPGHTILSWGPGIPGLLIPCYSGSEPSGIFGEVNEPSLNNIYEFMSTFFLEVSSVEFFDE

TERRERRRETR e reneeenn s etz nert=nter=rennitl
262 RVLAEFDTPGHETILSWGPGAPGLLIPCYSGSHLIGIFGPVHNPSLNSTYDFMSTLFLEISSVEEDE

385 YLELGGDEVDFICWESNPEIQDFMEEKGFGEDFEQLESFYIQTLLDIVISSYGEGYVVWOQEVFDN

Ferrrerreereeereer=er reseeet terereeerenrr e P rrernnd
326 YLHLGGDEVDFICWESNPNIQAFMEEKGF-TDFEQLESFYIQTLLDIVSDYDRGYVVWQEVEDN

448 EKVEIQPDTIIQVWREDIPVNYMRELELVIEAGFRALLSAPWYLNRISYGPDWEDEYIVEPLAFE

R R N e N N N R R N N RN R A AR
389 EVEVRPDTIIQVWREEMPVEYMLEMODITRAGFRALLSAPWYLNEVEYGPDWEDMYEVEPLAFH

513 GTPEQRALVIGGERCMWGEYVDNINLVPRLWPRAGAVAERLWSNELTSDLTFAYERLSHFRCEL

(AR R R R R R RN RN R R R RN RN RN RN
453 GIPEQEALVIGGERCHMWGEYVDSINLVPRLWPRAGAVAERLWSSHLITHNIDFAFERLSHFRCEL

577 LERGVOACPLNVGEFCECQEFEQT*APGIEEGAGCR*MVVEPGFHCILARGRSPLPSCPLEACEFCL

RO O B B N ! ! I
517 VRRGIQAQPISVGCCEQEFEQT*A--T--S5A--E-——-HPG——————- G-————— C-———CP——

641 WRERGRCWRSHSIESHNVAFFYNEHGLEVFHEEESVNGVRVRAQPGWSQCLPLRSFELRAGNETYS
= =: | | HE | HEEN | =] HE I
552 ——————- L-50-LE-—-%h———————— P-—-RRE-V--LALR-E--—-Q-VP--G-0——-G-*35FT

705 LCAVLPCL*AMSLPSHS*PYSRHLP*SSACSLHFCIISPREWYMEKDVGAWRCSGOWGGLOTQR
(B : I | [ [Ny I [
578 ———————— A-SRPGES——-T-——P-——-CP---C—-APVI--TEKEAGA-———-GT-—-GV--0—

769 GHRRASPPCILIHLPPLELESFGFLAASILYNHYLNIIKHILFS
| (B ] [
606 ——FR—mm——mmmmmm S-MW-HF——————— L-- 3-51
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The alignment is very good between amino acid position 69 and 599, after
which the two sequences appear to be unrelated. Notice that there is a
stop (*) in the sequence at this point. If you shorten the sequences to
include only the amino acids that are in the protein you might get a better
alignment. Include the amino acid positions from the first methionine (M) to
the first stop (*) that occurs after the first methionine.

Trim the sequence from the first start amino acid (usually M) to the first
stop (*) and then try alignment again. Find the indices for the stops in
the sequences.

humanStops find(humanProtein == '*')

humanStops

41 599 611 713 722 730

mouseStops find(mouseProtein == '*')

mouseStops
539 557 574 606

Looking at the amino acid sequence for humanProtein, the first M is at
position 70, and the first stop after that position is actually the second
stop in the sequence (position 599). Looking at the amino acid sequence
for mouseProtein, the first M is at position 11, and the first stop after that
position is the first stop in the sequence (position 557).

Truncate the sequences to include only amino acids in the protein and
the stop.

humanProteinORF = humanProtein(70:humanStops(2))

humanProteinORF

MTSSRLWFSLLLAAAFAGRATALWPWPQNFQTSDQRYVLYPNNFQFQYDV
SSAAQPGCSVLDEAFQRYRDLLFGSGSWPRPYLTGKRHTLEKNVLVVSVV
TPGCNQLPTLESVENYTLTINDDQCLLLSETVWGALRGLETFSQLVWKSA
EGTFFINKTEIEDFPRFPHRGLLLDTSRHYLPLSSILDTLDVMAYNKLNV
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FHWHLVDDPSFPYESFTFPELMRKGSYNPVTHIYTAQDVKEVIEYARLRG
IRVLAEFDTPGHTLSWGPGIPGLLTPCYSGSEPSGTFGPVNPSLNNTYEF
MSTFFLEVSSVFPDFYLHLGGDEVDFTCWKSNPEIQDFMRKKGFGEDFKQ
LESFYIQTLLDIVSSYGKGYVVWQEVFDNKVKIQPDTIIQVWREDIPVNY
MKELELVTKAGFRALLSAPWYLNRISYGPDWKDFYIVEPLAFEGTPEQKA
LVIGGEACMWGEYVDNTNLVPRLWPRAGAVAERLWSNKLTSDLTFAYERL
SHFRCELLRRGVQAQPLNVGFCEQEFEQT*

mouseProteinORF = mouseProtein(11:mouseStops(1))

mouseProteinORF

MAGCRLWVSLLLAAALACLATALWPWPQYIQTYHRRYTLYPNNFQFRYHV
SSAAQAGCVVLDEAFRRYRNLLFGSGSWPRPSFSNKQQTLGKNILVVSVV
TAECNEFPNLESVENYTLTINDDQCLLASETVWGALRGLETFSQLVWKSA
EGTFFINKTKIKDFPRFPHRGVLLDTSRHYLPLSSILDTLDVMAYNKFNV
FHWHLVDDSSFPYESFTFPELTRKGSFNPVTHIYTAQDVKEVIEYARLRG
IRVLAEFDTPGHTLSWGPGAPGLLTPCYSGSHLSGTFGPVNPSLNSTYDF
MSTLFLEISSVFPDFYLHLGGDEVDFTCWKSNPNIQAFMKKKGFTDFKQL
ESFYIQTLLDIVSDYDKGYVVWQEVFDNKVKVRPDTIIQVWREEMPVEYM
LEMQDITRAGFRALLSAPWYLNRVKYGPDWKDMYKVEPLAFHGTPEQKAL
VIGGEACMWGEYVDSTNLVPRLWPRAGAVAERLWSSNLTTNIDFAFKRLS
HFRCELVRRGIQAQPISVGCCEQEFEQT*

Globally align the trimmed amino acid sequences. Type

[GlobalScore_trim, GlobalAlignment_trim] = nwalign(humanProteinORF,...
mouseProteinORF) ;
showalignment (GlobalAlignment_trim)

showalignment displays the results for the second global alignment. Notice

that the percent identity for the untrimmed sequences is 60% and 84% for
trimmed sequences.
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Identities = 446/530 (84%), Positives = 502/530 (95%)
001 MT5SRLWFSLLLARAFAGRATALWEWPCNFCOTSDORYVLYPNNFQFOYDVSSAAQPGCSVLDER

P== 10 reeeeee=e rereeeee =00 =rr=rnenreer=r reeeer or o rernd
001 MAGCELWVSLLLAAALACLATALWPWPOYIQTYHRRYILYPNNEFQFREYHVSSAAQAGCVVLDEL

065 FORYRDLLFGSGESWPRPYLTGERHTLEENVLVVSVVIPGCHOLPTLESVENYTILTINDDQCLLL.

P=rri=nneenrernrr ===r==00 pr=neeheet  pr=st=0eer el
065 FRRYRNLLFGSGSWPRPSFSNEQOTLGENILVVSVVIAECNEFFNLESVENYTLTINDDOCLLA

129 SETVWGALRGLETFSQOLVWESAEGIFFINKIEIEDFPEFPHRGLLLDTSEHYLPLSSILDILDV

(NN RN N N R R RN R R R AR RN R RN RN R RN RN
129 SETVWGALRGLEIFSOLVWESAEGTFFINKIKIKDFPRFPHRGVLLDTSREYLPLSSILDILDV

193 MAYMELNVFHWHLVDDESFPYESFIFPELMEEGSYNPVIHIYTAQDVEEVIEYARLRGIEVLAE

Prrrr=ereeereeer reeereeeeeer reet=eeerer e er e rernnn
193 MAYNEFNVEHEWHLVDDSSFPRYESFTFPELTREGSFHNPVIHIYTAQDVEEVIEYARLEGIRVLAE

257 FDITPGHILSWGPGIPGLLTPCYSGEEPSGIFGPVNESLNNIYEFMSTFFLEVSSVEFPDEFYLHELG

Prrreeereerrr reeeeeerrers reernre et er=nerer=en=rrnneinrnnn
257 FDTPGHILSWGPGAPGLLTPCYSGSHLSGTFGPVNESLNESTYDFMSTLFLEISSVEFPDEFYLHELG

321 GDEVDFICWESHNPEIQDFMEEEGFGEDFEQLESFYIQILLDIVSSYGEGYVVWOEVEFDNEVEIQ

ferreerrerere=er re=eeer rerreer e e e et e
321 GDEVDFTCWESHNPNIQAFMEKEGF-TDFEQLESFYIQTLLDIVSDYDEGYVVHOEVEDNEVEVER

385 PDTIICVWREDIFVHNYMEELELVIEKAGFRALLSAPWYLNRISYGFDWEDFYIVEFLAFEGTFEQ

PERRRRRRN =i 0 pes s bs 0 i e e s s bnenent=0 renrnr=nnnni
384 POTIICVWREEMPVEYMLEMODITRAGFRALLSAPWYLNRVEYGPDWRKDMYKVEPLAFHGTFPECQ

449 FALVIGGEACHMWGEYVDNINLVEFRLWPRAGAVAERLWSNELT SDLTFAYERLSHFRCELLERGV
Frrrreereererrerrnrrrrreern etz e terennee=ntt:
448 FALVIGGEACHMWGEYVDSTNLVEPRLWPRAGAVAERLWSSNLITHNIDFAFERLSHFRCELVERGI

513 QAQPLNVGFCEQEFEQT*

FREr==0r tenerennd
512 QAQPISVGCCEQEFEQT*

7 Another way to truncate an amino acid sequence to only those amino acids

in the protein is to first truncate the nucleotide sequence with indices from
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the seqshoworfs function. Remember that the ORF for the human HEXA
gene and the ORF for the mouse HEXA were both on the first reading
frame.

humanORFs = seqshoworfs (humanHEXA.Sequence)

humanORFs

1x3 struct array with fields:
Start
Stop

mouseORFs = seqshoworfs(mouseHEXA.Sequence)

mouseORFs

1x38 struct array with fields:
Start
Stop

):

humanPORF = nt2aa(humanHEXA.Sequence (humanORFs(1).Start(1):...
1)));

humanORFs (1) .Stop(

1):...
)));

mousePORF = nt2aa(mouseHEXA.Sequence(mouseORFs(1).Start(
mouseORFs (1) .Stop (1

[GlobalScore2, GlobalAlignment2] = nwalign(humanPORF, mousePORF);
Show the alignment in the Help browser.
showalignment(GlobalAlignment2)

The result from first truncating a nucleotide sequence before converting it

to an amino acid sequence is the same as the result from truncating the

amino acid sequence after conversion. See the result in step 6.

An alternative method to working with subsequences is to use a local
alignment function with the nontruncated sequences.
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8 Locally align the two amino acid sequences using a Smith-Waterman
algorithm. Type

[LocalScore, LocalAlignment] = swalign(humanProtein,...
mouseProtein)
LocalScore =
1057
LocalAlignment =

RGDQR - AMTSSRLWFSLLLAAAFAGRATALWPWPQNFQTSDQRYV .
IO AR A R AR A A R R A R AN NN N R
RGAGRWAMAGCRLWVSLLLAAALACLATALWPWPQYIQTYHRRYT .

9 Show the alignment in color.

showalignment(LocalAlignment)
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Identities = 454/547 (83%), Positiwves = 514/547 (94%)

1

o4

65

125

129

192

193

256

247

320

354

354

445

345

51z

51z

RGDOR-AMTE3RLWFILLLALAF AGRATALWRWRONF QT3DORTVLYPNIF QF QVDWVIAS LLOP G

N e e R e R n A n R B AR AN .
RGAGRWAMAGCRLUVSLLLAALL ACLATALWPWFQYIQTYHRRYTLYPNNF OF RYHVSS LAQLG

CAVLDEAFORYRDLLFGAGEWPRP YL TGERHTLERIV LV SV TP GCNOLP TLESVENYTL T I

Forrrrrrsrrr=treerrrrrrr ===r==pr 0 rr=trrrrrt  prestst e rrrrn
CYWYLDEAFRRYRNLLF GEGEWPRPAF SNECOTLGEN ILVV AV TAECHEFPILESVEN Y TL TIIN

DDOCLLLEETVWGALRGLETF SOLVWESAEGTFF INKTE IEDFPRFPHRGLLLDTZREHYLEPLSS

Frrrer rerreerreerrerrrerrrerrrerrrrrr= st e e s e e
DDQCLLASETVWGALRGLETFSQLVWESAEGTFF INKTEIKDFFRFPHRGYLLD T3RHYLPLES

ILDTLDVMAYNELNYFHWHLVDDPSFPYESF TFPELNREGS VNPV THIVTLAODVEEVIEYLARLE

trrrerreerrrsrreerreerr crrerrrerrrr rrrrs e e e e e
ILDTLDVMAYHNEFNVFHWHLYDDSSFFYESF TFPELTREGSFNPVTHIYTAQDVKEVIETARLE

GIRVLAEFDTPGHTLAWGFGIPGLLTRCYAGEEPSGTF GPVHP LN TYEF NI TFFLEVSSVER

Frrrrrreerrrrrreerrr rreerrrrr s rrrrr e et ettt e
GIRVLAEFDTPGHTLAWGF GAPGLLTFCYAGEHLIGTF GPVIHPSALNS TYDFHSTLFLEISSVER

DFYLHLGGDEVDF TCWESNPE IQDFHREEGF GEDFEQLESF Y IQTLLD IV SYGEGTWVWITOEVE

trrrerreerreerreerrr=rr rr=eert rrrrrrr e e e e e e
DFYLHLGGDEVDF TCWESHPH IQAF MEEKGF - TDF EQLESF Y IQTLLD IVSDYDEGTVVWQEVF

DNEVEIQPDTIIOVWWRED TPV YMEELELVTELAGFRALLSAPWYLNR IS YGPDWEDF VWWEFPL A

RN R R N e R R R R A RN RN R A
DNEVEVEPDTIIOVWREENPVEYMLENOD ITRAGFRALL S APWYLNEVEVGPDWEDMYEVEFL L

FEGTPEQKALVIGGE ACMWGEYVDNTHLVPRLWPRAGAVAERLWANELTSDLTFATERLSHFRC

F=rrrrreerrrrr e et ettt e e et bezs fresi i
FHGTPEQEALVIGGE ACHWGE YV D S THLYVPRELWPRAGAV AERLWSSHNLTTH IDF AFERLSHF RC

ELLERGVQACPLINVGFCEQEFEQT* APGTEEGLAGT

Fr=rrt=trrt==tr trrrrrrrrr == =11
ELVERGIQAQP IZVGCCEQEFEQT*ATSAEHPGGC
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Viewing and Aligning Multiple Sequences

In this section...

“Overview of the Biological Sequence Alignment Window” on page 3-58
“Loading Sequence Data and Viewing the Phylogenetic Tree” on page 3-58
“Selecting a Subset of Data from the Phylogenetic Tree” on page 3-59
“Aligning Multiple Sequences” on page 3-61

“Adjusting Multiple Sequence Alignments Manually” on page 3-62

“Closing the Biological Sequence Alignment Window” on page 3-65

Overview of the Biological Sequence Alignment
Window

The Biological Sequence Alignment window is a graphical user interface
(GUI) that integrates many sequence and multiple alignment functions in the
toolbox. Instead of entering commands in the MATLAB Command Window,
you can use this interface to visually inspect a multiple alignment and make
manual adjustments.

Loading Sequence Data and Viewing the
Phylogenetic Tree

Load unaligned sequence data into the MATLAB environment and view it
in a phylogenetic tree.

1 Load sequence data.

load primatesdemodata

2 Create a phylogenetic tree.

tree = seqlinkage(seqpdist(primates), 'single', primates);

3 View the phylogenetic tree.

view(tree)

3-58




Viewing and Aligning Multiple Sequences

The MATLAB software creates a phytree object in the workspace and loads

the sequence data into the Phylogenetic Tree window.

Phylogenetic Tree 1

[ESMEENE)

File Tools Window

LR |4 £ D

Help E
T 2

————————0 ~German_keanderhal

L— & 4Russian_Neanderhal

L = HEurapean_Human

HChimp_Troglodytes

qChimp_Schweinfurthii

HChimp_Verus

Hchimp_Wellerosus

-Jari_Qrangutan

qtauntain_Gaorilla_Rwanda

HEastern_Lowland_Gaorilla

qWestern_Lowland_Garilla

—a
Y ——mn
0
]

l—n HPuti_Crangutan
S
L——0n
]

0.z 0.3 0.4

Selecting a Subset of Data from the Phylogenetic Tree

Select the human and chimp branches.

1 From the toolbar, click the Prune icon.
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Phylogenetic Tree 1

File Teools Window Help
% & @cé@k‘ﬁ

| Prune (delete) Leaf/Branch Mu:u:le|

2 Click the branches to prune (remove) from the tree. For this example, click
the branch nodes for gorillas, orangutans, and Neanderthals.

Phylogenetic Tree 1 =ARCE X

File Tools Window Help "

e '\-ﬁiﬂ-? @C&@a—_’

% HEuropean_Human
—— qChimp_Troglodytes
L—n HChimp_Schweinfurthii
7 L HChimp_Werus
o qchimp_Wellerosus

3 Export the selected branches to a second tree. Select File > Export to
Workspace, and then select Only Displayed.

4 In the Export to dialog box, enter the name of a variable. For example,
enter tree2, and then click OK.
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ru Export t..| = 2

Workspace variable name ?

tree2

[ox_| [cancel]

L -

5 Extract sequences from the tree object.

primates2 = primates(seqgmatch(get(tree2, 'Leafnames'),{primates.Header}));
Aligning Multiple Sequences
After selecting a set of related sequences, you can multiply align them and
view the results.
1 Align multiple sequences.

ma = multialign(primates2);
2 Load aligned sequences in the Biological Sequence Alignment window.

seqalignviewer(ma);

The aligned sequences appear in the Biological Sequence Alignment
window.
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-
4\ Biclogical Sequence Alignment - ma |ﬂ|
File Edit Display Window Help |?| x
- —
Aaa@EE G0 BODE 50
CONSENSUS CAACCG CTATGTATTTCGTSACATTACTGC
| | |
G0 70 &0
| ! I ! 1
European_Human C AACLCTELC CTAT TATTTTE TALCATTATLCT BN &
Chimp_Troglodytes cCaaccfiBlcTAaT TATTTCGETACATTATLCT|BC
Chimp_Schwreinfurthii C A ACLCEL CTAT TATTTEL TALCATTATLCT C
Chimp_¥erus C A ACLCEC T AT TACTTEC TACATTACLCT c
Chimp_¥ellerosus C A ACLCEC CTAT TATTTEC TACATTACLCT c
] P m ¢
1 55 g3 441
Y RO AL N I PN
1 | ] | 1 NN
5 sequences | European Human [Sea 1 Aln 1
LS -~

Adjusting Multiple Sequence Alignments Manually

Algorithms for aligning multiple sequences do not always produce an optimal
result. By visually inspecting the alignment, you can identify areas that could
use a manual adjustment to improve the alignment.

1 Identify an area where you could improve the alignment.
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-
4 Biclegical Sequence Alignment - ma ‘ ‘ M

File Edit Display Window Help |2 x

A A @ EE S0 EhENE

CONSENSUS TACAGT CAAMAAT CCATCCTCGCCCCCACGGEA
| | |
3z0 330 340

European_Human
Chimp_Troglodytes
Chimp_Schweinfurthii

Chimp_Yerus

Chimp_¥ellerosus

4 LA 1 L3

P

319 347 441

1'""Il|lﬂl|lll A LN O ..~

5 sequences | European Human [Sea 1 Aln 1
L G I

2 Click a letter to select it, and then move the cursor over the red direction
bar. The cursor changes to a hand.

European_Human
Chimp_Traglodytes
Chimp_Schweinfurthii
Chimp_¥erus

Chimp_¥ellerosus

1 3

3 Click and drag the sequence to the right to insert a gap. If there is a gap to
the left, you can also move the sequence to the left and eliminate the gap.
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European_Human
Chimp_Troglodytes
Chimp_Schweinfurthii
Chimp_¥Yerus

=4 4 4 4 4+
I I I I Is -
[ Y e Y o B B

L I I I Ix

=4 4 4 4 4+

[ Y B o B o B o B
F I I I Ix

I I I Ix

I I I Ix

0o 4 = > 0

= 4 4 - -+

=4 o o o

Chimp_¥ellerosus

4 2 4

Alternately, to insert a gap, select a character, and then click the Insert
Gap icon on the toolbar or press the spacebar.

4\ Biclogical Sequence Alignment - ma

File Edit Display Window Help

A A- A T%l% _é*a_a (7}

Insert Gap(s) (Space)

CONSENSUS T A CAGT CAMAALT CCATICC
Séﬂ Séﬂ

| | | |
European_Human T A LC A TCAAATLCLCCLCTTCLE
Chimp_Troglodytes T AL A TCAAATCLCATELECLIL
Chimp_Schweinfurthii T A C A TCAAATTCLCTLCATTELLIL
Chimp_Yerus T A C A TCAAALCTILCTTTELECTIE
Chimp_¥ellerosus T A C A T C A A Aﬂ CCATLCHIC
4 I 4

Note You cannot delete or add letters to a sequence, but you can add or
delete gaps. If all of the sequences at one alignment position have gaps,
you can delete that column of gaps.
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4 Continue adding gaps and moving sequences to improve the alignment.

COMSEMSUS T A CAGT A A A - TCC AT CC

3;0 Séﬂ
| | | |
European_Human T A C A TCAAA - TCLCLCTTCL
Chimp_Troglodytes TALCA TECAAA - TCCLCATTCLCLC
Chimp_Schweinfurthii T A LC A TCAAA - TLCLCATTETC
Chimp_¥erus T A C A TCAAALCTLC - TTCCLC
Chimp_¥ellerosus TALCRA TCAAA - TLCLCATTELC
4 I 4

Closing the Biological Sequence Alignment Window

Close the Biological Sequence Alignment window from the MATLAB
command line using the following syntax:

seqalignviewer('close')
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® “Managing Gene Expression Data in Objects” on page 4-2
® “Representing Expression Data Values in DataMatrix Objects” on page 4-5
® “Representing Expression Data Values in ExptData Objects” on page 4-11

® “Representing Sample and Feature Metadata in MetaData Objects” on
page 4-15

® “Representing Experiment Information in a MIAME Object” on page 4-22
¢ “Representing All Data in an ExpressionSet Object” on page 4-27

® “Visualizing Microarray Images” on page 4-33

® “Analyzing Gene Expression Profiles” on page 4-57

¢ “Detecting DNA Copy Number Alteration in Array-Based CGH Data” on
page 4-72

e “Exploring Gene Expression Data” on page 4-93
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Managing Gene Expression Data in Objects

Microarray gene expression experiments are complex, containing data and
information from various sources. The data and information from such an
experiment is typically subdivided into four categories:

e Measured expression data values

® Sample metadata

® Microarray feature metadata

® Descriptions of experiment methods and conditions

In MATLAB, you can represent all the previous data and information in an
ExpressionSet object, which typically contains the following objects:

® One ExptData object containing expression values from a microarray
experiment in one or more DataMatrix objects

® One MetaData object containing sample metadata in two dataset arrays

® One MetaData object containing feature metadata in two dataset arrays

® One MIAME object containing experiment descriptions

The following graphic illustrates a typical ExpressionSet object and its
component objects.
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Expressionset object

DataMatrix object DataMatrix object DataMatrix object

dataset array
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4-4

Each element (DataMatrix object) in the ExpressionSet object has an element
name. Also, there is always one DataMatrix object whose element name is
Expressions.

An ExpressionSet object lets you store, manage, and subset the data from a
microarray gene expression experiment. An ExpressionSet object includes
properties and methods that let you access, retrieve, and change data,
metadata, and other information about the microarray experiment. These
properties and methods are useful to view and analyze the data. For a list of
the properties and methods, see ExpressionSet class.

To learn more about constructing and using objects for microarray gene
expression data and information, see:

* “Representing Expression Data Values in DataMatrix Objects” on page 4-5
® “Representing Expression Data Values in ExptData Objects” on page 4-11

* “Representing Sample and Feature Metadata in MetaData Objects” on
page 4-15

® “Representing Experiment Information in a MIAME Object” on page 4-22
® “Representing All Data in an ExpressionSet Object” on page 4-27



Representing Expression Data Values in DataMatrix Objects

Representing Expression Data Values in DataMatrix

Obijects

In this section...

“Overview of DataMatrix Objects” on page 4-5
“Constructing DataMatrix Objects” on page 4-6
“Getting and Setting Properties of a DataMatrix Object” on page 4-7

“Accessing Data in DataMatrix Objects” on page 4-8

Overview of DataMatrix Objects

The toolbox includes functions, objects, and methods for creating, storing, and
accessing microarray data.

The object constructor function, DataMatrix, lets you create a DataMatrix
object to encapsulate data and metadata (row and column names) from a
microarray experiment. A DataMatrix object stores experimental data in a
matrix, with rows typically corresponding to gene names or probe identifiers,
and columns typically corresponding to sample identifiers. A DataMatrix
object also stores metadata, including the gene names or probe identifiers (as
the row names) and sample identifiers (as the column names).

You can reference microarray expression values in a DataMatrix object the
same way you reference data in a MATLAB array, that is, by using linear or
logical indexing. Alternately, you can reference this experimental data by
gene (probe) identifiers and sample identifiers. Indexing by these identifiers
lets you quickly and conveniently access subsets of the data without having
to maintain additional index arrays.

Many MATLAB operators and arithmetic functions are available to
DataMatrix objects by means of methods. These methods let you modify,
combine, compare, analyze, plot, and access information from DataMatrix
objects. Additionally, you can easily extend the functionality by using
general element-wise functions, dmarrayfun and dmbsxfun, and by manually
accessing the properties of a DataMatrix object.
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Note For tables describing the properties and methods of a DataMatrix
object, see the DataMatrix object reference page.

Constructing DataMatrix Objects

1 Load the MAT-file, provided with the Bioinformatics Toolbox software, that

contains yeast data. This MAT-file includes three variables: yeastvalues,
a 614-by-7 matrix of gene expression data, genes, a cell array of 614
GenBank accession numbers for labeling the rows in yeastvalues,

and times, a 1-by-7 vector of time values for labeling the columns in
yeastvalues.

load filteredyeastdata

Create variables to contain a subset of the data, specifically the first five
rows and first four columns of the yeastvalues matrix, the genes cell
array, and the times vector.

yeastvalues = yeastvalues(1:5,1:4);
genes = genes(1:5,:);
times times(1:4);

Import the microarray object package so that the DataMatrix constructor
function will be available.

import bioma.data.*

Use the DataMatrix constructor function to create a small DataMatrix
object from the gene expression data in the variables you created in step 2.

dmo = DataMatrix(yeastvalues,genes,times)
dmo =
0 9.5 11.5 13.5
SS DNA -0.131 1.699 -0.026 0.365
YALOO3W 0.305 0.146 -0.129 -0.444
YALO12W 0.157 0.175 0.467 -0.379
YALO26C 0.246 0.796 0.384 0.981
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YAL034C

-0.235

0.487 -0.184 -0.669

Getting and Setting Properties of a DataMatrix

Obiject

You use the get and set methods to retrieve and set properties of a

DataMatrix object.

1 Use the get method to display the properties of the DataMatrix object, dmo.

get(dmo)
Name:

RowNames:
ColNames:
NRows :

NCols:

NDims:
ElementClass:

{5x1 cell}
{ o
5
4
2
"double’

9.5' '11.5' '13.5'}

2 Use the set method to specify a name for the DataMatrix object, dmo.

dmo =

set(dmo, 'Name', 'MyDMObject');

3 Use the get method again to display the properties of the DataMatrix

object, dmo.
get(dmo)

Name:
RowNames:
ColNames:
NRows :
NCols:
NDims:
ElementClass:

'"MyDMObject
{5x1 cell}
{" o '
5
4
2
"double’

9.5' '11.5' '13.5'}

Note For a description of all properties of a DataMatrix object, see the
DataMatrix object reference page.
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Accessing Data in DataMatrix Objects

DataMatrix objects support the following types of indexing to extract, assign,
and delete data:
® Parenthesis () indexing

® Dot . indexing

Parentheses () Indexing

Use parenthesis indexing to extract a subset of the data in dmo and assign
it to a new DataMatrix object dmo2:

dmo2 = dmo(1:5,2:3)
dmo2 =
9.5 11.5

SS DNA 1.699 -0.026
YALOO3W 0.146 -0.129
YALO12W 0.175 0.467
YAL026C 0.796 0.384
YALO034C 0.487 -0.184

Use parenthesis indexing to extract a subset of the data using row names and
column names, and assign it to a new DataMatrix object dmo3:

dmo3 = dmo({'SS DNA', 'YALO12W','YALO34C'},'11.5")
dmo3 =
11.5
SS DNA -0.026
YALO12W 0.467
YAL034C -0.184

Note If you use a cell array of row names or column names to index into a
DataMatrix object, the names must be unique, even though the row names or
column names within the DataMatrix object are not unique.
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Use parenthesis indexing to assign new data to a subset of the elements in
dmo2:

dmo2({'SS DNA', 'YALOO3W'}, 1:2) = [1.700 -0.030; 0.150 -0.130]
dmo2 =

9.5 11.5
SS DNA 1.7 -0.03
YALOO3W 0.15 -0.13
YALO12W 0.175 0.467
YALO26C 0.796 0.384
YAL034C 0.487 -0.184

Use parenthesis indexing to delete a subset of the data in dmo2:

dmo2({'SS DNA', 'YALOO3W'}, :) = []

dmo2 =
9.5 11.5
YALO12W 0.175 0.467
YAL026C 0.796 0.384
YAL034C 0.487 -0.184

Dot . Indexing

Note In the following examples, notice that when using dot indexing with
DataMatrix objects, you specify all rows or all columns using a colon within
single quotation marks, (':"').

Use dot indexing to extract the data from the 11.5 column only of dmo:

timevValues = dmo.(':"')('11.5")
timeValues

-0.0260
-0.1290
0.4670
0.3840
-0.1840
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Use dot indexing to assign new data to a subset of the elements in dmo:

dmo. (1:2)(':") =7

dmo =
0 9.5 11.5 13.5
SS DNA 7 7 7 7
YALOO3W 7 7 7 7
YALO12W 0.157 0.175 0.467 -0.379
YALO26C 0.246 0.796 0.384 0.981
YALO034C -0.235 0.487 -0.184 -0.669

Use dot indexing to delete an entire variable from dmo:

dmo.YALO34C = []

dmo =
0 9.5 11.5 13.5
SS DNA 7 7 7 7
YALOO3W 7 7 7 7
YALO12W 0.157 0.175 0.467 -0.379
YALO26C 0.246 0.796 0.384 0.981

Use dot indexing to delete two columns from dmo:

dmo. (':")(2:3)=[1]

dmo =
0 13.5
SS DNA 7 7
YALOO3W 7 7
YALO12W 0.157 -0.379
YALO26C 0.246 0.981
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Representing Expression Data Values in ExptData Objects

In this section...

“Overview of ExptData Objects” on page 4-11
“Constructing ExptData Objects” on page 4-12

“Using Properties of an ExptData Object” on page 4-12
“Using Methods of an ExptData Object” on page 4-13

“References” on page 4-14

Overview of ExptData Objects

You can use an ExptData object to store expression values from a microarray
experiment. An ExprData object stores the data values in one or more
DataMatrix objects, each having the same row names (feature names) and
column names (sample names). Each element (DataMatrix object) in the
ExptData object has an element name.

The following illustrates a small DataMatrix object containing expression
values from three samples (columns) and seven features (rows):

A B C
100001_at 2.26 20.14 31.66
100002_at 158.86 236.25 206.27
100003_at 68.11 105.45 82.92
100004_at 74.32 96.68 84.87
100005_at 75.05 53.17 57.94
100006_at 80.36 42.89 77.21

100007_at 216.64 191.32 219.48

An ExptData object lets you store, manage, and subset the data values from a
microarray experiment. An ExptData object includes properties and methods
that let you access, retrieve, and change data values from a microarray
experiment. These properties and methods are useful to view and analyze the
data. For a list of the properties and methods, see ExptData class.
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Constructing ExptData Objects

The mouseExprsData.txt file used in this example contains data from
Hovatta et al., 2005.

1 Import the bioma.data package so that the DataMatrix and ExptData
constructor functions are available.

import bioma.data.*

2 Use the DataMatrix constructor function to create a DataMatrix object
from the gene expression data in the mouseExprsData. txt file. This
file contains a table of expression values and metadata (sample and
feature names) from a microarray experiment done using the Affymetrix
MGU74Av2 GeneChip array. There are 26 sample names (A through 2),
and 500 feature names (probe set names).

dmObj = DataMatrix('File', 'mouseExprsData.txt');

3 Use the ExptData constructor function to create an ExptData object from
the DataMatrix object.

EDObj = ExptData(dmObj);
4 Display information about the ExptData object, EDObj.

EDOD j

Experiment Data:
500 features, 26 samples
1 elements
Element names: Elmt1

Note For complete information on constructing ExptData objects, see
ExptData class.

Using Properties of an ExptData Object

To access properties of an ExptData object, use the following syntax:

objectname .propertyname



Representing Expression Data Values in ExptData Objects

For example, to determine the number of elements (DataMatrix objects) in
an ExptData object:

EDObj.NElements
ans =
1
To set properties of an ExptData object, use the following syntax:
objectname.propertyname = propertyvalue
For example, to set the Name property of an ExptData object:

EDObj.Name = 'MyExptDataObject’

Note Property names are case sensitive. For a list and description of all
properties of an ExptData object, see ExptData class.

Using Methods of an ExptData Object

To use methods of an ExptData object, use either of the following syntaxes:

objectname .methodname
or
methodname (objectname)
For example, to retrieve the sample names from an ExptData object:
EDObj .sampleNames
Columns 1 through 9
‘A 'B' 'C! ‘D' 'E' 'F! 'G' 'H' 'T!
To return the size of an ExptData object:

size (EDObj)
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ans =

500 26

Note For a complete list of methods of an ExptData object, see ExptData
class.

References

[1] Hovatta, I., Tennant, R S., Helton, R., et al. (2005). Glyoxalase 1 and
glutathione reductase 1 regulate anxiety in mice. Nature 438, 662—666.
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Representing Sample and Feature Metadata in MetaData

Obijects

In this section...

“Overview of MetaData Objects” on page 4-15
“Constructing MetaData Objects” on page 4-16
“Using Properties of a MetaData Object” on page 4-19
“Using Methods of a MetaData Object” on page 4-20

Overview of MetaData Objects

You can store either sample or feature metadata from a microarray gene
expression experiment in a MetaData object. The metadata consists of
variable names, for example, related to either samples or microarray features,
along with descriptions and values for the variables.

A MetaData object stores the metadata in two dataset arrays:

¢ Values dataset array — A dataset array containing the measured value
of each variable per sample or feature. In this dataset array, the columns
correspond to variables and rows correspond to either samples or features.
The number and names of the columns in this dataset array must match
the number and names of the rows in the Descriptions dataset array. If
this dataset array contains sample metadata, then the number and names
of the rows (samples) must match the number and names of the columns
in the DataMatrix objects in the same ExpressionSet object. If this
dataset array contains feature metadata, then the number and names of
the rows (features) must match the number and names of the rows in the
DataMatrix objects in the same ExpressionSet object.

¢ Descriptions dataset array — A dataset array containing a list of the
variable names and their descriptions. In this dataset array, each row
corresponds to a variable. The row names are the variable names, and
a column, named VariableDescription, contains a description of the
variable. The number and names of the rows in the Descriptions dataset
array must match the number and names of the columns in the Values
dataset array.
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The following illustrates a dataset array containing the measured value of
each variable per sample or feature:

Gender Age Type Strain Source
A ‘Male'’ 8 ‘Wild type' '129S6/SvEvTac' "amygdala’
B ‘Male' 8 ‘Wild type' '129S6/SvEvTac' 'amygdala’
C ‘Male’ 8 ‘Wild type' '129S6/SvEvTac' "amygdala’
D ‘Male' 8 ‘Wild type' "‘Ald ! "amygdala’
E ‘Male' 8 ‘Wild type' "‘A/d ! 'amygdala’
F ‘Male' 8 ‘Wild type' 'C57BL/6J 'amygdala’

The following illustrates a dataset array containing a list of the variable
names and their descriptions:

VariableDescription
id ‘Sample identifier'
Gender 'Gender of the mouse in study'
Age 'The number of weeks since mouse birth'
Type 'Genetic characters'
Strain 'The mouse strain'
Source 'The tissue source for RNA collection'

A MetaData object lets you store, manage, and subset the metadata from a
microarray experiment. A MetaData object includes properties and methods
that let you access, retrieve, and change metadata from a microarray
experiment. These properties and methods are useful to view and analyze the
metadata. For a list of the properties and methods, see MetaData class

Constructing MetaData Objects

Constructing a MetaData Object from Two dataset Arrays

1 Import the bioma.data package so that the MetaData constructor function
is available.

import bioma.data.*

2 Load some sample data, which includes Fisher’s iris data of 5 measurements
on a sample of 150 irises.
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load fisheriris

3 Create a dataset array from some of Fisher’s iris data. The dataset
array will contain 750 measured values, one for each of 150 samples (iris
replicates) at five variables (species, SL, SW, PL, PW). In this dataset array,
the rows correspond to samples, and the columns correspond to variables.

irisValues = dataset({nominal(species), 'species'},
{meas, 'SL', 'SW', 'PL', 'PW'});

4 Create another dataset array containing a list of the variable names
and their descriptions. This dataset array will contain five rows, each
corresponding to the five variables: species, SL, SW, PL, and PW. The
first column will contain the variable name. The second column will have
a column header of VariableDescription and contain a description of
the variable.

% Create 5-by-1 cell array of description text for the variables
varDesc = {'Iris species', 'Sepal Length', 'Sepal Width',
'Petal Length', 'Petal Width'}';
% Create the dataset array from the variable descriptions
irisVarDesc = dataset(varDesc,
'ObsNames', {'species','SL','SW','PL','PW'},
'VarNames', {'VariableDescription'})

irisVarDesc =
VariableDescription
species '"Iris species'
SL 'Sepal Length'
Sw 'Sepal Width'
PL 'Petal Length'
PW 'Petal Width'

5 Create a MetaData object from the two dataset arrays.

MDObj1 = MetaData(irisValues, irisVarDesc);
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Constructing a MetaData Object from a Text File

1 Import the bioma.datapackage so that the MetaData constructor function
1s available.

import bioma.data.*

2 View the mouseSampleData.txt file included with the Bioinformatics
Toolbox software.

Note that this text file contains two tables. One table contains 130
measured values, one for each of 26 samples (A through Z) at five variables
(Gender, Age, Type, Strain, and Source). In this table, the rows correspond
to samples, and the columns correspond to variables. The second table has
lines prefaced by the # symbol. It contains five rows, each corresponding to
the five variables: Gender, Age, Type, Strain, and Source. The first column
contains the variable name. The second column has a column header of
VariableDescription and contains a description of the variable.

id: Sample identifier

Gender: Gender of the mouse in study

Age: The number of weeks since mouse birth
Type: Genetic characters

Strain: The mouse strain

Source: The tissue source for RNA collection
D Gender Age Type Strain Source

Male 8 Wild type 129S6/SvEvTac amygdala

Male 8 Wild type 129S6/SvEvTac amygdala

Male 8 Wild type 129S6/SvEvTac amygdala

Male 8 Wild type A/J amygdala

Male 8 Wild type A/J amygdala

Male 8 Wild type C57BL/6J amygdala

Male 8 Wild type C57BL/6J amygdala

Male Wild type 129S6/SvEvTac cingulate cortex
Male Wild type 129S6/SvEvTac cingulate cortex
Male 8 Wild type A/J cingulate cortex

Male 8 Wild type A/J cingulate cortex

Male 8 Wild type A/J cingulate cortex

Male Wild type C57BL/6J cingulate cortex
Male Wild type C57BL/6J cingulate cortex

ZErrXCHIOQTMMOO W > H I 3 3 Ik F
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Male
Male
Male
Male
Male
Male
Male
Male
Male
Male
Male
Male

N<X=<CHw@>ImO VO
0 O 0 00 00 00 0 0 0 0

Wwild
Wild
Wwild
Wild
Wild
Wild
Wild
Wild
Wwild
Wwild
Wwild
Wwild

type
type
type
type
type
type
type
type
type
type
type
type

129S6/SvEvTac hippocampus
129S6/SvEvTac hippocampus
A/J hippocampus

A/J hippocampus

C57BL/6J hippocampus
C57BL/6J4 hippocampus
129S6/SvEvTac hypothalamus
129S6/SvEvTac hypothalamus
A/J hypothalamus

A/J hypothalamus

C57BL/6J hypothalamus
C57BL/6J hypothalamus

3 Create a MetaData object from the metadata in the mouseSampleData. txt

file.

MDObj2 = MetaData('File', 'mouseSampleData.txt', 'VarDescChar', '#')

Sample Names:

A, B, ...

,Z (26 total)

Variable Names and Meta Information:

Gender
Age
Type
Strain
Source

VariableDescription

' Gender of the mouse in study'

' The number of weeks since mouse birth'

' Genetic characters'

' The mouse strain'

' The tissue source for RNA collection'

For complete information on constructing MetaData objects, see MetaData

class.

Using Properties of a MetaData Object

To access properties of a MetaData object, use the following syntax:

objectname .propertyname

For example, to determine the number of variables in a MetaData object:

MDObj2.NVariables
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ans =
5
To set properties of a MetaData object, use the following syntax:
objectname .propertyname = propertyvalue
For example, to set the Description property of a MetaData object:

MDObj1.Description = 'This is my MetaData object for my sample metadata'

Note Property names are case sensitive. For a list and description of all
properties of a MetaData object, see MetaData class.

Using Methods of a MetaData Object

To use methods of a MetaData object, use either of the following syntaxes:
objectname .methodname

or

methodname (objectname)

For example, to access the dataset array in a MetaData object that contains
the variable values:

MDObj2.variableValues;

To access the dataset array of a MetaData object that contains the variable

descriptions:
variableDesc (MDObj2)
ans =
VariableDescription
Gender ' Gender of the mouse in study'
Age " The number of weeks since mouse birth'
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Type ' Genetic characters'
Strain " The mouse strain'
Source ' The tissue source for RNA collection'

Note For a complete list of methods of a MetaData object, see MetaData
class.
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Representing Experiment Information in a MIAME Obiject

In this section...

“Overview of MIAME Objects” on page 4-22
“Constructing MIAME Objects” on page 4-22
“Using Properties of a MIAME Object” on page 4-25
“Using Methods of a MIAME Object” on page 4-25

Overview of MIAME Obijects

You can store information about experimental methods and conditions from
a microarray gene expression experiment in a MIAME object. It loosely
follows the Minimum Information About a Microarray Experiment (MIAME)
specification. It can include information about:

¢ Experiment design

® Microarrays used

®* Samples used

e Sample preparation and labeling

e Hybridization procedures and parameters

® Normalization controls

¢ Preprocessing information

e Data processing specifications

A MIAME object includes properties and methods that let you access, retrieve,
and change experiment information related to a microarray experiment.

These properties and methods are useful to view and analyze the information.
For a list of the properties and methods, see MIAME class.

Constructing MIAME Objects

For complete information on constructing MIAME objects, see MIAME class.

4-22




Representing Experiment Information in a MIAME Obiject

Constructing a MIAME Object from a GEO Structure

1 Import the bioma.data package so that the MIAME constructor function
1s available.

import bioma.data.*

2 Use the getgeodata function to return a MATLAB structure containing
Gene Expression Omnibus (GEO) Series data related to accession number
GSE4616.

geoStruct = getgeodata('GSE4616"')

geoStruct

Header: [1x1 struct]
Data: [12488x12 bioma.data.DataMatrix]

3 Use the MIAME constructor function to create a MIAME object from the
structure.

MIAMEObj1 = MIAME(geoStruct);

4 Display information about the MIAME object, MIAMEODbj.

MIAMEOb] 1
MIAMEObj1 =

Experiment Description:
Author name: Mika,,Silvennoinen
Riikka,,Kivel"/
Maarit,,Lehti
Anna-Maria,,Touvras
Jyrki, ,Komulainen
Veikko, ,Vihko
Heikki, ,Kainulainen
Laboratory: LIKES - Research Center
Contact information: Mika,,Silvennoinen
URL:
PubMedIDs: 17003243
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Abstract: A 90 word abstract is available. Use the Abstract property.
Experiment Design: A 234 word summary is available. Use the ExptDesign property.
Other notes:

[1x80 char]

Constructing a MIAME Object from Properties

1 Import the bioma.data package so that theMIAME constructor function
is available.

import bioma.data.*

2 Use the MIAME constructor function to create a MIAME object using
individual properties.

MIAMEObj2 = MIAME('investigator', 'Jane Researcher',...
‘lab', 'One Bioinformatics Laboratory',...
‘contact', 'jresearcher@lab.not.exist',...

‘url', 'www.lab.not.exist',...
'title', 'Normal vs. Diseased Experiment',...
'abstract', 'Example of using expression data',...

'other', {'Notes:Created from a text file.'});

3 Display information about the MIAME object, MIAMEObj 2.

MIAMEObj2
MIAMEObj2 =

Experiment Description:
Author name: Jane Researcher
Laboratory: One Bioinformatics Laboratory
Contact information: jresearcher@lab.not.exist
URL: www.lab.not.exist
PubMedIDs:
Abstract: A 4 word abstract is available. Use the Abstract property.
No experiment design summary available.
Other notes:
'Notes:Created from a text file.'
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Using Properties of a MIAME Object

To access properties of a MIAME object, use the following syntax:

objectname .propertyname

For example, to retrieve the PubMed identifier of publications related to a
MIAME object:

MIAMEObj1.PubMedID

ans =

17003243

To set properties of a MIAME object, use the following syntax:
objectname .propertyname = propertyvalue

For example, to set the Laboratory property of a MIAME object:

MIAMEObj1.Laboratory = 'XYZ Lab'

Note Property names are case sensitive. For a list and description of all
properties of a MIAME object, see MIAME class.

Using Methods of a MIAME Obiject

To use methods of a MIAME object, use either of the following syntaxes:
objectname .methodname

or

methodname (objectname)

For example, to determine if a MIAME object is empty:

MIAMEObj1.isempty

ans =
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Note For a complete list of methods of a MIAME object, see MIAME class.
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Representing All Data in an ExpressionSet Object

In this section...

“Overview of ExpressionSet Objects” on page 4-27
“Constructing ExpressionSet Objects” on page 4-29
“Using Properties of an ExpressionSet Object” on page 4-30

“Using Methods of an ExpressionSet Object” on page 4-30

Overview of ExpressionSet Objects

You can store all microarray experiment data and information in one object
by assembling the following into an ExpressionSet object:

* One ExptData object containing expression values from a microarray
experiment in one or more DataMatrix objects

® One MetaData object containing sample metadata in two dataset arrays

® One MetaData object containing feature metadata in two dataset arrays

® One MIAME object containing experiment descriptions

The following graphic illustrates a typical ExpressionSet object and its
component objects.
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Each element (DataMatrix object) in the ExpressionSet object has an element
name. Also, there is always one DataMatrix object whose element name is
Expressions.

An ExpressionSet object lets you store, manage, and subset the data from a
microarray gene expression experiment. An ExpressionSet object includes
properties and methods that let you access, retrieve, and change data,
metadata, and other information about the microarray experiment. These
properties and methods are useful to view and analyze the data. For a list of
the properties and methods, see ExpressionSet class.

Constructing ExpressionSet Objects

Note The following procedure assumes you have executed the example code
in the previous sections:
® “Representing Expression Data Values in ExptData Objects” on page 4-11

® “Representing Sample and Feature Metadata in MetaData Objects” on
page 4-15

® “Representing Experiment Information in a MIAME Object” on page 4-22

1 Import the bioma package so that the ExpresssionSet constructor function
is available.

import bioma.*

2 Construct an ExpressionSet object from EDObj, an ExptData object, MDObj2,
a MetaData object containing sample variable information, and MIAMEObj,
a MIAME object.

ESObj = ExpressionSet(EDObj, 'SData', MDObj2, 'EInfo', MIAMEObj1);

3 Display information about the ExpressionSet object, ESObj.

ESODbj
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ExpressionSet
Experiment Data: 500 features, 26 samples
Element names: Expressions
Sample Data:
Sample names: A, B, ...,Z (26 total)
Sample variable names and meta information:
Gender: Gender of the mouse in study
Age: The number of weeks since mouse birth
Type: Genetic characters
Strain: The mouse strain
Source: The tissue source for RNA collection
Feature Data: none
Experiment Information: use 'exptInfo(obj)'

For complete information on constructing ExpressionSet objects, see
ExpressionSet class.

Using Properties of an ExpressionSet Object
To access properties of an ExpressionSet object, use the following syntax:

objectname .propertyname

For example, to determine the number of samples in an ExpressionSet object:
ESObj.NSamples
ans =

26

Note Property names are case sensitive. For a list and description of all
properties of an ExpressionSet object, see ExpressionSet class.

Using Methods of an ExpressionSet Object

To use methods of an ExpressionSet object, use either of the following
syntaxes:
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objectname .methodname

or

methodname (objectname)

For example, to retrieve the sample variable names from an ExpressionSet
object:

ESObj.sampleVarNames
ans =
'Gender' "Age’ "Type' 'Strain' 'Source'’

To retrieve the experiment information contained in an ExpressionSet object:

exptInfo(ESObj)
ans =

Experiment description
Author name: Mika,,Silvennoinen
Riikka,,Kivel"/
Maarit,,Lehti
Anna-Maria,,Touvras
Jyrki,,Komulainen
Veikko, ,Vihko
Heikki, ,Kainulainen
Laboratory: XYZ Lab
Contact information: Mika,,Silvennoinen
URL:
PubMedIDs: 17003243
Abstract: A 90 word abstract is available Use the Abstract property.
Experiment Design: A 234 word summary is available Use the ExptDesign property.
Other notes:
[1x80 char]
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Note For a complete list of methods of an ExpressionSet object, see
ExpressionSet class.
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Visualizing Microarray Images

In this section...

“Overview of the Mouse Example” on page 4-33
“Exploring the Microarray Data Set” on page 4-34
“Spatial Images of Microarray Data” on page 4-36
“Statistics of the Microarrays” on page 4-46

“Scatter Plots of Microarray Data” on page 4-48

Overview of the Mouse Example

This example looks at the various ways to visualize microarray data. The
data comes from a pharmacological model of Parkinson’s disease (PD) using
a mouse brain. The microarray data for this example is from Brown, V.M.,
Ossadtchi, A., Khan, A.H., Yee, S., Lacan, G., Melega, W.P., Cherry, S.R.,
Leahy, R.M., and Smith, D.J.; "Multiplex three dimensional brain gene
expression mapping in a mouse model of Parkinson’s disease"; Genome
Research 12(6): 868-884 (2002).

The microarray data used in this example is available in a Web supplement
to the paper by Brown et al. and in the file mouse_aipd.gpr included with
the Bioinformatics Toolbox software.

http://labs.pharmacology.ucla.edu/smithlab/genome_multiplex/

The microarray data is also available on the Gene Expression Omnibus Web
site at

http://www.ncbi.nlm.nih.gov/geo/query/acc.cgi?acc=GSE30

The GenePix GPR-formatted file mouse_aipd.gpr contains the data for one
of the microarrays used in the study. This is data from voxel Al of the brain
of a mouse in which a pharmacological model of Parkinson’s disease (PD)
was induced using methamphetamine. The voxel sample was labeled with
Cy3 (green) and the control, RNA from a total (not voxelated) normal mouse
brain, was labeled with Cy5 (red). GPR formatted files provide a large amount
of information about the array, including the mean, median, and standard
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deviation of the foreground and background intensities of each spot at the
635 nm wavelength (the red, Cy5 channel) and the 532 nm wavelength (the

green, Cy3 channel).

Exploring the Microarray Data Set

This procedure illustrates how to import data from the Web into the MATLAB
environment, using data from a study about gene expression in mouse brains
as an example. See “Overview of the Mouse Example” on page 4-33.

1 Read data from a file into a MATLAB structure. For example, in the
MATLAB Command Window, type

pd = gprread('mouse_aipd.gpr')

Information about the structure displays in the MATLAB Command

Window:

pd =

Header:
Data:
Blocks:
Columns:
Rows:

Names:

IDs:
ColumnNames:
Indices:
Shape:

[1x1 struct]
[9504x38 double]

[9504x1
[9504x1
[9504x1
{9504x1
{9504x1

double]
double]
double]
cell}
cell}

{38x1 cell}
[132x72 double]
[1x1 struct]

2 Access the fields of a structure using StructureName.FieldName. For
example, you can access the field ColumnNames of the structure pd by typing

pd.ColumnNames

The column names are shown below.

ans =
N
y
'Dia.’
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'F635 Median'
'F635 Mean'

'F635 SD'

'B635 Median'
'B635 Mean'

'B635 SD'

'% > B635+1SD'

'% > B635+2SD'
'F635 % Sat.'
'F532 Median'
'F532 Mean'

'F532 SD'

'B532 Median'
'B532 Mean'

'B532 SD'

'% > B532+1SD'

'% > B532+2SD'
'F532 % Sat.'
'Ratio of Medians'
'Ratio of Means'
'‘Median of Ratios'
'Mean of Ratios'
'Ratios SD'

'Rgn Ratio’

'Rgn Rt'

'F Pixels'

'B Pixels'

'Sum of Medians'
'Sum of Means'
'Log Ratio'

'F635 Median - B635'
'F532 Median - B532'
'F635 Mean - B635'
'F532 Mean - B532'
'Flags'

3 Access the names of the genes. For example, to list the first 20 gene names,
type

pd.Names (1:20)
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A list of the first 20 gene names is displayed:

ans =

'AA467053 "
'AA388323"
' AA387625'
'AA4T4342"
‘Myotb'
'AA473123"
' AA387579"
'AA387314 "
'AA467571"
Spop'
'AA547022"
'AI508784 "
'AA413555"
'AA414733"
'Sntat’
'AI414419"
'W14393"
'W10596

Spatial Images of Microarray Data

This procedure illustrates how to visualize microarray data by plotting image
maps. The function maimage can take a microarray data structure and create
a pseudocolor image of the data arranged in the same order as the spots on
the array. In other words, maimage plots a spatial plot of the microarray.

This procedure uses data from a study of gene expression in mouse brains.
For a list of field names in the MATLAB structure pd, see “Exploring the
Microarray Data Set” on page 4-34.

1 Plot the median values for the red channel. For example, to plot data from
the field F635 Median, type

figure
maimage (pd, 'F635 Median')
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The MATLAB software plots an image showing the median pixel values for
the foreground of the red (Cy5) channel.

FE35 Median « 107

2 Plot the median values for the green channel. For example, to plot data
from the field F532 Median, type

figure
maimage (pd, 'F532 Median')
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The MATLAB software plots an image showing the median pixel values of
the foreground of the green (Cy3) channel.

F532 Median w107

0.5

3 Plot the median values for the red background. The field B635 Median
shows the median values for the background of the red channel.

figure
maimage (pd, 'B635 Median')
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The MATLAB software plots an image for the background of the red
channel. Notice the very high background levels down the right side of
the array.

BE35 tedian

24500

- 2000

- 1500

1000

500

4 Plot the medial values for the green background. The field B532 Median
shows the median values for the background of the green channel.

figure
maimage (pd, 'B532 Median')
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The MATLAB software plots an image for the background of the green
channel.

B532 Median

400

350

- q300

- 250

200

1450

5 The first array was for the Parkinson’s disease model mouse. Now read in
the data for the same brain voxel but for the untreated control mouse. In
this case, the voxel sample was labeled with Cy3 and the control, total
brain (not voxelated), was labeled with Cy5.

wt = gprread('mouse_aiwt.gpr')

The MATLAB software creates a structure and displays information about
the structure.
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wt

Header: [1x1 struct]
Data: [9504x38 double]

Blocks: [9504x1
Columns: [9504x1
Rows: [9504x1
Names: {9504x1
IDs: {9504x1

double]
double]
double]
cell}
cell}

ColumnNames: {38x1 cell}

Indices: [132x72

double]

Shape: [1x1 struct]

6 Use the function maimage to show pseudocolor images of the foreground
and background. You can use the function subplot to put all the plots

onto one figure.

figure

subplot(2,2,1);
maimage (wt, 'F635 Median')
subplot(2,2,2);
maimage (wt, 'F532 Median')
subplot(2,2,3);
maimage (wt, 'B635 Median')
subplot(2,2,4);
maimage (wt, 'B532 Median')
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The MATLAB software plots the images.

FE35 Median ik F532 Median

— b W = Mmoo &

BE35 Median B532 Median
10000 i

8000

G000
1500

4000
2000

7 If you look at the scale for the background images, you will notice that the
background levels are much higher than those for the PD mouse and there
appears to be something nonrandom affecting the background of the Cy3
channel of this slide. Changing the colormap can sometimes provide more
insight into what is going on in pseudocolor plots. For more control over the
color, try the colormapeditor function.

colormap hot
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The MATLAB software plots the images.

FB35 Median ot Fa32 Median

BE35 Median B532 Median
10000 ;

8000
BO00
4000
2000

8 The function maimage is a simple way to quickly create pseudocolor images
of microarray data. However if you want more control over plotting, it is
easy to create your own plots using the function imagesc.

First find the column number for the field of interest.

b532MedCol = find(strcmp(wt.ColumnNames, 'B532 Median'))

The MATLAB software displays:

b532MedCol =
16

9 Extract that column from the field Data.

b532Data = wt.Data(:,b532MedCol);
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10 Use the field Indices to index into the Data.

figure

subplot(1,2,1);
imagesc(b532Data(wt.Indices))
axis image

colorbar

title('B532 Median')

The MATLAB software plots the image.

B532 Median

20

40 2000

]
1500

80

1000
100

120 500
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11 Bound the intensities of the background plot to give more contrast in the
image.

maskedData = b532Data;
maskedData(b532Data<500) = 500;
maskedData(b532Data>2000) = 2000;

subplot(1,2,2);
imagesc(maskedData(wt.Indices))
axis image

colorbar

title('Enhanced B532 Median')

The MATLAB software plots the images.

Enhanced B532 Median
z _

1800
20

1600
40

1400
B0

1200
Gl

1000 1000

100 100

120 500 120}
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Statistics of the Microarrays

This procedure illustrates how to visualize distributions in microarray data.
You can use the function maboxplot to look at the distribution of data in
each of the blocks.

1 In the MATLAB Command Window, type

figure

subplot(2,1,1)

maboxplot(pd, 'F532 Median', 'title', 'Parkinson''s Disease Model Mouse')
subplot(2,1,2)

maboxplot(pd, 'B532 Median', 'title', 'Parkinson''s Disease Model Mouse')
figure

subplot(2,1,1)

maboxplot (wt, 'F532 Median', 'title', 'Untreated Mouse')

subplot(2,1,2)

maboxplot (wt, 'B532 Median', 'title', 'Untreated Mouse')

The MATLAB software plots the images.



Visualizing Microarray Images

B532 Median
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2 Compare the plots.

From the box plots you can clearly see the spatial effects in the background
intensities. Blocks numbers 1, 3, 5, and 7 are on the left side of the
arrays, and numbers 2, 4, 6, and 8 are on the right side. The data must be
normalized to remove this spatial bias.

Scatter Plots of Microarray Data

This procedure illustrates how to visualize expression levels in microarray
data. There are two columns in the microarray data structure labeled 'F635
Median - B635' and 'F532 Median - B532'. These columns are the
differences between the median foreground and the median background for
the 635 nm channel and 532 nm channel respectively. These give a measure of
the actual expression levels, although since the data must first be normalized
to remove spatial bias in the background, you should be careful about using
these values without further normalization. However, in this example no
normalization is performed.
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1 Rather than working with data in a larger structure, it is often easier to
extract the column numbers and data into separate variables.

cy5DataCol = find(strcmp(wt.ColumnNames, 'F635 Median - B635'))
cy3DataCol = find(strcmp(wt.ColumnNames, 'F532 Median - B532'))
cy5Data = pd.Data(:,cy5DataCol);
cy3Data = pd.Data(:,cy3DataCol);

The MATLAB software displays:

cy5DataCol
34

cy3DataCol
35

2 A simple way to compare the two channels is with a loglog plot. The
function maloglog is used to do this. Points that are above the diagonal in
this plot correspond to genes that have higher expression levels in the Al
voxel than in the brain as a whole.

figure

maloglog(cy5Data,cy3Data)

xlabel('F635 Median - B635 (Control)');
ylabel('F532 Median - B532 (Voxel Al1)');

The MATLAB software displays the following messages and plots the
images.

Warning: Zero values are ignored

(Type "warning off Bioinfo:MaloglogZeroValues" to suppress
this warning.)

Warning: Negative values are ignored.

(Type "warning off Bioinfo:MaloglogNegativeValues" to suppress
this warning.)
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L1 gl 111l B R

F532 Median - B532 (Woxel A1)

_—
]
1
I

10° 10° 10t
FBE35 Median - BE35 (Caontral)

Notice that this function gives some warnings about negative and zero
elements. This is because some of the values in the 'F635 Median - B635'
and 'F532 Median - B532' columns are zero or even less than zero. Spots
where this happened might be bad spots or spots that failed to hybridize.
Points with positive, but very small, differences between foreground and
background should also be considered to be bad spots.

3 Disable the display of warnings by using the warning command. Although

warnings can be distracting, it is good practice to investigate why the
warnings occurred rather than simply to ignore them. There might be some
systematic reason why they are bad.

warnState = warning; % First save the current warning
state.
% Now turn off the two warnings.
warning('off', 'Bioinfo:MaloglogZeroValues');
warning('off', 'Bioinfo:MaloglogNegativeValues');
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figure
maloglog(cy5Data,cy3Data) % Create the loglog plot
warning(warnState); % Reset the warning state.

xlabel('F635 Median - B635 (Control)');
ylabel('F532 Median - B532 (Voxel A1)');

The MATLAB software plots the image.
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—
=
1
T

FE35 Median - BE3S (Control)

4 An alternative to simply ignoring or disabling the warnings is to remove
the bad spots from the data set. You can do this by finding points where
either the red or green channel has values less than or equal to a threshold
value. For example, use a threshold value of 10.

threshold = 10;
badPoints (cybbata <= threshold) | (cy3Data <= threshold);
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The MATLAB software plots the image.
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FE35 Median - BE35 (Cantrol)

10

5 You can then remove these points and redraw the loglog plot.

cy5Data(badPoints) = []; cy3Data(badPoints) = [];
figure

maloglog(cy5Data,cy3Data)

xlabel('F635 Median - B635 (Control)')

5
ylabel('F532 Median - B532 (Voxel A1)');
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The MATLAB software plots the image.
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This plot shows the distribution of points but does not give any indication
about which genes correspond to which points.

6 Add gene labels to the plot. Because some of the data points have
been removed, the corresponding gene IDs must also be removed from
the data set before you can use them. The simplest way to do that is
wt.IDs(~badPoints).

maloglog(cy5Data,cy3Data, 'labels',wt.IDs(~badPoints),...
‘factorlines',?2)
xlabel('F635 Median - B635 (Control)')

ylabel('F532 Median - B532 (Voxel A1)');
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The MATLAB software plots the image.
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7 Try using the mouse to click some of the outlier points.

You will see the gene ID associated with the point. Most of the outliers are
below the y = x line. In fact, most of the points are below this line. Ideally
the points should be evenly distributed on either side of this line.

8 Normalize the points to evenly distribute them on either side of the line.
Use the function mameannorm to perform global mean normalization.

normcy5 = mameannorm(cy5Data);
normcy3 mameannorm(cy3Data);

If you plot the normalized data you will see that the points are more evenly
distributed about the y = x line.

figure
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maloglog(normcy5,normcy3, 'labels' ,wt.IDs(~badPoints),...
‘factorlines',2)

xlabel('F635 Median - B635 (Control)');

ylabel('F532 Median - B532 (Voxel A1)');

The MATLAB software plots the image.

F532 Median - B332 Moxel Al)

K] -
10 PR | Ll Ll Ll
10 107 10" 10" 10’
FE35 Median - BE35 (Control)

The function mairplot is used to create an Intensity vs. Ratio plot for the
normalized data. This function works in the same way as the function
maloglog.

figure

mairplot(normcy5,normcy3, 'labels’',wt.IDs(~badPoints),...
‘factorlines',2)
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The MATLAB software plots the image.

10° . :
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Ratio
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10° 10 107 10
Intensity

10 You can click the points in this plot to see the name of the gene associated

with the plot.
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Analyzing Gene Expression Profiles

In this section...

“Overview of the Yeast Example” on page 4-57
“Exploring the Data Set” on page 4-57
“Filtering Genes” on page 4-61

“Clustering Genes” on page 4-64

“Principal Component Analysis” on page 4-68

Overview of the Yeast Example

This example demonstrates a number of ways to look for patterns in gene
expression profiles, using gene expression data from yeast shifting from
fermentation to respiration.

The microarray data for this example is from DeRisi, J.L., Iyer, V.R., and
Brown, P.O. (Oct 24, 1997). Exploring the metabolic and genetic control of
gene expression on a genomic scale. Science, 278 (5338), 680—-686. PMID:
9381177.

The authors used DNA microarrays to study temporal gene expression of
almost all genes in Saccharomyces cerevisiae during the metabolic shift from
fermentation to respiration. Expression levels were measured at seven time
points during the diauxic shift. The full data set can be downloaded from the
Gene Expression Omnibus Web site at:

http://www.ncbi.nlm.nih.gov/geo/query/acc.cgi?acc=GSE28

Exploring the Data Set

This procedure illustrates how to import data from the Web into the MATLAB
environment. The data for this procedure is available in the MAT-file
yeastdata.mat. This file contains the VALUE data or LOG_RAT2N_MEAN,
or log2 of ratio of CH2DN_MEAN and CH1IDN_MEAN from the seven time
steps in the experiment, the names of the genes, and an array of the times at
which the expression levels were measured.

1 Load data into the MATLAB environment.
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load yeastdata.mat

Get the size of the data by typing

numel(genes)

The number of genes in the data set displays in the MATLAB Command
Window. The MATLAB variable genes is a cell array of the gene names.

ans =
6400

Access the entries using cell array indexing.

genes{15}

This displays the 15th row of the variable yeastvalues, which contains
expression levels for the open reading frame (ORF) YAL054C.

ans =
YAL054C

Use the function web to access information about this ORF in the
Saccharomyces Genome Database (SGD).

url = sprintf(...
‘http://genome-www4.stanford.edu/cgi-bin/SGD/. ..
locus.pl?locus=%s',...
genes{15});
web(url);

A simple plot can be used to show the expression profile for this ORF.

plot(times, yeastvalues(15,:))
xlabel('Time (Hours)');
ylabel('Log2 Relative Expression Level');
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The MATLAB software plots the figure. The values are log, ratios.

5 T T T T

LogZ? Relative Expression Level

2 1 1 1 1
1] g 10 15 20 25

Time [Hours)

6 Plot the actual values.
plot(times, 2."yeastvalues(15,:))

xlabel('Time (Hours)');
ylabel('Relative Expression Level');
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The MATLAB software plots the figure. The gene associated with this
ORF, ACS1, appears to be strongly up-regulated during the diauxic shift.
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7 Compare other genes by plotting multiple lines on the same figure.

hold on

plot(times, 2."yeastvalues(16:26,:)")
xlabel('Time (Hours)');
ylabel('Relative Expression Level');
title('Profile Expression Levels');
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The MATLAB software plots the image.
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Filtering Genes

This procedure illustrates how to filter the data by removing genes that are
not expressed or do not change. The data set is quite large and a lot of the
information corresponds to genes that do not show any interesting changes
during the experiment. To make it easier to find the interesting genes, reduce
the size of the data set by removing genes with expression profiles that do not
show anything of interest. There are 6400 expression profiles. You can use

a number of techniques to reduce the number of expression profiles to some
subset that contains the most significant genes.

1 If you look through the gene list you will see several spots marked as

"EMPTY'. These are empty spots on the array, and while they might have
data associated with them, for the purposes of this example, you can
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consider these points to be noise. These points can be found using the
strcmp function and removed from the data set with indexing commands.

emptySpots = strcmp('EMPTY',genes);
yeastvalues(emptySpots,:) = [];
genes(emptySpots) = [1];
numel(genes)

The MATLAB software displays:

ans =
6314

In the yeastvalues data you will also see several places where the
expression level is marked as NaN. This indicates that no data was collected
for this spot at the particular time step. One approach to dealing with
these missing values would be to impute them using the mean or median of
data for the particular gene over time. This example uses a less rigorous
approach of simply throwing away the data for any genes where one or
more expression levels were not measured.

Use the isnan function to identify the genes with missing data and then
use indexing commands to remove the genes.

nanIndices = any(isnan(yeastvalues),2);
yeastvalues(nanIndices,:) = [];
genes(nanIndices) = [];

numel(genes)

The MATLAB software displays:

ans =
6276

If you were to plot the expression profiles of all the remaining profiles,
you would see that most profiles are flat and not significantly different
from the others. This flat data is obviously of use as it indicates that the
genes associated with these profiles are not significantly affected by the
diauxic shift. However, in this example, you are interested in the genes
with large changes in expression accompanying the diauxic shift. You can
use filtering functions in the toolbox to remove genes with various types
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of profiles that do not provide useful information about genes affected by
the metabolic change.

3 Use the function genevarfilter to filter out genes with small variance
over time. The function returns a logical array of the same size as the
variable genes with ones corresponding to rows of yeastvalues with

variance greater than the 10th percentile and zeros corresponding to those
below the threshold.

mask = genevarfilter(yeastvalues);

% Use the mask as an index into the values to remove the
% filtered genes.

yeastvalues = yeastvalues(mask,:);

genes = genes(mask);

numel(genes)

The MATLAB software displays:

ans =
5648

4 The function genelowvalfilter removes genes that have very low
absolute expression values. Note that the gene filter functions can also
automatically calculate the filtered data and names.

[mask, yeastvalues, genes] = genelowvalfilter(yeastvalues,genes,...

‘absval',log2(4));
numel(genes)

The MATLAB software displays:

ans =
423

5 Use the function geneentropyfilter to remove genes whose profiles have
low entropy:

[mask, yeastvalues, genes] = geneentropyfilter(yeastvalues,genes,...

‘prctile',15);
numel(genes)
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The MATLAB software displays:

ans = 310

Clustering Genes

Now that you have a manageable list of genes, you can look for relationships

between the profiles using some different clustering techniques from the
Statistics Toolbox software.

1 For hierarchical clustering, the function pdist calculates the pairwise
distances between profiles, and the function linkage creates the
hierarchical cluster tree.

corrDist = pdist(yeastvalues, 'corr');
clusterTree = linkage(corrDist, 'average');

2 The function cluster calculates the clusters based on either a cutoff
distance or a maximum number of clusters. In this case, the 'maxclust'
option is used to identify 16 distinct clusters.

clusters = cluster(clusterTree, 'maxclust', 16);

3 The profiles of the genes in these clusters can be plotted together using a

simple loop and the function subplot.

figure

for ¢ = 1:16
subplot(4,4,c);
plot(times,yeastvalues((clusters == c¢c),:)"');
axis tight

end

suptitle('Hierarchical Clustering of Profiles');

The MATLAB software plots the images.
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4 The Statistics Toolbox software also has a K-means clustering function.
Again, 16 clusters are found, but because the algorithm is different these
are not necessarily the same clusters as those found by hierarchical
clustering.

[cidx, ctrs] = kmeans(yeastvalues, 16,...
‘dist', 'corr',...
‘rep',5,...
‘disp','final');
figure
for c = 1:16
subplot(4,4,c);
plot(times,yeastvalues((cidx == c),:)");
axis tight
end
suptitle('K-Means Clustering of Profiles');
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The MATLAB software displays:

13 iterations, total sum of distances 11.4042
14 iterations, total sum of distances = 8.62674

26 iterations, total sum of distances = 8.86066
22 iterations, total sum of distances = 9.77676
26 iterations, total sum of distances = 9.01035

_iofx|
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K-Means Clustering of Profiles

5 Instead of plotting all of the profiles, you can plot just the centroids.

figure
for ¢c = 1:16
subplot(4,4,c);
plot(times,ctrs(c,:)"');
axis tight
axis off % turn off the axis
end
suptitle('K-Means Clustering of Profiles');
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The MATLAB software plots the figure:
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6 You can use the function clustergram to create a heat map and
dendrogram from the output of the hierarchical clustering.

figure
clustergram(yeastvalues(:,2:end), 'RowLabels',genes,...
‘ColumnLabels',times(2:end))
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The MATLAB software plots the figure:
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Principal Component Analysis

Principal-component analysis (PCA) is a useful technique you can use to
reduce the dimensionality of large data sets, such as those from microarray
analysis. You can also use PCA to find signals in noisy data.

1 Use the pca function in the Statistics Toolbox software to calculate the
principal components of a data set.

[pc, zscores, pcvars] = pca(yeastvalues)
The MATLAB software displays:
pc =

Columns 1 through 4
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[N elNeolNelNolNolNo]

Columns 5 through 7

-0

-0.
-0.
-0.

0.
-0.
-0.

.0245
.0186
.0713
.2254
.2950
.6596
.6490

.1155
2384
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2385
5592
0194
0673

-0.
-0.
-0.
-0.
-0.

0.

0.

0.
-0.
-0.

0.
-0.
-0.
-0.
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1970
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6422
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2377

4034
2903
3657
7520
2110
0961
0039

1
O OO O0OO0OOoOOo

.1710
.3843
.2493
.1667
.1415
.5155
.6689

. 7887
.3679
.2035
.4283
.1032
.0667
.0521

O O OO0 OoOOo

.2831
.5419
.4042
.1705
.3358
.5032
.2601

2 You can use the function cumsum to see the cumulative sum of the variances.

cumsum(pcvars./sum(pcvars)

* 100)

The MATLAB software displays:

ans =

78.
89.
93.
96.
98.
99.

100

3719
2140
4357
0831
3283
3203
.0000

This shows that almost 90% of the variance is accounted for by the first

two principal components.

3 A scatter plot of the scores of the first two principal components shows that
there are two distinct regions. This is not unexpected, because the filtering
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process removed many of the genes with low variance or low information.
These genes would have appeared in the middle of the scatter plot.

figure

scatter(zscores(:,1),zscores(:,2));
xlabel('First Principal Component');
ylabel('Second Principal Component');
title('Principal Component Scatter Plot');

The MATLAB software plots the figure:

J Figure 3 - O] x|
File Edit Wiew Insert Tools Deskiop Window Help ¥
Frincipal Component Scatter Plot

6 _
1= O
ak}
5
=% 4r
£
o
(_) 2 L
=
=2
2
£ 0f
o
=
5 -2}
L
k]
n

_4 1 1 1 1 1 1 1

-8 -6 -4 -2 ] 2 4 G

First Principal Component

4 The gname function from the Statistics Toolbox software can be used to
identify genes on a scatter plot. You can select as many points as you like
on the scatter plot.

gname (genes) ;
When you have finished selecting points, press Enter.

5 An alternative way to create a scatter plot is with the gscatter function
from the Statistics Toolbox software. gscatter creates a grouped scatter
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plot where points from each group have a different color or marker. You
can use clusterdata, or any other clustering function, to group the points.

figure

pcclusters = clusterdata(zscores(:,1:2),6);
gscatter(zscores(:,1),zscores(:,2),pcclusters)

xlabel('First Principal Component');

ylabel('Second Principal Component');

title('Principal Component Scatter Plot with Colored Clusters');
gname(genes) % Press enter when you finish selecting genes.

The MATLAB software plots the figure:

—lo]x]
File Edit Wiew Insert Tools Deskiop Window Help ¥
Frincipal Component Scatter Plot with Colored Clusters
= O YGL184C
2 JYGL138C * ;
4.
%l A LO6TC » 3
© 2 4
g . WNLOBTW . 5
2 OR095C * B
= ol . by
S
= »
S -2r YDRO19C
Jub]
0]
_4 1 1 1 1 1 1 1
-8 -B -4 -2 0 2 4 6
First Principal Component
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Detecting DNA Copy Number Alteration in Array-Based
CGH Data

This example shows how to detect DNA copy number alterations in
genome-wide array-based comparative genomic hybridization (CGH) data.

Introduction

Copy number changes or alterations is a form of genetic variation in the
human genome [1]. DNA copy number alterations (CNAs) have been linked to
the development and progression of cancer and many diseases.

DNA microarray based comparative genomic hybridization (CGH) is a
technique allows simultaneous monitoring of copy number of thousands of
genes throughout the genome [2,3]. In this technique, DNA fragments or
"clones" from a test sample and a reference sample differentially labeled with
dyes (typically, Cy3 and Cy5) are hybridized to mapped DNA microarrays and
imaged. Copy number alterations are related to the Cy3 and Cyb5 fluorescence
intensity ratio of the targets hybridized to each probe on a microarray.
Clones with normalized test intensities significantly greater than reference
intensities indicate copy number gains in the test sample at those positions.
Similarly, significantly lower intensities in the test sample are signs of

copy number loss. BAC (bacterial artificial chromosome) clone based CGH
arrays have a resolution in the order of one million base pairs (1Mb) [3].
Oligonucleotide and cDNA arrays provide a higher resolution of 50-100kb [2].

Array CGH log2-based intensity ratios provide useful information about
genome-wide CNAs. In humans, the normal DNA copy number is two for all
the autosomes. In an ideal situation, the normal clones would correspond to
a log2 ratio of zero. The log2 intensity ratios of a single copy loss would be
-1, and a single copy gain would be 0.58. The goal is to effectively identify
locations of gains or losses of DNA copy number.

The data in this example is the Coriell cell line BAC array CGH data analyzed
by Snijders et al.(2001). The Coriell cell line data is widely regarded as a "gold
standard" data set. You can download this data of normalized log2-based
intensity ratios and the supplemental table of known karyotypes from
http://www.nature.com/ng/journal/v29/n3/suppinfo/ng754_S1.html. You will
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compare these cytogenically mapped alterations with the locations of gains or
losses identified with various functions of MATLAB and its toolboxes.

For this example, the Coriell cell line data are provided in a MAT file. The
data file coriell baccgh.mat contains coriell data, a structure containing
of the normalized average of the log2-based test to reference intensity ratios
of 15 fibroblast cell lines and their genomic positions. The BAC targets are
ordered by genome position beginning at Ip and ending at Xq.

load coriell_baccgh
coriell data

coriell data =

Sample: {1x15 cell}
Chromosome: [2285x1 int8]
GenomicPosition: [2285x1 int32]
Log2Ratio: [2285x15 double]
FISHMap: {2285x1 cell}

Visualizing the Genome Profile of the Array CGH Data Set
You can plot the genome wide log2-based test/reference intensity ratios of
DNA clones. In this example, you will display the log2 intensity ratios for cell

line GMO03576 for chromosomes 1 through 23.

Find the sample index for the CM03576 cell line.

sample = find(strcmpi(coriell_data.Sample, 'GM03576'))

sample =

8

To label chromosomes and draw the chromosome borders, you need to find
the number of data points of in each chromosome.
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chr_nums = zeros(1, 23);

chr_data_len = zeros(1,23);

for ¢ = 1:23
tmp coriell data.Chromosome == c;
chr_nums(c) = find(tmp, 1, 'last');
chr_data_len(c) = length(find(tmp));

n =

end

% Draw a vertical bar at the end of a chromosome to indicate the border
= repmat(chr_nums, 3, 1);
repmat([2;-2;NaN], 1, 23);

< X
< <
O O
0 Q©
R

1

% Label the autosomes with their chromosome numbers, and the sex chromosome
% with X.

x_label chr_nums - ceil(chr_data_len/2);

y_label = zeros(1, length(x_label)) - 1.6;

chr_labels=num2str((1:1:23)"');

chr_labels = cellstr(chr_labels);

chr_labels{end} = 'X';

figure;hold on
h_ratio = plot(coriell_data.Log2Ratio(:,sample), '.');
h_vbar = line(x_vbar, y_vbar, 'color', [0.8 0.8 0.8]);

h_text = text(x_label, y label, chr_labels,...
‘fontsize', 8, 'HorizontalAlignment', 'center');
h_axis = get(h_ratio, 'parent');

set(h_axis, 'xtick', [], 'ygrid', ‘'on', 'box', 'on',...
‘xlim', [0 chr_nums(23)], 'ylim', [-1.5 1.5])

title(coriell data.Sample{sample})
xlabel({'', 'Chromosome'})
ylabel('Log2(T/R)")

hold off

4-74



Detecting DNA Copy Number Alteration in Array-Based CGH Data
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In the plot, borders between chromosomes are indicated by grey vertical bars.
The plot indicates that the GM03576 cell line is trisomic for chromosomes
2 and 21 [3].

You can also plot the profile of each chromosome in a genome. In this
example, you will display the log2 intensity ratios for each chromosome in cell
line GM05296 individually.

sample = find(strcmpi(coriell_data.Sample, 'GM05296'));

figure;
for ¢ = 1:23
idx = coriell_data.Chromosome == c;

chr_y = coriell data.Log2Ratio(idx, sample);
subplot(5,5,c);

hp = plot(chr_y, '.');
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line([0, chr_data_len(c)], [0,0], 'color', 'r');

h_axis = get(hp, 'Parent');
set(h_axis, 'xtick', [], 'Box', ‘'on',...
‘xlim', [0 chr_data_len(c)], 'ylim', [-1.5 1.5])
xlabel(['chr ' chr_labels{c}], 'FontSize', 8)
end
suptitle('GM05296"');

GMO05296
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The plot indicates the GM05296 cell line has a partial trisomy at chromosome
10 and a partial monosomy at chromosome 11.

Observe that the gains and losses of copy number are discrete. These

alterations occur in contiguous regions of a chromosome that cover several
clones to entitle chromosome.
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The array-based CGH data can be quite noisy. Therefore, accurate
identification of chromosome regions of equal copy number that accounts for
the noise in the data requires robust computational methods. In the rest of
this example, you will work with the data of chromosomes 9, 10 and 11 of
the GM05296 cell line.

Initialize a structure array for the data of these three chromosomes.

GM05296_Data = struct('Chromosome', {9 10 11},...

‘GenomicPosition', {[1, [1, [I},...
‘Log2Ratio’, {[], [1, [I1},.-.-
'SmoothedRatio', {[1, [1, [I},--.
‘DiffRatio’, {[1, [1, [1},..-
‘SegIndex', {[1, [1, [1});

Filtering and Smoothing Data

A simple approach to perform high-level smoothing is to use a median filter.
The median filter removes outliers while preserving sustained changes in the
input data. The median filter function, medfilt1, is available with Signal
Processing Toolbox™,

for

end

iloop = 1:1length(GM05296_ Data)

idx = coriell_data.Chromosome == GM05296_ Data(iloop).Chromosome;
chr_x = coriell_data.GenomicPosition(idx);

chr_y coriell data.Log2Ratio(idx, sample);

% Remove NaN data points

idx = ~isnan(chr_y);
GM05296_Data(iloop).GenomicPosition = chr_x(idx);
GM05296_Data(iloop).Log2Ratio = chr_y(idx);

% Apply a median filter
GM05296_Data(iloop).SmoothedRatio = medfilt1(GM05296_ Data(iloop).Log2Ra

% Find the derivative of the smoothed ratio
GM05296_Data(iloop).DiffRatio = diff([0; GM05296_Data(iloop).SmoothedRa
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To better visualize and later validate the locations of copy number changes,
we need cytoband information. Read the human cytoband information from
the hs_cytoBand.txt data file using the cytobandread function. It returns a
structure of human cytoband information [4].

hs_cytobands = cytobandread('hs_cytoBand.txt"')
% Find the centromere positions for the chromosomes.
acen_idx = strcmpi(hs_cytobands.GieStains, 'acen');
acen_ends = hs_cytobands.BandEndBPs(acen_idx);

% Convert the cytoband data from bp to kilo bp because the genomic
% positions in Coriell Cell Line data set are in kilo base pairs.
acen_pos = acen_ends(1:2:end)/1000;

hs_cytobands =

ChromLabels: {862x1 cell}
BandStartBPs: [862x1 int32]
BandEndBPs: [862x1 int32]
BandLabels: {862x1 cell}
GieStains: {862x1 cell}

You can inspect the data by plotting the log2-based ratios, the smoothed ratios
and the derivative of the smoothed ratios together. You can also display the
centromere position of a chromosome in the data plots. The magenta vertical
bar marks the centromere of the chromosome.

for iloop = 1:1length(GM05296_Data)

chr = GM05296_Data(iloop).Chromosome;

chr_x = GM05296_Data(iloop).GenomicPosition;

figure; hold on

plot(chr_x, GM05296_Data(iloop).Log2Ratio, '.');

line(chr_x, GM05296_Data(iloop).SmoothedRatio,...
'Color', 'r', 'LineWidth', 2);

line(chr_x, GM05296_Data(iloop).DiffRatio,...
'Color', 'k', 'LineWidth', 2);

line([acen_pos(chr), acen_pos(chr)], [-1, 1],...

4-78



Detecting DNA Copy Number Alteration in Array-Based CGH Data

end

‘Color',

if iloop ==

end
ylim([-1, 1])
xlabel('Genomic Position')
ylabel('Log2(T/R)")

legend('Raw', 'Smoothed', 'Diff"',

‘m', 'LineWidth',

2, 'LineStyle',

‘Centromere');

title(sprintf('GM05296: Chromosome %d ', chr))
hold off
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1r :
! +  Haw
08 ! Smoothed
I — Diff
0&r I —— - Centromere
|
D4 I
02t . . ! .
& | *,
E EI " * * * b - * " *t
=
5 - ‘¢+ - " t b .
02F I . .
!
L4r I
!
QB !
0Ek !
|
_1 1 | i | 1 1 1
1] 2 4 5 a 10 12
Genormic Position . 1D4

')

4-79



4 Microarray Analysis

4-80

Log2(T/R)

0.4

06

0.8

GMOS296: Chromogorne 10

1] 5 10 14

. . 4
Genoric Position w10



Detecting DNA Copy Number Alteration in Array-Based CGH Data

GMOS295: Chrormosgorme 11
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Detecting Change-Points

The derivatives of the smoothed ratio over a certain threshold usually
indicate substantial changes with large peaks, and provide the estimate of the
change-point indices. For this example you will select a threshold of 0.1.

thrd = 0.1;

for iloop = 1:1length(GM05296_Data)
idx = find(abs(GM05296 Data(iloop).DiffRatio) > thrd );
N = numel(GMO5296_Data(iloop).SmoothedRatio);
GM05296_Data(iloop).SegIndex = [1;idx;N];

% Number of possible segments found

disp(sprintf('%d segments initially found on Chromosome %d',...
numel (GM05296_Data(iloop).SegIndex) - 1,...
GM05296_Data(iloop) .Chromosome)) ;

4-81



4 Microarray Analysis

end

1 segments initially found on Chromosome 9
3 segments initially found on Chromosome 10
5 segments initially found on Chromosome 11

Optimizing Change-Points by GM Clustering

Gaussian Mixture (GM) or Expectation-Maximization (EM) clustering can
provide fine adjustments to the change-point indices [5]. The convergence to
statistically optimal change-point indices can be facilitated by surrounding
each index with equal-length set of adjacent indices. Thus each edge is
associated with left and right distributions. The GM clustering learns the
maximum-likelihood parameters of the two distributions. It then optimally
adjusts the indices given the learned parameters.

You can set the length for the set of adjacent positions distributed around the
change-point indices. For this example, you will select a length of 5. You can
also inspect each change-point by plotting its GM clusters. In this example,
you will plot the GM clusters for the Chromosome 10 data.

len = 5;
for iloop = 1:1ength(GM05296 Data)
seg_num = numel(GM05296 Data(iloop).SegIndex) - 1;
if seg_num > 1
% Plot the data points in chromosome 10 data
if GM05296 Data(iloop).Chromosome == 10
figure; hold on;
plot(GM05296 Data(iloop).GenomicPosition,...
GM05296 Data(iloop).Log2Ratio, '.')
ylim([-0.5, 1])
xlabel('Genomic Position')
ylabel('Log2(T/R)")
title(sprintf('Chromosome %d - GM05296', GM05296 Data(iloop).Ch
end

segidx = GM05296 Data(iloop).SegIndex;
segidx_emadj = GM05296 Data(iloop).SegIndex;

for jloop = 2:seg_num
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ileft = min(segidx(jloop) - len, segidx(jloop));

iright = max(segidx(jloop) + len, segidx(jloop));

gmx = GM05296 Data(iloop).GenomicPosition(ileft:iright);
gmy = GM05296 Data(iloop).SmoothedRatio(ileft:iright);

% Select initial guess for the of cluster index for each point.
gmpart = (gmy > (min(gmy) + range(gmy)/2)) + 1;

% Create a Gaussian mixture model object
gm = gmdistribution.fit(gmy, 2, 'start', gmpart);
gmid = gm.cluster(gmy);

segidx_emadj(jloop) = find(abs(diff(gmid))==1) + ileft;

o°

Plot GM clusters for the change-points in chromosome 10 data
if GM05296 Data(iloop).Chromosome == 10
plot(gmx(gmid==1),gmy(gmid==1), 'g."',...
gmx (gmid==2), gmy(gmid==2), 'r.")
end
end

% Remove repeat indices

zeroidx = [diff(segidx_emadj) == 0; 0];

GM05296 Data(iloop).SegIndex = segidx_emadj (~zeroidx);
end

% Number of possible segments found
disp(sprintf('%sd segments found on Chromosome %d after GM clustering ad
numel (GM05296_Data(iloop).SegIndex) - 1,...
GM05296_Data(iloop).Chromosome));
end
hold off;

1 segments found on Chromosome 9 after GM clustering adjustment.
3 segments found on Chromosome 10 after GM clustering adjustment.
3 segments found on Chromosome 11 after GM clustering adjustment.
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Chromogome 10 - GMO5296
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Testing Change-Point Significance

Once you determine the optimal change-point indices, you also need to
determine if each segment represents a statistically significant changes

in DNA copy number. You will perform permutation t-tests to assess the
significance of the segments identified. A segment includes all the data points
from one change-point to the next change-point or the chromosome end. In
this example, you will perform 10,000 permutations of the data points on two
consecutive segments along the chromosome at the significance level of 0.01.

alpha = 0.01;
for iloop = 1:1length(GM05296_Data)
seg_num = numel(GM05296_Data(iloop).SegIndex) - 1;
seg_index = GM05296_Data(iloop).SegIndex;
if seg_num > 1
ppvals = zeros(seg_num+1, 1);

4-84



Detecting DNA Copy Number Alteration in Array-Based CGH Data

for sloop = 1:seg_num-1
seglidx = seg_index(sloop):seg_index(sloop+1)-1;

if sloop== seg_num-1

seg2idx = seg_index(sloop+1):(seg_index(sloop+2));
else

seg2idx = seg_index(sloop+1):(seg_index(sloop+2)-1);
end

seg!l = GM05296 Data(iloop).SmoothedRatio(seg1idx);
seg2 GM05296 Data(iloop).SmoothedRatio(seg2idx);

ni = numel(segl);
n2 numel(seg2);

N = ni1+n2;

segs = [segl1;seg2];

% Compute observed t statistics
t_obs = mean(segl) - mean(seg2);

% Permutation test
iter = 10000;
t_perm = zeros(iter,1);
for i = 1:iter
randseg = segs(randperm(N));
t_perm(i) = abs(mean(randseg(1:n1)) - mean(randseg(ni+1:N))
end
ppvals(sloop+1) = sum(t_perm >= abs(t_obs))/iter;
end

sigidx = ppvals < alpha;
GM05296 Data(iloop).SegIndex = seg_index(sigidx);
end

% Number segments after significance tests
disp(sprintf('%d segments found on Chromosome %d after significance tes
numel (GM05296_Data(iloop).SegIndex) - 1, GM05296 Data(iloop).Chroma
end

1 segments found on Chromosome 9 after significance tests.
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3 segments found on Chromosome 10 after significance tests.
3 segments found on Chromosome 11 after significance tests.

Assessing Copy Number Alterations

Cytogenetic study indicates cell line GM05296 has a trisomy at 10q21-10q24
and a monosomy at 11p12-11p13 [3]. Plot the segment means of the three
chromosomes over the original data with bold red lines, and add the
chromosome ideograms to the plots using the chromosomeplot function. Note
that the genomic positions in the Coriell cell line data set are in kilo base
pairs. Therefore, you will need to convert cytoband data from bp to kilo bp
when adding the ideograms to the plot.

for iloop = 1:1length(GM05296_Data)

figure;

seg_num = numel(GM05296_Data(iloop).SegIndex)

seg_mean = ones(seg_num,1);

chr_num = GM05296_Data(iloop).Chromosome;

for jloop = 2:seg_num+1
idx = GM05296_Data(iloop).SegIndex(jloop-1):GM05296 Data(iloop) .Seg
seg_mean(idx) = mean(GM05296 Data(iloop).Log2Ratio(idx));
line (GM05296_Data(iloop).GenomicPosition(idx), seg_mean(idx),...

_1;

‘color', 'r', 'linewidth', 3);
end
line (GM05296_Data(iloop).GenomicPosition, GM05296 Data(iloop).Log2Ratic
‘linestyle', 'none', 'Marker', '.');

line([acen_pos(chr_num), acen_pos(chr_num)],
‘linewidth', 2,...
‘color', 'm',...
‘linestyle', '-.

[-1, 11,...

)

ylabel('Log2(T/R)")

set(gca, 'Box', 'on', 'ylim', [-1, 1])
title(sprintf('Chromosome %d - GM05296', chr_num));
chromosomeplot(hs_cytobands, chr_num, 'addtoplot', gca, ‘'unit', 2)

end
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Chromosome 10 - GMMOS296
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Chromosome 11 - GMOS296
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As shown in the plots, no copy number alterations were found on chromosome
9, there is copy number gain span from 10g21 to 10924, and a copy number
loss region from 11p12to 11p13. The CNAs found match the known results in
cell line GM05296 determined by cytogenetic analysis.

You can also display the CNAs of the GM05296 cell line align to the
chromosome ideogram summary view using the chromosomeplot function.
Determine the genomic positions for the CNAs on chromosomes 10 and 11.

chr10_idx = GM05296 _Data(2).SegIndex(2):GM05296 Data(2).SegIndex(3)-1;
chr10_cna_start = GM05296 Data(2).GenomicPosition(chr10_idx(1))*1000;
chr10_cna_end = GM05296_Data(2).GenomicPosition(chr10_idx(end))*1000;

chr11_idx = GM05296 Data(3).SegIndex(2):GM05296_Data(3).SegIndex(3)-1;

chr11_cna_start = GM05296 Data(3).GenomicPosition(chri11_idx(1))*1000;
chr11_cna_end = GM05296_Data(3).GenomicPosition(chr11_idx(end))*1000;
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Create a structure containing the copy number alteration data from
the GMO05296 cell line data according to the input requirements of the
chromosomeplot function.

cna_struct

cna_struct =

Chromosome:
CNVType:
Start:

End:

struct('Chromosome’, [10 11],...

‘CNVType', [2 1],...

‘Start', [chr10_cna_start, chr11_cna_start],...

"End"', [chr10_cna_end, chri11_cna_end])

[10 11]

(2 1]

[65000000 35416000]
[110000000 39389000]

chromosomeplot(hs_cytobands, ‘'cnv', cna_struct, 'unit', 2)
title('Human Karyogram with Copy Number Alterations of GM05296')
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analysis and visualization of copy-number alterations in array-based CGH
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Exploring Gene Expression Data

This example shows how to identify differentially expressed genes. Then it
uses Gene Ontology to determine significant biological functions that are
associated to the down- and up-regulated genes.

Introduction

Microarrays contain oligonucleotide or cDNA probes for comparing the
expression profile of genes on a genomic scale. Determining if changes in
gene expression are statistically significant between different conditions,
e.g. two different tumor types, and determining the biological function
of the differentially expressed genes, are important aims in a microarray
experiment.

A publicly available dataset containing gene expression data of 42 tumor
tissues of the embryonal central nervous system (CNS, Pomeroy et al. 2002) is
used for this example. The samples were hybridized on Affymetrix HuGeneFL
GeneChip arrays.

The CNS dataset (CEL files) is available at the CNS experiment web site.
The 42 tumor tissue samples include 10 medulloblastomas, 10 rhabdoid, 10
malignant glioma, 8 supratentorial PNETS, and 4 normal human cerebella.
The CNS raw dataset was preprocessed with the Robust Multi-array Average
(RMA) and GC Robust Multi-array Average (GCRMA) procedures. For
further information on Affymetrix oligonucleotide microarray preprocessing,
see Preprocessing Affymetrix Microarray Data at the Probe Level.

You will use the t-test and false discovery rate to detect differentially
expressed genes between two of the tumor types. Additionally, you will look
at Gene Ontology terms related to the significantly up-regulated genes.

Loading the Expression Data

Load the MAT file cnsexpressiondata containing three DataMatrix
objects. Gene expression values preprocessed by RMA and GCRMA (MLE
and EB) procedures are stored in the DataMatrix objects expr_cns_rma,
expr_cns_gcrma_mle, and expr_cns_gcrma_eb respectively.

load cnsexpressiondata
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In each DataMatrix object, each row corresponds to a probe set on the
HuGeneF1 array, and each column corresponds to a sample. The row
names are the probe set IDs and column names are the sample names. The
DataMatrix object expr_cns_gcrma_eb will be used in this example. You can
use either of the other two expression variables as well.

You can get the properties of the DataMatrix object expr_cns_gcrma_eb
using the get command.

get(expr_cns_gcrma_eb)

Name: "'
RowNames: {7129x1 cell}

ColNames: {1x42 cell}

NRows: 7129
NCols: 42
NDims: 2

ElementClass: 'single'

Determine the number of genes and number of samples in the DataMatrix
object expr_cns_gcrma_eb.

[nGenes, nSamples] = size(expr_cns_gcrma_eb)
nGenes =
7129
nSamples =
42

You can use gene symbols instead of the probe set IDs to label the expression
values. The gene symbols for the HuGeneF1 array are provided in a MAT
file containing a Map object.
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load HuGeneFL_GeneSymbol Map;

Create a cell array of gene symbols for the expression values from the
hu6800GeneSymbolMap object.

huGenes = values(hu6800GeneSymbolMap, expr_cns_gcrma_eb.RowNames);

Set the row names of the exprs_cns_gcrma_eb to gene symbols using the
rownames method of the DataMatrix object.

expr_cns_gcrma_eb = rownames(expr_cns_gcrma_eb, ':', huGenes);
Filtering the Expression Data

Remove gene expression data with empty gene symbols. In the example, the

empty symbols are labeled as '---"'.
expr_cns_gcrma_eb('---"', ) = [1];

Many of the genes in this study are not expressed, or have only small
variability across the samples. Remove these genes using non-specific
filtering.

Use genelowvalfilter to filter out genes with very low absolute expression
values.

[mask, expr_cns_gcrma_eb] = genelowvalfilter(expr_cns_gcrma_eb);
Use genevarfilter to filter out genes with a small variance across samples.
[mask, expr_cns_gcrma_eb] = genevarfilter(expr_cns_gcrma_eb);
Determine the number of genes after filtering.

nGenes = expr_cns_gcrma_eb.NRows

nGenes =

5669
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Identifying Differential Gene Expression

You can now compare the gene expression values between two groups of data:
CNS medulloblastomas (MD) and non-neuronal origin malignant gliomas
(Mglio) tumor.

From the expression data of all 42 samples, extract the data of the 10 MD
samples and the 10 Mglio samples.

MDs = strncmp(expr_cns_gcrma_eb.ColNames, 'Brain_MD', 8);
Mglios = strncmp(expr_cns_gcrma_eb.ColNames, 'Brain_MGlio', 11);

MDData = expr_cns_gcrma_eb(:, MDs);
get(MDData)

Name: "'
RowNames: {5669x1 cell}
ColNames: {1x10 cell}

NRows: 5669
NCols: 10
NDims: 2

ElementClass: 'single'

MglioData = expr_cns_gcrma_eb(:, Mglios);

get(MglioData)
Name: "'

RowNames: {5669x1 cell}

ColNames: {1x10 cell}

NRows: 5669
NCols: 10
NDims: 2

ElementClass: 'single'

A standard statistical test for detecting significant changes between the
measurement of a variable in two groups is the t-test. Conduct a t-test for
each gene to identify significant changes in expression values between the
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MD samples and Mglio samples. You can inspect the test results from the
normal quantile plot of t-scores and the histograms of t-scores and p-values
of the t-tests.

[pvalues, tscores] = mattest(MDData, MglioData,...
‘Showhist', true', 'Showplot', true);

Mormal Cluantile Plot of t
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Histograms of t-test Results
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In any test situation, two types of errors can occur, a false positive by
declaring that a gene is differentially expressed when it is not, and a false
negative when the test fails to identify a truly differentially expressed gene.
In multiple hypothesis testing, which simultaneously tests the null hypothesis
of thousands of genes using microarray expression data, each test has a
specific false positive rate, or a false discovery rate (FDR). False discovery
rate is defined as the expected ratio of the number of false positives to the
total number of positive calls in a differential expression analysis between
two groups of samples (Storey et al., 2003).

In this example, you will compute the FDR using the Storey-Tibshirani
procedure (Storey et al., 2003). The procedure also computes the q-value of
a test, which measures the minimum FDR that occurs when calling the test
significant. The estimation of FDR depends on the truly null distribution of
the multiple tests, which is unknown. Permutation methods can be used to
estimate the truly null distribution of the test statistics by permuting the
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columns of the gene expression data matrix (Storey et al., 2003, Dudoit et
al., 2003). Depending on the sample size, it may not be feasible to consider
all possible permutations. Usually a random subset of permutations are
considered in the case of large sample size. Use the nchoosek function in
Statistics Toolbox™ to find out the number of all possible permutations of
the samples in this example.

all _possible_perms = nchoosek(1:MDData.NCols+MglioData.NCols, MDData.NCols)
size(all_possible_perms, 1)

ans =

184756

Perform a permutation t-test using mattest and the PERMUTE option to
compute the p-values of 10,000 permutations by permuting the columns of the
gene expression data matrix of MDData and MglioData (Dudoit et al., 2003).

pvaluesCorr = mattest(MDData, MglioData, 'Permute', 10000);

Determine the number of genes considered to have statistical significance at
the p-value cutoff of 0.05. Note: You may get a different number of genes
due to the permutation test outcome.

cutoff = 0.05;
sum(pvaluesCorr < cutoff)

ans =

2121

Estimate the FDR and g-values for each test using mafdr. The quantity pi0 is
the overall proportion of true null hypotheses in the study. It is estimated
from the simulated null distribution via bootstrap or the cubic polynomial fit.
Note: You can also manually set the value of lambda for estimating pi0.

figure;
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[pFDR, gvalues] = mafdr(pvaluesCorr, 'showplot',6 true);
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Determine the number of genes that have g-values less than the cutoff value.
Note: You may get a different number of genes due to the permutation test
and the bootstrap outcomes.

sum(qvalues < cutoff)

ans =

2173

Many genes with low FDR implies that the two groups, MD and Mglio, are
biologically distinct.
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You can also empirically estimate the FDR adjusted p-values using the
Benjamini-Hochberg (BH) procedure (Benjamini et al, 1995) by setting the
mafdr input parameter BHFDR to true.

pvaluesBH = mafdr(pvaluesCorr, 'BHFDR', true);
sum(pvaluesBH < cutoff)

ans =

1374

You can store the t-scores, p-values, pFDRs, g-values and BH FDR corrected
p-values together as a DataMatrix object.

testResults = [tscores pvaluesCorr pFDR qvalues pvaluesBH];

Update the column name for BH FDR corrected p-values using the colnames
method of DataMatrix object.

testResults = colnames(testResults, 5, {'FDR_BH'});

You can sort by p-values pvaluesCorr using the sortrows mathod.

testResults = sortrows(testResults, 2);

Display the first 23 genes in testResults. Note: Your results may be
different from those shown below due to the permutation test and the
bootstrap outcomes.

testResults(1:23, :)

ans =
t-scores p-values FDR g-values
PLECA -9.6223 6.7194e-09 1.3675e-05 7.171e-06
HNRPA1 9.359 1.382e-08 1.4063e-05 7.171e-06
FCGR2A -9.3548 1.394e-08 9.457e-06 7.171e-06
PLECA -9.3495 1.4094e-08 7.171e-06 7.171e-06

FDR_E
1.997

—_
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A gene is considered to be differentially expressed between the two groups
of samples if it shows both statistical and biological significance. In this
example, you will compare the gene expression ratio of MD over Mglio
tumor samples. Therefore an up-regulated gene in this example has higher
expression in MD and down-regulate gene has higher expression in Mglio.

Plot the -1log10 of p-values against the biological effect in a volcano plot. Note:
From the volcano plot Ul, you can interactively change the p-value cutoff and
fold change limit, and export differentially expressed genes.

diffStruct

diffStruct

Name:
PVCutoff:

mavolcanoplot (MDData, MglioData, pvaluesCorr)

0.0500

FCThreshold: 2

GenelLabels:

{327x1 cell}

'Differentially Expressed’

.96
.96
.96
.96
.224
. 383
. 383
. 394
.905
.905
9.07
.317
.317
.317
.317
.376
.000
.000
.000
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PValues: [327x1 bioma.data.DataMatrix]
FoldChanges: [327x1 bioma.data.DataMatrix]
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Ctrl-click genes in the gene lists to label the genes in the plot. As seen in the
volcano plot, genes specific for neuronal based cerebella granule cells, such
as ZIC and NEUROD, are found in the up-regulated gene list, while genes
typical of the astrocytic and oligodendrocytic lineage and cell differentiation,

such as SOX2, PEA15, and ID2B, are found in the down-regulated list.

Determine the number of differentially expressed genes.

nDiffGenes

nDiffGenes

327

diffStruct.PValues.NRows
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Get the list of up-regulated genes for MD compared to Mglio.

up_geneidx = find(diffStruct.FoldChanges > 0);
up_genes = rownames(diffStruct.FoldChanges, up_geneidx);
nUpGenes = length(up_geneidx)

nUpGenes =

225

Determine the number of down-regulated genes for MD compared to Mglio.

nDownGenes sum(diffStruct.FoldChanges < 0)

nDownGenes =

102

Annotating Up-Regulated Genes Using Gene Ontology

Use Gene Ontology (GO) to annotate the differentially expressed genes. You
can look at the up-regulated genes from the analysis above. Download the
Homo sapiens annotations (gene_association.goa_human.gz file) from
Gene Ontology Current Annotations, unzip, and store it in your the current
directory.

Find the indices of the up-regulated genes for Gene Ontology analysis.

huGenes = rownames(expr_cns_gcrma_eb) ;
for i = 1:nUpGenes

up_geneidx(i) = find(strncmpi(huGenes, up_genes{i}, length(up_genes{i})
end
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Load the Gene Ontology database into a MATLAB object using the geneont
function.

GO = geneont('live',true);

Read the Homo sapiens gene annotation file. For this example, you will look
only at genes that are related to molecular function, so you only need to read
the information where the Aspect field is set to 'F’. The fields that are of
interest are the gene symbol and associated ID. In GO Annotation files these
have field names DB_Object_Symbol and GOid respectively.

HGann = goannotread('gene_association.goa_human',...
'"Aspect','F','Fields',{'DB_Object_Symbol', 'G0id'});

Create a map between annotated genes and GO terms.

HGmap = containers.Map();
for i=1:numel(HGann)
key = HGann(i).DB_Object_Symbol;
if isKey(HGmap,key)
HGmap (key) = [HGmap(key) HGann(i).GOid];
else
HGmap (key) = HGann(i).GO0id;
end
end

Determine the number of Homo sapiens annotated genes related to molecular
function.

HGmap.Count

ans =

15561

Not all of the 5758 genes on the HuGeneFL chip are annotated. For every
gene on the chip, see if it is annotated by comparing its gene symbol to the
list of gene symbols from GO. Track the number of annotated genes and the
number of up-regulated genes associated with each GO term. Note: You
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might get warnings about invalid or obsolete IDs due to the frequent update
to the Homo sapiens gene annotation file.

o°

m = GO.Terms(end).id; gets the last term id
chipgenesCount = zeros(m,1); % a vector of GO term counts for the entire ch
upgenesCount = zeros(m,1); % a vector of GO term counts for up-regulated
for i = 1:1length(huGenes)
if isKey(HGmap,huGenes{i})
goid = getrelatives(GO,HGmap(huGenes{i}));
% Update the tally
chipgenesCount(goid) = chipgenesCount(goid) + 1;
if (any(i == up_geneidx))
upgenesCount(goid) = upgenesCount(goid) +1;
end
end
end

Determine the statistically significant GO terms using the hypergeometric
probability distribution. For each GO term, a p-value is calculated
representing the probability that the number of annotated genes associated
with it could have been found by chance.

gopvalues = hygepdf (upgenesCount,max(chipgenesCount),...
max (upgenesCount),chipgenesCount);
[dummy, idx] = sort(gopvalues);

report = sprintf('GO Term p-value counts definition\n');
for i = 1:10
term = idx(1i);
report = sprintf('%s%s\t%-1.5F\t%3d / %3d\t%s...\n',...
report, char(num2goid(term)), gopvalues(term),...
upgenesCount(term), chipgenesCount(term),...
GO(term).Term.definition(2:min(50,end)));
end
disp(report);

GO Term p-value counts definition

G0:0005515 0.00000 119 / 2984 Interacting selectively with any protein or p
G0:0003735 0.00000 56 / 151 The action of a molecule that contributes to t
G0:0019843 0.00000 52 / 214 Interacting selectively with ribosomal RNA." [
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GO:
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Inspect the significant GO terms and select the terms related to specific
molecule functions to build a sub-ontology that includes the ancestors of the
terms. Visualize this ontology using the biograph function. You can also color
the graphs nodes. In this example, the red nodes are the most significant,
while the blue nodes are the least significant gene ontology terms. Note: The
GO terms returned may differ from those shown due to the frequent update to
the Homo sapiens gene annotation file.

fcnAncestors = GO(getancestors(GO,idx(1:5)))
[cm acc rels] = getmatrix(fcnAncestors);
BG = biograph(cm,get(fcnAncestors.Terms, 'name'))

for i=1:numel(acc)

end

pval =
color

gopvalues(acc(i));
[(1-pval).~(1) pval.~(1/8) pval.”(1/8)];

set(BG.Nodes (i), 'Color',color);

view(BG)

Gene Ontology object with 9 Terms.

Biograph object with 9 nodes and 8 edges.
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Finding the Differentially Expressed Genes in Pathways

You can query the pathway information of the differentially expressed genes
from the KEGG pathway database through KEGG’s SOAP Web Service (For
more information, see Connecting to the KEGG API Web Service), or by
simply passing the list of gene symbols to KEGG’s Web query tool.

Following are a few pathway maps with the genes in the up-regulated gene
list highlighted:

Cell Cycle
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Hedgehog Signaling pathway

mTor Signaling pathway
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® “Overview of Phylogenetic Analysis” on page 5-2
¢ “Building a Phylogenetic Tree” on page 5-3

¢ “Phylogenetic Tree Viewer Reference” on page 5-16
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Overview of Phylogenetic Analysis

Phylogenetic analysis is the process you use to determine the evolutionary
relationships between organisms. The results of an analysis can be drawn

in a hierarchical diagram called a cladogram or phylogram (phylogenetic
tree). The branches in a tree are based on the hypothesized evolutionary
relationships (phylogeny) between organisms. Each member in a branch, also
known as a monophyletic group, is assumed to be descended from a common
ancestor. Originally, phylogenetic trees were created using morphology, but
now, determining evolutionary relationships includes matching patterns in
nucleic acid and protein sequences.



Building a Phylogenetic Tree

Building a Phylogenetic Tree

In this section...

“Overview of the Primate Example” on page 5-3

“Searching NCBI for Phylogenetic Data” on page 5-5
“Creating a Phylogenetic Tree for Five Species” on page 5-6
“Creating a Phylogenetic Tree for Twelve Species” on page 5-9

“Exploring the Phylogenetic Tree” on page 5-11

Note For information on creating a phylogenetic tree with multiply aligned
sequences, see the phytree function.

Overview of the Primate Example

In this example, a phylogenetic tree is constructed from mitochondrial DNA
(mtDNA) sequences for the family Hominidae. This family includes gorillas,
chimpanzees, orangutans, and humans.

The following procedures demonstrate the phylogenetic analysis features
in the Bioinformatics Toolbox software. They are not intended to teach the
process of phylogenetic analysis, but to show you how to use MathWorks
products to create a phylogenetic tree from a set of nonaligned nucleotide
sequences.

The origin of modern humans is a heavily debated issue that scientists have
recently tackled by using mitochondrial DNA (mtDNA) sequences. One
hypothesis explains the limited genetic variation of human mtDNA in terms
of a recent common genetic ancestry, implying that all modern population
mtDNA originated from a single woman who lived in Africa less than 200,000
years ago.

Why Use Mitochondrial DNA Sequences for Phylogenetic
Study?

Mitochondrial DNA sequences, like the Y chromosome, do not recombine
and are inherited from the maternal parent. This lack of recombination
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allows sequences to be traced through one genetic line and all polymorphisms
assumed to be caused by mutations.

Mitochondrial DNA in mammals has a faster mutation rate than nuclear
DNA sequences. This faster rate of mutation produces more variance between
sequences and is an advantage when studying closely related species. The
mitochondrial control region (Displacement or D-loop) is one of the fastest
mutating sequence regions in animal DNA.

Neanderthal DNA

The ability to isolate mitochondrial DNA (mtDNA) from palaeontological
samples has allowed genetic comparisons between extinct species and closely
related nonextinct species. The reasons for isolating mtDNA instead of
nuclear DNA in fossil samples have to do with the fact that:

e mtDNA, because it is circular, is more stable and degrades slower then
nuclear DNA.

¢ Each cell can contain a thousand copies of mtDNA and only a single copy
of nuclear DNA.

While there is still controversy as to whether Neanderthals are direct
ancestors of humans or evolved independently, the use of ancient genetic
sequences in phylogenetic analysis adds an interesting dimension to the
question of human ancestry.
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Searching NCBI for Phylogenetic Data

The NCBI taxonomy Web site includes phylogenetic and taxonomic
information from many sources. These sources include the published
literature, Web databases, and taxonomy experts. And while the NCBI
taxonomy database is not a phylogenetic or taxonomic authority, it can be
useful as a gateway to the NCBI biological sequence databases.

This procedure uses the family Hominidae (orangutans, chimpanzees,
gorillas, and humans) as a taxonomy example for searching the NCBI Web
site and locating mitochondrial D-loop sequences.

1 Use the MATLAB Help browser to search for data on the Web. In the
MATLAB Command Window, type

web('http://www.ncbi.nlm.nih.gov")

A separate browser window opens with the home page for the NCBI Web
site.

2 Search the NCBI Web site for information. For example, to search for the
human taxonomy, from the Search list, select Taxonomy, and in the for
box, enter hominidae.

National Center for Biotechnology Information
National Library of Medicine National Institutes of Health

PubMed Entrez BLAST OMIM Books TaxBrowser Structure
~| for |hnminidae

Search |Tax0anY

| @@3}\\% . e .;‘Taxonomy

Entrez PubMed Nucleotide Protein Genome Structure PMC Taxonomy Books

Search ITaxunumy j for Ihuminidae Clear |

Limits  Preview/Index History Clipboard Details

Display iSummary ﬂ Show:|20 j Send to IText -

r 1: Hominidae, family, mammals Links

About Entrez
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3 Select the taxonomy link for the family Hominidae. A page with the
taxonomy for the family is shown.

Taxonomy
Browser

Entrez PubMed Nucleotide Protein Genome Structure PMC Taxonomy Books
Search fOI'I as Icnmplete nameﬂ ~ lock
Clear
|3 levels using filter: |nune 'l
F Nucleotide  Protein ™ Structure — Genome I~ Popset ™

n r r r GEO - r
i e PSR Domains Expressions UniGene UniSTS
r PubMed . . r
Central r r MapView 1 LinkOut  BLAST TRACE

Lineage (full): root; cellular organisms; Eukarvota; Funei/Metazoa group;
Metazoa; Eumetazoa; Bilateria; Coelomata; Deuterostomia; Chordata;
Craniata; Vertebrata; Gnathostomata; Teleostomi; Euteleostomi;
Sarcopterveil; Tetrapoda; Amniota; Mammealia; Theria; Eutheria; Primates;

Catarrhini

o Hominidae ciick on organism name to get more information.

o Homo/Pan/Gorilla group

o Gorilla
+ Gorilla gorilla (gorilla)
c Homo
+« Homo sapiens (human)
o Pan (chimpanzees)
s Pan paniscus (pygmy chimpanzee)
+ Pan troglodyvtes (chimpanzee)

o Pongo

¢ Pongo pvegmaeus (orangutan)

» Pongo pyvgmaeus abelii (Sumatran orangutan)

» Pongo pvgmaeus pvgmaeus (Bornean orangutan)
= Pongo sp.

Creating a Phylogenetic Tree for Five Species

Drawing a phylogenetic tree using sequence data is helpful when you are
trying to visualize the evolutionary relationships between species. The
sequences can be multiply aligned or a set of nonaligned sequences, you can
select a method for calculating pairwise distances between sequences, and
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you can select a method for calculating the hierarchical clustering distances
used to build a tree.

After locating the GenBank accession codes for the sequences you are
interested in studying, you can create a phylogenetic tree with the data. For
information on locating accession codes, see “Searching NCBI for Phylogenetic
Data” on page 5-5.

In the following example, you will use the Jukes-Cantor method to calculate
distances between sequences, and the Unweighted Pair Group Method
Average (UPGMA) method for linking the tree nodes.

2

Create a MATLAB structure with information about the sequences. This
step uses the accession codes for the mitochondrial D-loop sequences
isolated from different hominid species.

data = {'German_Neanderthal' '"AF011222"';
‘Russian_Neanderthal' 'AF254446"';
‘European_Human' 'X90314"'
‘Mountain_Gorilla_Rwanda' 'AF089820';
‘Chimp_Troglodytes' 'AF176766"' ;

};

Retrieve sequence data from the GenBank database and copy into the
MATLAB environment.

for ind = 1:5
seqs(ind) .Header data{ind,1};
seqs(ind) .Sequence = getgenbank(data{ind,2},...
‘sequenceonly', true);

end

Calculate pairwise distances and create a phytree object. For example,
compute the pairwise distances using the Jukes-Cantor distance method
and build a phylogenetic tree using the UPGMA linkage method. Since
the sequences are not prealigned, seqpdist pairwise aligns them before
computing the distances.

distances = seqpdist(seqs, 'Method', 'Jukes-Cantor', 'Alphabet', 'DNA');
tree = seqlinkage(distances, 'UPGMA',seqs)

5-7
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The MATLAB software displays information about the phytree object.
The function seqpdist calculates the pairwise distances between pairs of
sequences while the function seqlinkage uses the distances to build a
hierarchical cluster tree. First, the most similar sequences are grouped
together, and then sequences are added to the tree in descending order
of similarity.

Phylogenetic tree object with 5 leaves (4 branches)

Draw a phylogenetic tree.

h = plot(tree,'orient', " 'top');
ylabel('Evolutionary distance')
set(h.terminalNodelLabels, 'Rotation',65)

The MATLAB software draws a phylogenetic tree in a Figure window. In

the figure below, the hypothesized evolutionary relationships between the
species is shown by the location of species on the branches. The horizontal
distances do not have any biological significance.



Building a Phylogenetic Tree

EEE

File Edit View Insert Tools Desktop Window Help a

=" %|'+.\_"-\.‘STF':@“-E£’ @J|DE|DE

D2F R

03F R

Evolutionary distance

04| .

0.5F R

. - f o)
F H &
]
o o s}
&

&

Creating a Phylogenetic Tree for Twelve Species

Plotting a simple phylogenetic tree for five species seems to indicate a number
of monophyletic groups (see “Creating a Phylogenetic Tree for Five Species”
on page 5-6). After a preliminary analysis with five species, you can add more
species to your phylogenetic tree. Adding more species to the data set will
help you to confirm the observed monophyletic groups are valid.

1 Add more sequences to a MATLAB structure. For example, add mtDNA
D-loop sequences for other hominid species.

data2 = {'Puti_Orangutan' 'AF451972"';
‘Jari_Orangutan' 'AF451964 " ;
‘Western_Lowland_Gorilla' 'AY079510';
'Eastern_Lowland_Gorilla' 'AF050738';
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‘Chimp_Schweinfurthii' 'AF176722"';
‘Chimp_Vellerosus' "AF315498" ;
‘Chimp_Verus' "AF176731";

b

2 Get additional sequence data from the GenBank database, and copy the
data into the next indices of a MATLAB structure.

for ind = 1:7
seqs(ind+5) .Header
seqs(ind+5) .Sequence

data2{ind,1};
getgenbank(data2{ind,2}, ...
‘sequenceonly', true);

end

3 Calculate pairwise distances and the hierarchical linkage.

distances = seqpdist(seqs, 'Method', 'Jukes-Cantor', 'Alpha', 'DNA");
tree = seqlinkage(distances, 'UPGMA',seqs);

4 Draw a phylogenetic tree.
h = plot(tree,'orient', 'top');

ylabel('Evolutionary distance')
set(h.terminalNodelLabels, 'Rotation',65)

The MATLAB software draws a phylogenetic tree in a Figure window. You
can see four main clades for humans, gorillas, chimpanzee, and orangutans.
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Exploring the Phylogenetic Tree

After you create a phylogenetic tree, you can explore the tree using the
MATLAB command line or the phytreeviewer GUI. This procedure uses the
tree created in “Creating a Phylogenetic Tree for Twelve Species” on page
5-9 as an example.

1 List the members of a tree.

names get(tree, 'LeafNames')

names

'German_Neanderthal'
'Russian_Neanderthal'
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'"European_Human'
'Chimp_Troglodytes'
'Chimp_Schweinfurthii'
'Chimp_Verus'
'Chimp_Vellerosus'
'"Puti_Orangutan'
‘dari_Orangutan'
'Mountain_Gorilla_Rwanda'
'Eastern_Lowland_Gorilla'
'Western_Lowland_Gorilla'

From the list, you can determine the indices for its members. For example,
the European Human leaf is the third entry.

Find the closest species to a selected species in a tree. For example, find
the species closest to the European human.

[h_all,h_leaves] = select(tree, 'reference',3,...
‘criteria', 'distance’',...
‘threshold',0.6);

h_all is a list of indices for the nodes within a patristic distance of 0.6 to
the European human leaf, while h_leaves is a list of indices for only the
leaf nodes within the same patristic distance.

A patristic distance is the path length between species calculated from
the hierarchical clustering distances. The path distance is not necessarily
the biological distance.

List the names of the closest species.

subtree_names = names(h_leaves)

The MATLAB software prints a list of species with a patristic distance to
the European human less than the specified distance. In this case, the
patristic distance threshold is less than 0.6.

subtree_names =

'German_Neanderthal'
'Russian_Neanderthal'
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'"European_Human'
'Chimp_Schweinfurthii'’
'Chimp_Verus'
'Chimp_Troglodytes'

4 Extract a subtree from the whole tree by removing unwanted leaves. For
example, prune the tree to species within 0.6 of the European human
species.

leaves_to_prune = ~h_leaves;

pruned_tree = prune(tree,leaves_to_prune)
h = plot(pruned_tree,'orient', 'top');
ylabel('Evolutionary distance')
set(h.terminalNodeLabels, 'Rotation',65)

The MATLAB software returns information about the new subtree and
plots the pruned phylogenetic tree in a Figure window.

Phylogenetic tree object with 6 leaves (5 branches)
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5 Explore, edit, and format a phylogenetic tree using an interactive GUL.

phytreeviewer (pruned_tree)

The Phylogenetic Tree window opens, showing the tree.
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Phylogenetic Tree 1

File Tools Window Help
LERO| gD 2

German_Meanderthal

Russian_Meanderthal

European_Human

Chimp_Troglodytes

Chimp_Schweinfurthii

Chimp_Werus

0 0.05 0.1

014

0.2

0.25

You can interactively change the appearance of the tree within the tool
window. For information on using this GUI, see “Phylogenetic Tree Viewer

Reference” on page 5-16.
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Phylogenetic Tree Viewer Reference

In this section...

“Overview of the Phylogenetic Tree Viewer” on page 5-16
“Opening the Phylogenetic Tree Viewer” on page 5-16
“File Menu” on page 5-18

“Tools Menu” on page 5-29

“Window Menu” on page 5-38

“Help Menu” on page 5-38

Overview of the Phylogenetic Tree Viewer

The Phylogenetic Tree viewer is an interactive graphical user interface (GUI)
that allows you to view, edit, format, and explore phylogenetic tree data. With
this GUI you can prune, reorder, rename branches, and explore distances.
You can also open or save Newick-formatted files. The following sections
give a description of menu commands and features for creating publishable
tree figures.

Opening the Phylogenetic Tree Viewer

This section illustrates how to draw a phylogenetic tree from data in a phytree
object or a previously saved file.

The Phylogenetic Tree viewer can read data from Newick and ClustalW tree
formatted files.

This procedure uses the phylogenetic tree data stored in the file pf00002. tree
as an example. The data was retrieved from the protein family (PFAM) Web
database and saved to a file using the accession number PF00002 and the
function gethmmtree.

1 Create a phytree object. For example, to create a phytree object from tree
data in the file pf00002. tree, type

tr= phytreeread('pf00002.tree')
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The MATLAB software creates a phytree object.

Phylogenetic tree object with 33 leaves (32 branches)

2 Open the Phylogenetic Tree viewer and draw a phylogenetic tree.

phytreeviewer(tr)

The Phylogenetic Tree viewer opens.

Phylogenetic Tree 1

[ESMEENE)

File Tools Window Help
LERO| gD 2

1

&
&
Uﬂ[l oo UUUUU[lUUUUUUUUUUUUUm

1 Q9YHCE_RANMRIM 26-382
1 VIPR1_RATM40-397
1WIPR_CARALIT00-359
1WIPRZ_HUMANM 23-382
1 PACE_MOLISEM 50-435
<+ SCTR_RABITM 35-391

<+ 0T3TES_CARALI33-350
41 GHRHRE_MOLUISEM 26-383
1 PTHRZ_HUMANM 41-420
4 PTHR1_HUMANM B4-466
1 GLP2R_RATMN75-443

1 GLR_HUMAN 38-407

—1 GIPR_HUMARNI1 34-399

1 GLP1R_RATM 41-408

1 DIHR_ACHDOM 30-393

< DIHR_MANSEMR3-351

1 CRFRZ_=EMLAM15-368
1 CRFR1_RATIM16-370

1 CALRL_HURANIT 38-391
1 CALCR_RATI 45-435
+1SEB1_CAEELIG4-436

1 CELR1_MOUSES2480-2723
1 CELR3_RAT/2534-2777
1 CDe7_MOUSEMSZE-TTT
<+ CD97_HUMANMS44-733
S EMR1_HURMAMNISE9-851
+1GQ17404_CAEELMS45-799
1 087802_BOVIMNITES-1016
1 LPHMN3_BOYINIZ42-11498
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1
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Alternately, if you do not give the phytreeviewer function an argument,
the Select Phylogenetic Tree dialog box opens. Select a Newick-formatted
file and then click Open.

3 Select a command from the menu or toolbar.

u Phylogenetic Tree 1

File Tools Window Help
R G EDT A

File Menu

The File menu includes the standard commands for opening and closing a
file, and it includes commands to use phytree object data from the MATLAB
Workspace. The File menu commands are shown below.

u Phylogenetic Tree 1

File | Tecls Window  Help

Mew Viewer...

Open...

Import from Workspace...

Open Original in Mew Viewer

Save As..

Print to Figure »
Export to New Viewer »
Export to Workspace »
Export Setup..

Print Preview...

Print... Ctrl+P

Exit
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New Viewer Command

Use the New Viewer command to open tree data from a file into a second

Phylogenetic Tree viewer.

1 From the File menu, select New Viewer.

The Open A Phylogenetic Tree dialog box opens.

n Open A Phylogen... | =

£3

|'\

— Choose tree source:

@ Import from workspace

Select phytree object:

(") Open phylogenetic tree file

[ox | [ cance]

L

2 Choose the source for a tree.

e MATLAB Workspace — Select the Import from Workspace options,
and then select a phytree object from the list.

* File — Select the Open phylogenetic tree file option, click the
Browse button, select a directory, select a file with the extension .tree,
and then click Open. The toolbox uses the file extension .tree for
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Newick-formatted files, but you can use any Newick-formatted file with
any extension.

= Mew folder
Mame

demosearch
htrnl
ia
|| pf00002.tree
Il pfﬂﬂﬂﬂEfukree

A second Phylogenetic Tree viewer opens with tree data from the selected
file.

Open Command
Use the Open command to read tree data from a Newick-formatted file and
display that data in a Phylogenetic Tree viewer.

1 From the File menu, click Open.
The Select Phylogenetic Tree File dialog box opens.

2 Select a directory, select a Newick-formatted file, and then click Open. The
toolbox uses the file extension .tree for Newick-formatted files, but you
can use any Newick-formatted file with any extension.

The MATLAB software replaces the current tree data with data from the
selected file.

Import from Workspace Command

Use the Import from Workspace command to read tree data from a phytree
object in the MATLAB Workspace and display that data in a Phylogenetic
Tree viewer.
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1 From the File menu, select Import from Workspace.

The Get Phytree Object dialog box opens.

. ™
B Get.. | = 2|
Select phytree object:
tr -
| Import | | Cancel
. A

2 From the list, select a phytree object in the MATLAB Workspace.

3 Click the Import button.
The MATLAB software replaces the current tree data in the Phylogenetic

Tree viewer with data from the selected object.

Open Original in New Viewer

There may be times when you make changes that you would like to undo.
phytreeviewer does not have an undo command, but you can get back to the
original tree you started viewing with the Open Original in New Viewer
command.

From the File menu, select Open Original in New Viewer.

A new Phylogenetic Tree viewer opens with the original tree.
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Save As Command

After you create a phytree object or prune a tree from existing data, you can
save the resulting tree in a Newick-formatted file. The sequence data used to
create the phytree object is not saved with the tree.

1 From the File menu, select Save As.
The Save Phylogenetic tree as dialog box opens.

2 In the Filename box, enter the name of a file. The toolbox uses the file
extension .tree for Newick-formatted files, but you can use any file
extension.

3 Click Save.

phytreeviewer saves tree data without the deleted branches, and it saves
changes to branch and leaf names. Formatting changes such as branch
rotations, collapsed branches, and zoom settings are not saved in the file.

Export to New Viewer Command

Because some of the Phylogenetic Tree viewer commands cannot be undone
(for example, the Prune command), you might want to make a copy of your
tree before trying a command. At other times, you might want to compare two
views of the same tree, and copying a tree to a new tool window allows you to
make changes to both tree views independently .

1 Select File > Export to New Viewer, and then select either With
Hidden Nodes or Only Displayed.

A new Phylogenetic Tree viewer opens with a copy of the tree.

2 Use the new figure to continue your analysis.

Export to Workspace Command

The Phylogenetic Tree viewer can open Newick-formatted files with tree data.
However, it does not create a phytree object in the MATLAB Workspace. If
you want to programmatically explore phylogenetic trees, you need to use the
Export to Workspace command.
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1 Select File > Export to Workspace, and then select either With Hidden
Nodes or Only Displayed.

The Export to Workspace dialog box opens.

2 In the Workspace variable name box, enter the name for your
phylogenetic tree data. For example, enter MyTree.

ru Export tl — | |&

-

Workspace variable name 7
MyTree

[Cox_] [{camea]

L o

3 Click OK.
The phytreeviewer creates a phytree object in the MATLAB Workspace.

Print to Figure Command

After you have explored the relationships between branches and leaves in
your tree, you can copy the tree to a MATLAB Figure window. Using a
Figure window lets you use all the features for annotating, changing font
characteristics, and getting your figure ready for publication. Also, from the
Figure window, you can save an image of the tree as it was displayed in the

Phylogenetic Tree viewer.

1 From the File menu, select Print to Figure, and then select either With
Hidden Nodes or Only Displayed.

The Publish Phylogenetic Tree to Figure dialog box opens.
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Print Phylogenetic Tree to Fgure

2 Select one of the Rendering Types.
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Rendering Type Description

‘square’' (default)

ooooaoan

‘angular’

DooobooooodoodddlE ol o
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Rendering Type Description

'radial’

‘equalangle’
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Rendering Type Description

Tip This rendering type hides the significance of
the root node and emphasizes clusters, thereby
making it useful for visually assessing clusters
and detecting outliers.

"equaldaylight’

Tip This rendering type hides the significance of
the root node and emphasizes clusters, thereby
making it useful for visually assessing clusters
and detecting outliers.

3 Select the Display Labels you want on your figure. You can select from all
to none of the options.

¢ Branch Nodes — Display branch node names on the figure.
¢ Leaf Nodes — Display leaf node names on the figure.

¢ Terminal Nodes — Display terminal node names on the right border.

4 Click the Print button.
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A new Figure window opens with the characteristics you selected.

Print Preview Command

When you print from the Phylogenetic Tree viewer or a MATLAB Figure
window (with a tree published from the viewer), you can specify setup options

for printing a tree.

1 From the File menu, select Print Preview.

The Print Preview window opens, which you can use to select page

formatting options.

B Print Preview

=hac X

StyleSheet | default

Layout | Line;,"Textl Colorl Advanced|

Placement
) Auto (Actual Size, Centered)

@ Use manual size and position

Left: 0.250%
Top: 25045
Width: 80015
Height: 6.001%
I Use defaults I I Fill page I

I Fix aspect ratio I I Center I

Paper

Format: | USLetter —
Width: 850
Height: 11.00 1%
Units: Orientation

@ Inches @ Portrait

) Centimeters _) Landscape

! Points | Rotated

W oo = o m B W R

e

-_ Zooml Print H Refresh II

Help H Close

6 8

2 Select the page formatting options and values you want, and then click

Print.



Phylogenetic Tree Viewer Reference

Print Command

Use the Print command to make a copy of your phylogenetic tree after you
use the Print Preview command to select formatting options.

1 From the File menu, select Print.
The Print dialog box opens.
2 From the Name list, select a printer, and then click OK.

Tools Menu
Use the Tools menu to:

® Explore branch paths

® Rotate branches

* Find, rename, hide, and prune branches and leaves.

The Tools menu and toolbar contain most of the commands specific to trees

and phylogenetic analysis. Use these commands and modes to edit and format
your tree interactively. The Tools menu commands are:
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m Phylogenetic Tree 1

File | Tools | Window  Help

e = Inspect

Collapse/Expand
Rotate Branch
Rename

Prune

Zoom In

Zoom Cut

Pan

Select r
Find Leaf/Branch...
Collapse Selected
Expand Selected
Expand All

Fit to Window
Reset View

Options 3

Inspect Mode

Viewing a phylogenetic tree in the Phylogenetic Tree viewer provides a rough
idea of how closely related two sequences are. However, to see exactly how
closely related two sequences are, measure the distance of the path between
them. Use the Inspect command to display and measure the path between
two sequences.

1 Select Tools > Inspect, or from the toolbar, click the Inspect Tool Mode

icon é'?c .

The Phylogenetic Tree viewer is set to inspect mode.
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2 Click a branch or leaf node (selected node), and then hover your cursor over
another branch or leaf node (current node).

The tool highlights the path between the two nodes and displays the path
length in the pop-up window. The path length is the patristic distance
calculated by the seqpdist function.

0 :Il.aI:I_HJ AL S4-40 0}

_:& CD97_MOLISES2E-777

ChnT dkdakiiEdd TR

a Pathlength; 0.535444

Collapse and Expand Branch Mode

Some trees have thousands of leaf and branch nodes. Displaying all the nodes
can create an unreadable tree diagram. By collapsing some branches, you can
better see the relationships between the remaining nodes.

1 Select Tools > Collapse/Expand, or from the toolbar, click the
Collapse/Expand Brand Mode icon El
The Phylogenetic Tree viewer is set to collapse/expand mode.

2 Point to a branch.

The paths, branch nodes, and leaf nodes below the selected branch appear
in gray, indicating you selected them to collapse (hide from view).

I_H I_*
Branch 11 (3 samples) _% &
GLP1 RATA41-4039 .
GIPR HURMAM34-399
GLR HUMAMNA35-407

I e

oooooooo

3 Click the branch node.

The tool hides the display of paths, branch nodes, and leaf nodes below the
selected branch. However, it does not remove the data.

o Selected node: EMRT _HUMARIS99-551
———————n Current node:  CDAT_MOUSERS2E-777
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4 To expand a collapsed branch, click it or select Tools > Reset View.

Tip After collapsing nodes, you can redraw the tree by selecting Tools >
Fit to Window.

Rotate Branch Mode

A phylogenetic tree is initially created by pairing the two most similar
sequences and then adding the remaining sequences in a decreasing order of
similarity. You can rotate branches to emphasize the direction of evolution.

1 Select Tools > Rotate Branch, or from the toolbar, click the Rotate
Branch Mode icon @I

The Phylogenetic Tree viewer is set to rotate branch mode.

2 Point to a branch node.

1
Branch 11 (3 samples) _tk @
GLP1 RATA41-4039
GIPR HUR AR Z4-399
GLR HURANA 33-407

gooooon

3 Click the branch node.

Il ®
Branch 11 (3 samples) %
GIPR HUMANA34-399
GLR HUMAN/138-407 ——®

GLP1 RATA141-403

I - |

gooooooo
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The branch and leaf nodes below the selected branch node rotate 180
degrees around the branch node.

4 To undo the rotation, simply click the branch node again.

Rename Leaf or Branch Mode

The Phylogenetic Tree viewer takes the node names from the phytree object
and creates numbered branch names starting with Branch 1. You can edit
any of the leaf or branch names.

1 Select Tools > Rename, or from the toolbar, click the Rename Leaf/Branch
T
Mode icon £|

The Phylogenetic Tree viewer is set to rename mode.

2 Click a branch or leaf node.
%
—

A text box opens with the current name of the node.

— | I I N RN NPy R T L ) N

Branch 14 SREFE HUMAMN38-391
ALR BATHA5-435
CALR PIGH14B-415
CRF1 FATH1E-370
CRF2 *EMNLAM 15-363

OooocC

3 In the text box, edit or enter a new name.

i s (= I Y 0 i
—] CALR SRR HURMARN/138-391

& u LALR RATI145-435
o - CALR PIG/146-415
o {CRF1 RAT/16-370

0 CREZAENLAMTTS-388

4 To accept your changes and close the text box, click outside of the text box.
To save your changes, select File > Save As.

Prune (Delete) Leaf or Branch Mode

Your tree can contain leaves that are far outside the phylogeny, or it can have
duplicate leaves that you want to remove.
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1 Select Tools > Prune, or from the toolbar, click the Prune (delete)

Leaf/Branch Mode icon iﬂ .
The Phylogenetic Tree viewer is set to prune mode.

2 Point to a branch or leaf node.

MTH DROMESZT1-480

looooooo

*

For a leaf node, the branch line connected to the leaf appears in gray. For a
branch node, the branch lines below the node appear in gray.

Note If you delete nodes (branches or leaves), you cannot undo the
changes. The Phylogenetic Tree viewer does not have an Undo command.

3 Click the branch or leaf node.

The tool removes the branch from the figure and rearranges the other
nodes to balance the tree structure. It does not recalculate the phylogeny.

Tip After pruning nodes, you can redraw the tree by selecting Tools > Fit
to Window.

Zoom In, Zoom Out, and Pan Commands

The Zoom and Pan commands are the standard controls for resizing and
moving the screen in any MATLAB Figure window.

1 Select Tools > Zoom In, or from the toolbar, click the Zoom In icon %
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The tool activates zoom in mode and changes the cursor to a magnifying
glass.

2 Place the cursor over the section of the tree diagram you want to enlarge
and then click.

The tree diagram doubles its size.

o 4

&1%::

3 From the toolbar click the Pan icon ﬂl

4 Move the cursor over the tree diagram, left-click, and drag the diagram to
the location you want to view.

Tip After zooming and panning, you can reset the tree to its original view,
by selecting Tools > Reset View.

Select Submenu

Select a single branch or leaf node by clicking it. Select multiple branch or
leaf nodes by Shift-clicking the nodes, or click-dragging to draw a box around
nodes.
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Use the Select submenu to select specific branch and leaf nodes based on
different criteria.

¢ Select By Distance — Displays a slider bar at the top of the window,
which you slide to specify a distance threshold. Nodes whose distance from
the selected node are below this threshold appear in red. Nodes whose
distance from the selected node are above this threshold appear in blue.

¢ Select Common Ancestor — For all selected nodes, highlights the closest
common ancestor branch node in red.

® Select Leaves — If one or more nodes are selected, highlights the nodes
that are leaf nodes in red. If no nodes are selected, highlights all leaf
nodes in red

* Propogate Selection — For all selected nodes, highlights the descendant
nodes in red.

* Swap Selection — Clears all selected nodes and selects all deselected

nodes.

After selecting nodes using one of the previous commands, hide and show the
nodes using the following commands:

e Collapse Selected

¢ Expand Selected

e Expand All

Clear all selected nodes by clicking anywhere else in the Phylogenetic Tree
viewer.

Find Leaf or Branch Command

Phylogenetic trees can have thousands of leaves and branches, and finding a
specific node can be difficult. Use the Find Leaf/Branch command to locate
a node using its name or part of its name.

1 Select Tools > Find Leaf/Branch.

The Find Leaf/Branch dialog box opens.
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Find Leaf/Branch _}il

Feqgular Expression to match ?

I Cancel | ﬁ

2 In the Regular Expression to match box, enter a name or partial name
of a branch or leaf node.

3 Click OK.

The branch or leaf nodes that match the expression appear in red.

After selecting nodes using the Find Leaf/Branch command, you can hide
and show the nodes using the following commands:

¢ Collapse Selected
e Expand Selected
e Expand All

Collapse Selected, Expand Selected, and Expand All
Commands

When you select nodes, either manually or using the previous commands, you
can then collapse them by selecting Tools > Collapse Selected.

The data for branches and leaves that you hide using the Collapse/Expand
or Collapse Selected command are not removed from the tree. You can
display selected or all hidden data using the Expand Selected or Expand
All command.

Fit to Window Command

After you hide nodes with the collapse commands, or delete nodes with the
Prune command, there can be extra space in the tree diagram. Use the Fit
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to Window command to redraw the tree diagram to fill the entire Figure
window.

Select Tools > Fit to Window.

Reset View Command

Use the Reset View command to remove formatting changes such as
collapsed branches and zooms.

Select Tools > Reset View.

Options Submenu
Use the Options command to select the behavior for the zoom and pan modes.

¢ Unconstrained Zoom — Allow zooming in both horizontal and vertical
directions.

* Horizontal Zoom — Restrict zooming to the horizontal direction.

® Vertical Zoom (default) — Restrict zooming to the vertical direction.

¢ Unconstrained Pan — Allow panning in both horizontal and vertical
directions.

¢ Horizontal Pan — Restrict panning to the horizontal direction.

® Vertical Pan (default) — Restrict panning to the vertical direction.

Window Menu
This section illustrates how to switch to any open window.

The Window menu is standard on MATLAB interfaces and Figure windows.
Use this menu to select any opened window.

Help Menu

This section illustrates how to select quick links to the Bioinformatics
Toolbox documentation for phylogenetic analysis functions, tutorials, and
the phytreeviewer reference.
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Use the Help menu to select quick links to the Bioinformatics Toolbox
documentation for phylogenetic analysis functions, tutorials, and the
phytreeviewer reference.
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